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1 SuperPad 3.3 Help

SuperPad 3.3 Help                               
  

SuperPad 3.3 is a full-function mobile GIS application.  SuperPad contains  the powerful
and  complete  GIS  functions  as  well  as  a  superior  C/P  ratio  to  help  field-based
personnel  to  collect,  edit,  display  and  measure  spatial  data  at  a  reasonable  budget.
The highly  flexible  development  environment  and  diversified  extensions  enable  you  to
create  an  ideal  platform  and  solve  more  demands  during  field  tasks.  Moreover,
SuperPad  allows  synchronizing  the  data  with  enterprise  server  to  improve  your  work
efficiency.   
 

   

© 2015 Supergeo Technologies Inc. All Rights Reserved.
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2 Copyright Information

All Rights Reserved.

The information contained in this  document  is  the exclusive property  of Supergeo.  This
work  is  protected  under  Taiwan  copyright  law  and  the  copyright  laws  of  the  given
countries  of  origin  and  applicable  international  laws,  treaties,  and/or  conventions.  No
part  of  this  work  may  be  reproduced  or  transmitted  in  any  form  or  by  any  means,
electronic  or  mechanical,  including  photocopying  or  recording,  or  by  any  information
storage or retrieval system, except  as  expressly  permitted in writing by  Supergeo.  All
requests  should  be  sent  to  Attention:  Contracts  Manager,  Supergeo,  2F.,  No.  324,
Sec. 1, Neihu Road, Taipei, 114, Taiwan. The information contained in this  document  is
subject to change without notice.

Disclaimer
THE DATA INCLUDED IN THIS WORK IS FROM AN INDEPENDENT COMPANY AND,
AS  SUCH,  SUPERGEO  MAKES  NO  GUARANTEES  AS  TO  THE  QUALITY,
COMPLETENESS,  AND/OR  ACCURACY  OF  THE  DATA.  EVERY  EFFORT  HAS
BEEN  MADE  TO  ENSURE  THE  ACCURACY  OF  THE  DATA  INCLUDED  IN  THIS
WORK,  BUT THE  INFORMATION IS  DYNAMIC  IN  NATURE  AND  IS  SUBJECT  TO
CHANGE  WITHOUT NOTICE.  SUPERGEO  AND THE  DATA  VENDOR(S)  ARE  NOT
INVITING RELIANCE OF THE DATA. AND ONE SHOULD ALWAYS VERIFY ACTUAL
DATA AND NOT LIMITED TO, THE  IMPLIED WARRANTIES  OF  MERCHANTABILITY
OR  FITNESS  FOR  A  PARTICULAR  PURPOSE.  SUPERGEO  AND  THE  DATA
VENDOR(S)  SHALL  ASSUME  NO  LIABILITY  FOR  INDIRECT,  SPECIAL,
EXEMPLARY,  OR  CONSEQUENTIAL  DAMAGES,  EVEN  IF  ADVISED  OF  THE
POSSIBILITY THEREOF.

@  2013  Supergeo  Technologies  Inc.  All  rights  reserved.  SuperPad,  SuperObjects,
SuperGIS,  SuperWebGIS,  supergeotek.com  and  www.supergeotek.com  are
trademarks or registered trademarks of  Supergeo  Technologies  Inc.  Other  companies
and  products  mentioned  herein  are  trademarks  or  registered  trademarks  of  their
respective trademark owners.



SuperPad 3.3 Help

13

© 2015 Supergeo Technologies Inc. All Rights Reserved.



3
C h a p t e r



SuperPad 3.3 Help

15

3 New Generation of SuperPad
3.1 What's New in SuperPad 3.3

What's New in SuperPad 3.3 

Different from SuperPad 2, SuperPad 3.3 is developed by the brand new operation core,
SuperGIS Mobile Engine 3. As a result, all the functions SuperGIS Mobile Engine 3 has
are able to be designed in SuperPad 3.3.  SuperPad 3.3  is  more  powerful,  more  rapid
and more user-friendly  in  manipulation  than  SuperPad  2.  Besides  SuperPad  3.3  also
offers developers to develop plug-in extensions,  such as  self-defined layer format,  GPS
Protocol,  toolbar,  buttons,  etc.,  which will  satisfy  users'  more  needs  and  improve  the
working efficiency. 
   
The  new generation  of  SuperPad  3.3  is  designed  with  more  flexible  applications  and
could be used in more different fields, which is the first choice of Mobile GIS Software.
Besides, user can use SuperGIS Mobile Engine to customize the most  suitable mobile
GIS solution according to the needs.

Here we have listed the features of SuperPad 3.3:
1. With the brand new .NET Compact  Framework  as  its  core component,  it  could  run

on devices that  support  .NET CF WinCE /  Smart  Phone /  Desktop,  such as  PDA
or Smart cell phone .  

2. The brand new interface is more user-friendly;  the function is  more concentrated and
practical, and the process performance is higher and more rapidly. 

3. The  symbols  are  compatible  and  exchangeable  between  SuperPad  3.3  and
SuperGIS Desktop 3.1 to improve the use of data.

4. The new design of toolbar groups allows users  to  flexibly  change  toolbar  based  on
the  property  to  rapidly  manipulate  on  the  limited  PDA  screen;  moreover,  the  less
space toolbars  occupy,  the  more  space  map  could  display.  Such  design  will  help
users to read and manipulate map more easily and conveniently.

5. The new function of Screen Lock could reduce the chance of unintended modifying
map by touching screen in motion.

6. The dialog box is able to maximize for data reading clearly.
7. The  transparency  settings  of  layer  display  could  enhance  the  overall  looks  and

coordination of map.
8. The  brand  new  Smart  Editing  Bar  allows  users  to  undo  and  redo  the  editing

actions;  besides,  all  the editing actions to a single feature confirmed can be  stored
and redrew at a time, which could improve the overall efficiency and speed.   
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9. Combined with image and GPS information,  the brand new photo layer management
could rapidly  create photo layer then directly  open the  connected  photo  at  its  map
position through Hyperlink function, just like you are in the real environment.  

10.The  brand  new Slide  Zoom  function  allows  you  to  do  fixed  zoom  out  and  fixed
zoom in by drawing upwards and downwards with your finger for the quick browse. Or
you  could  also  use  this  function  together  with  another  new  function  of  Panning
Frame  to  do  panning  and  zooming  together  without  switching  functions  but  finish
your request more quickly.

11.Rotate Map function allows users to rotate map and fix  your heading aspect  as  the
PDA's  upward aspect  so that  as  users  are heading with PDA, they  do  not  need  to
rotate PDA to adjust  the map aspect  to fit  the  real  heading  aspect.  And  to  cancel
this  function  and  recover  map  aspect,  it  takes  only  one  click  on  Clear  Rotation
button to make it.  Quickly  and  precisely,  PDA  upward  aspect  will  be  locked  north
aspect. 

12.As GPS turns  on,  it  shows the GPS status  bar on the screen  along,  the  revealing
information includes longitude, latitude, altitude, heading speed, data and time.    

13.Tracklog  Record  function  has  great  upgrade  with  more  options  that  users  could
choose to save the tracklog file  in  type  of  KML,  GEO  or  SHP  file,  and  assign  the
format as point, line or polygon.

14.Users could develop plug-in extensions with SuperGIS Mobile Engine and customize
the needed functions.  For instance,  the function  of  Sketch  could  sketch  and  mark
the map on mobile devices. 

15.SuperGIS  Layer  Files  (*.slr)  of  SuperPad  3.3,  SuperPad  2,  SuperGIS  2  and
SuperGIS 3.1 are able to be used among these software freely, expanding the use of
file.

16.The map files of SuperPad 3.3 (*.spp) and SuperWebGIS (*.swg) are able to be used
in each other,  while  the  map  file  of  SuperPad  2  (*.spm)  still  could  be  opened  and
browsed in SuperPad 3.3.

17.Quick Explorer is  added on the right  side of the map,  allowing users  to use Pan,
Zoom In,  Zoom Out or Zoom To Full  Extent  function,  and  users  do  not  need  to
switch the main toolbar to choose the function.

© 2015 Supergeo Technologies Inc. All Rights Reserved.

3.2 I can Use SuperPad to...

I Can Use SuperPad to…
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All  the  new  or  enhanced  functions  described  above  are  taking  SuperPad  2  as  the
foundation  to  further  enhance  and  improve  in  user-friendliness,  flexibility  and
functionality. SuperPad can be a good assistant to do the field surveys, and its  mobility
feature  makes  it  easily  portable  and  flexibly  used,  which  will  help  you  complete  the
tasks more efficiently. 

The Mobile GIS, SuperPad 3.3, will assist you to do many tasks as below:

View the Existing Layers
SuperPad 3.3 supports various types of layers, such as vector and raster layers.
Supported  Feature  Layer:  Supergeo  GEO  (*.geo),  ESRI  Shapefile  (*.shp),  DXF
(AutoCAD,*.cad).
Supported  Raster  Layer:  MrSID  (*.sid),  ECW  (*.ecw),  JPG(*.jpg),  SGR(SuperGIS
Raster,*.sgr), GeoTiff (*.tiff), JPEG 2000(*.jpeg). 

Browse the Map
Various methods provided by  SuperPad 3.3 facilitate  you  to  view the  files  freely.  You
could set up labels to mark some specific attributes or set up the waypoints to navigate
with GPS. Or you could use Zoom In,  Zoom Out or Pan tool to further view the area
desired to understand. Also it offers Rotate Map tool to rotate map.

View the Attribute Data of Files 
Through the  Identify  tool,  you  only  need  to  tap  on  the  feature,  and  then  the  related
attribute  data  will  reveal;  or  it  will  open  the  related  exterior  information  or  file  on  the
screen immediately by  the function of Hyperlink to promptly  offer related message for
you. Thus, you do not need to search information. As you are editing features,  you can
zoom in the editing feature to the map center for easier viewing and help you precisely
edit.  

Measure Distance and Area
With  the  tools  of  Polyline  Measurement,  Freehand  Measurement,  Rectangle
Measurement,  Radial  Measurement  and  Feature  Measurement  you  could
measure the distance and area.

Connection of SuperPad and GPS
As  SuperPad  and  GPS  are  connected,  you  could  use  GPS  to  help  navigation  and
orientation based on the existing layers. Even you could edit the features  through GPS.
And  the  GPS  Tracklog  Record  function  provides  many  diversified  applications.  For
example,  you  might  convert  the  tracklog  file  to  GIS  file  and  display  on  SuperPad  or
other related GIS software. 

Edit the Layers
Through  SuperPad  3.3,  you  could  not  only  view or  search  your  layers  but  also  you
could edit the layers. To Point  layer,  Line layer or Polygon layer you could use stylus,
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mouse or even by capturing GPS position to create or edit features, and you could also
edit the spatial reference and attribute. As a result, all the properties  of the features  are
totally under your control.

Camera Function
SuperPad 3.3  supports  PDA's  Camera  function.  As  GPS  is  open  to  take  a  picture,
SuperPad  3.3  could  record  the  coordinates  of  the  position,  date  and  time  for  you  to
manage  pictures.  Moreover,  these  pictures  with  coordinates  are  able  to  be  used  to
create photo layers. The combination of pictures and GIS system will  give better image
concept of the real environment to users. 

© 2015 Supergeo Technologies Inc. All Rights Reserved.

3.3 Contact Supergeo

Contact Supergeo

If you would like to obtain the technical supports  or receive related educational training,
you might  find the contact  information from the Product  License  Agreement  or  please
directly contact your sales representative for further help.

You  are  also  welcome  to  visit  our  website  at:  http://www.supergeotek.com/for
technical supports and GIS related news.

© 2015 Supergeo Technologies Inc. All Rights Reserved.
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4 Installing SuperPad
4.1 Installing on Desktop Computer

Installing on Desktop Computer

SuperPad has to be installed in a different way. Firstly you need to install  SuperPad
on  your  desktop  computer  with  the  installation  disk.  After  the  installation  is
finished,  install  SuperPad  on  the  mobile  device  through  the  installation
program provided by the  desktop computer which already installed SuperPad.
So at the  second step,  you need to connect  the  mobile  device  (like  PDA)  and
computer  via  synchronization  software  and  follow  the  directions  to  install
SuperPad on the  mobile  device  step by  step  through  the  installation  program
provided by desktop  computer.  After  the  installation  is finished,  you  can  start
SuperPad with the mobile device. 

  

Since  SuperPad  3.3  adopts  .NET Compact  Framework  (abbreviated  .NET CF)  as  its
core architecture,  before  installation,  please  make  sure  your  desktop  computer
already  installed  .NET  Framework.  Then  you  can  start  to  install  SuperPad.  If
system  detects  .NET Framework  is  not  installed  when  SuperPad  is  being  installed,
please  install  the  program  which  is  provided  in  the  installation  disk  first(Install  .NET
Framework  on  Desktop  Computer).  If  .NET  Framework  is  being  installed  in  your
computer,  please  skip  to  Install  SuperPad  on  Desktop  Computer  and  install



SuperPad 3.3 Help

21

SuperPad.

© 2015 Supergeo Technologies Inc. All Rights Reserved.
Installing .NET Framework in Desktop Computer

Install .NET Framework on Desktop Computer

1. Insert the installation CD to the CD-ROM drive of your computer, and the SuperPad
Installation screen will pop-up automatically. Select the third item, “Redistributable.”

   

NOTE: if the installation screen does not  show up automatically  on the screen,  please
click Start ’ Computer , and right-click the CD-ROM drive under Computer directory.  A
pop-up menu shows up. Please click Open on the menu and then click  Autorun.exe to
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show the installation screen of the figure  above.  Now you  can  follow the  steps  below
and start to install.

2. After  you  enter  the  window  of  the  figure  below,  select  the  second  item,  “.NET
Framework 2.0” to start to install.

  

3. .NET Framework 2.0 setup program appears and click Next.
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4. Check  “I  accept  the  terms  of  the  License  Agreement”  and  click  Install,  and  the
installation starts.
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5. When  the  window  of  figure  below  shows  up,  it  means  .NET  Framework  2.0  is
successfully installed. In the next, please click Finish.
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6. After .NET Framework 2.0 is installed, please follow the descriptions below to install
SuperPad.

© 2015 Supergeo Technologies Inc. All Rights Reserved.
Installing SuperPad on Desktop Computer

Install SuperPad on Desktop Computer

1. Insert the installation CD to the CD-ROM drive of your computer,  and the SuperPad
Installation  screen  will  pop-up  automatically.  Click  “Install  SuperPad  3.3”,  and  the
installation starts.
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NOTE: if the installation screen does not  show up automatically  on the screen,  please
click Start  ’ Computer,  and right-click  the CD-ROM drive under Computer directory.  A
pop-up menu shows up. Please click Open on the menu and then click  Autorun.exe to
show the installation screen of the figure  above.  Now you  can  follow the  steps  below
and start to install.

2. Click Next to start installation.
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3. Click “I accept the terms of the license agreement” and click Next. The installation of
SuperPad starts.
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4. If your computer does not  install  .NET Framework,  the message as the figure below
will  appear to notify  to install  .NET Framework  first.  Please  click  OK.  And  install  .
NET Framework  according  to  the  steps  of  Install  .NET  Framework  on  Desktop
Computer.

   

5. When the window of the figure below shows up, it means the installation of SuperPad
is finished. Click Finish to accomplish installation.
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6. After the installation is accomplished, you could open SuperPad. 

If the license is not obtained yet, you will have ten minutes  to use SuperPad.  As to the
way to obtain the license, please refer to Obtaining a License.

© 2015 Supergeo Technologies Inc. All Rights Reserved.

4.2 Installing on Mobile Device

Installing on Mobile Device

To install  SuperPad on mobile  device  you should install  SuperPad on desktop
computer  first  and  connect  the  desktop  computer  which  already  installed
SuperPad  to  mobile  device  via  synchronization  software,  and  then  you  can
install  SuperPad on the  mobile  device.  So, before  installing  SuperPad  on  the
mobile device please install on desktop computer first, and then you can install
SuperPad  on  the  mobile  device  through  the  synchronization  software.
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Synchronization  software  is  used  to  communicate  between  desktop  computer  and
mobile  device,  if  your  operating  system  is  Windows  2000/2003/XP  please  install
ActiveSync 4.0 or higher as  the synchronization software;  if  your  operating  system  is
Windows  Vista  or  higher,  please  install  Mobile  Center  6.0  or  6.1.  Both  the  two
synchronization  software  mentioned  above  are  free  to  download  from  the  web  site.
Before  you  start  to  install  please  turn  on  the  Mobile  device  (for  example,  PDA)  and
connect PDA with desktop computer via synchronization software.   
  

Since SuperPad uses .NET Compact  Framework  (.NET CF) as  the development  core,
you should install  .NET CF  on  the  mobile  device  first.  Thus,  SuperPad  is  able  to  be
installed and activated.  To help you install  SuperPad conveniently,  SuperPad  provides
the Setup of .NET Compact Framework 3.5 in the installation disk. If your mobile device
does not install .NET Compact  Framework,  you can connect  your PDA to the desktop
computer through synchronization software and then install  .NET Compact  Framework
on  PDA  from  installation  disk(Install  .NET  Compact  Framework).  If  you  already
install .NET Compact Framework, please directly install SuperPad(Install SuperPad).

© 2015 Supergeo Technologies Inc. All Rights Reserved.
Installing .NET Compact Framework

Installing .NET Compact Framework 

1. Connect  your PDA to the desktop computer;  insert  the  installation  disk  to  the  CD-
ROM  drive.  When  the  installation  screen  appears  select  the  fourth  item,
“Redistributable”, in the right part and then select “.NET Compact Framework 3.5.”
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NOTE: if the installation screen does not  show up automatically  on the screen,  please
click  Start’ Computer,  and right-click  the CD-ROM drive  under  Computer  directory.  A
pop-up menu shows up. Please click Open on the menu and then click  Autorun.exe to
show the installation screen of the figure  above.  Now you  can  follow the  steps  below
and start to install.

2. After the window of the figure below shows up you can start  to install  .NET Compact
Framework 3.5. Please click Next.
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3. Click “I accept the terms in the license agreement” and click Next.

          

4. Select Complete and click Next.
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5. Click Install to start to install .NET CF 3.5.

          

6. When the window of  the  figure  below shows  up,  it  means  the  system  will  start  to
install  .NET Compact  Framework  3.5 on the mobile device.  At  the time,  please  do
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not click OK and check the PDA.

   

7. Select where you want to install .NET CF 3.5, Device or Storage Card of your PDA.

       

8. You should restart the PDA to finish the installation. Please click OK to restart  PDA.
After PDA restarts, please follow the directions and continue to install.
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9. Please go back your desktop computer and see the screen, and click OK.

   

10.When  the  window  of  the  figure  below  shows  up,  it  means  .NET  CF  3.5  is
successfully installed. Click Finish to accomplish  setup.
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11..NET CF 3.5 is successfully installed.

NOTE: If you wish to have better performance, higher version of .NET Compact
Framework is recommended.

© 2015 Supergeo Technologies Inc. All Rights Reserved.
Installing SuperPad

Installing SuperPad 

1. Click  Start  >  Program  Files  >  SuperGeo  >  SuperPad  3  >   Install  SuperPad  3  for
Windows Mobile.
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2. Click Next.

   

3. Click  “I accept  the terms of the license agreement” and click  Next.  The  installation
starts.
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4. When the window of the figure below shows up,  it  means  SuperGIS  Mobile  Engine
Runtime application program is  installed  and  downloaded  to  the  desktop  computer
successfully and the installation on PDA will  start.  At  the time please  do not click
OK to prevent the incomplete installation and check the screen of the mobile device.

   

5. SuperPad  is  developed  with  SuperGIS  Mobile  Engine  as  the  core.  So,  before
SuperPad is installed, the system will install SuperGIS Mobile Engine Runtime first.
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6. Choose  to  install  SuperGIS  Mobile  Engine  Runtime  on  Device  or  Storage  Card  of
PDA. After selection  please  tap  Install  to  start  to  install  SuperGIS  Mobile  Engine
Runtime.
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7. When  the  message  of  the  figure  below  shows  up  on  the  PDA  screen,  it  means
SuperGIS  Mobile  Engine  Runtime  is  installed  successfully.  Please  tap  OK  at  the
upper right corner.
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8. Go back to the computer screen, please ensure SuperGIS Mobile Engine Runtime is
installed on PDA successfully  and the screen of  the  previous  step  already  showed
up.  Then  you  could  click  OK.  After  you  click  OK,  system  starts  to  download
SuperPad on PDA.

   

9. After the downloading is finished, the screen will show the window of the figure below
again. At the time please do not click OK to prevent the incomplete installation and
check the screen of the mobile device.
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10.The system of PDA is ready to install SuperPad 3.
 

   

11.Choose to install on Device or Storage Card. After selection, please tap Install.
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12.When  the  window  of  the  figure  below  shows  up  on  the  PDA  screen,  it  means
SuperPad 3 is  successfully  installed on the PDA. Please tap OK at  the upper right
corner.
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13.Go back to the computer screen,  please ensure SuperPad is  installed on the PDA
successfully  and the window of the previous step  already  showed  up  so  you  could
tap OK.

   

14.Please click Finish to complete the SuperPad installation of PDA side.
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15.Now you  will  see  the  icon  of  SuperPad  3  on  Program  Files.  If  the  license  is  not
obtained yet, you will have ten minutes to use SuperPad. As to the way to obtain the
license, please refer to Obtaining a License.

   



Installing SuperPad

46

© 2015 Supergeo Technologies Inc. All Rights Reserved.

4.3 Obtaining a License

Obtaining a License

To activate all  Supergeo series  products,  you need to acquire the  license  after  setup.
Please find the serial number on the Product  License Agreement  attached  to  Product
Box. Before you start to obtain the license, please read the notes carefully: 

1. Please connect your PC to the Internet. License Verifier will  retrieve the valid license
through the Internet. 

2. For SuperPad,  you will  have two  sets  of  serial  number.  One  is  for  desktop  version
(SuperPad for Windows Desktop),  and the other is  for  mobile  device  (SuperPad  for
Windows Mobile).

3. It is necessary to connect your mobile device to the desktop before getting the valid
license for SuperPad CE version.

1. Go to Start > All Programs > SuperGeo > License Verifier.
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2. Click  the  product  desired  to  obtain  a  license  and  select  “Single  License.”  For
“Single License”, you only need to connect  to the Internet  while it  is  the first  time
to obtain a license. Because SuperPad is  not  available in Floating version,  please
do not choose Floating License.
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How to Obtain a Single License?

How to Obtain a Single License?  

1. Select  the  title  of  the  software  you  want  to  obtain  a  license  for,  choose  “Single
License” and click Next.
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2. Select  “Input  serial number  to  get  license  file  from  SuperGeo”  and  enter  the  serial
number  to  the  text  box.  Serial  number  could  be  found  on  the  Product  License
Agreement attached to Installation CD.
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3. If you have activated the software,  you could also select  the existing license  file  (*.
lic). Click “Specify the location of license file (*.lic)” and click the folder icon.

   

4. When “Open” dialog opens,  select  the license  file  and  click  Open.  After  the  serial
number is input or license file is selected, please click Finish.
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5. After the license is  successfully  obtained,  the message  as  the  figure  below shows
up.

   

NOTE:  if  you  want  to  get  license  for  CE  version,  please  connect  mobile  device  and
computer first. Then follow the steps of this  section by  selecting product  as  “SuperPad
for Windows Mobile.” 

© 2015 Supergeo Technologies Inc. All Rights Reserved.
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License Status

License Status

Before obtaining a license,  you could click  Details to  know the  license  status  of  the
software. Select the software you want to know and click Details.

   

The  “Details”  window for  the  selected  software  shows  up.  There  are  four  messages
released in the window:
Type:  the  ways  to  obtain  a  license.  Single  means  license  for  one  single  computer;
Floating means a floating license for use of software through internet.
Feature: a licensed software.
Version: the version of the software.
Expires: if your software is  an  official  version,  the  expiration  will  show “Unlimited”  as
presented in the square of the figure below.
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If your software is a trial version,  the expiration will  show the expiry  date,  as  presented
in the square of the figure below.
 

   

If there is no license for selected software, “License Unavailable” window will  pop up,  as
the figure presented in the following. This means that you have to continue the following
steps to obtain a license.
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If you tap About, the version information dialog box shows.
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5 Starting SuperPad
5.1 Starting SuperPad in Desktop Computer

Starting SuperPad in Desktop Computer

1. Click Start > All Programs > SuperGeo > SuperPad 3 > SuperPad 3 for Windows.

   

2. SuperPad starts.
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© 2015 Supergeo Technologies Inc. All Rights Reserved.

5.2 Starting SuperPad in Smart Device

Starting SuperPad in Smart Device

1. Tap Start > Program Files > SuperPad 3 on your mobile device.
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2. SuperPad starts.
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6 Opening Map and Layer
6.1 Map

Map

After SuperPad starts,  please add files  first  to start  to  use  all  the  functions.  You  can
open an existing map file (*.spp) or you can add many different layers to produce a new
map file. Or even you could create new layers and generate a new map file with the new
layers.

SuperPad map file (*.spp) contains all the map related settings, such as map scale,
spatial reference, map center, background, etc. SuperPad 3.3 supports SPP (*.spp) file
of SuperPad 3.3 and SWG (*.swg) file of SuperWebGIS. That is, the map files created
by SuperPad 3.3 and SuperGIS series products are exchangeable, which expands the
use of data and enables one map to be used in different software for different purposes.
However, SuperPad 3.3 can only read and browse SPM file (*.spm) of SuperPad 2, but
cannot store SPM file (*.spm) of SuperPad 2. 

© 2015 Supergeo Technologies Inc. All Rights Reserved.

Open Map

Open Map

Start SuperPad, and "Open Map" dialog box shows up.  If ”Show startup dialog” item is
unchecked in the Misc tab of System Settings,  “Open  Map”  dialog  box  will  not  show
up. About the “Show startup dialog” settings, please refer to System Settings,  the Misc
tab. 
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In “Open Map” dialog box, some map files (*.spp) are listed here.  Select  the map file to
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open and tap OK, and the selected map file opens.  The listed map files  come from the
folder set  in “Default  Maps and Data Path” in Path tab of System Settings.  About  the
settings of “Default  Maps  and  Data  Path”  please  refer  to  System  Settings,  the  Path
tab.
 
There are four buttons on the upper right side of the dialog box, and we will explain the
functions by each.

:  Create Quick  Project.  If you want  to add new layers  and make  them  into  a  map,
you can use this  function which creates  multiple layers  and attribute fields  by  default;
thus,  you  can  create  the  new layers  more  rapidly.  If  you  need  to  add  more  layers,
please tap   to add. Tap  to delete the selected layer.  Tap  to enter the dialog

box of field data of the layer. Tap  to specify the spatial reference.  As to the way to
create layer, please refer to Feature Layer.
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A project list shows up when the project is created. 
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: The map project files saved in the folder, “Default Maps and Data path” which is
set in the Path tab of System Settings, will be listed in the square below. If you tap the

button , the Recent Maps will be shown in the square below as well.
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: Open map. Tap the button and enter the “Open File” dialog box in which you can
select the map project file to open.
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: Enter the “Add Layer(s)” dialog box and select the layers to add to the map.
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New

Map

Map

A new map appears if you do not select a map project.
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1. If you are manipulating SuperPad and want to open a new map file, please tap the
Map/Layer button on the main toolbar, switch to Map/Layer toolbar, tap the
downward arrow of Open Map >New > Map.
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2. A query message will show up and ask whether you want to save the current map or
not. 
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Quick Project

Quick Project
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1. Tap Map/Layer button on the main toolbar, switch to Map/Layer toolbar, tap the
dropdown arrow of Open Map > New > Quick Project. 

    

2. Enter the Quick Project Settings dialog box. You will find one point layer, one

polyline layer and one polygon layer are created by default. Click  to set spatial
reference. Select a layer, click .
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3. Enter the Layer Properties dialog box where you can set  up the filename of the new
layer,  type,  codepage and the  fields.  Four  fields  are  created  by  system  as  default
settings or you can add or delete fields  according to your  need.  As  to  the  detailed
settings, please refer to Feature Layer.
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Feature Layer

Feature Layer

The new created layer  will  be  added  to  the  current  map  automatically  and  under  the
editable status in SuperPad. There are three types of layer provided for users  to create
or edit in SuperPad, including Point, Line and Polygon.

1. Tap the Map/Layer button on the main toolbar,  switch to Map/Layer toolbar,  tap the
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downward arrow of Open Map > New > Feature Layer.

   

2. The “New Layer” dialog box shows up, please input the field data as below:
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File Name: give a name for the file.  Tap  and choose a folder to store the creating
layer.
Type: tap the dropdown arrow and the layer type list shows up. It offers two different  file
types, *.geo and *.shp for each Point, Line and Polygon format. 

   

Code  Page:  to  select  the  code  page  for  the  layer  that  is  suitable  for  the  area  and
culture. Code Page is also termed as “character encoding” which consists  of a table of
values.  The combination  of  values  can  make  into  characters,  and  the  combination  of
characters  make into texts.  Through this  way,  the values can  be  used  to  represent  a
specified  language.  People  in  different  areas  use  different  languages;  even  the  same
language  might  be  used  in  a  different  way  with  different  habits  or  idioms  in  different
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areas. Through the code page you can specify the area and culture and then select  the
corresponding texts  to display.  Please select  the code page suitable for the  language
and area so that the situation of unreadable character can be avoided.
Add Z Value: New feature in SuperPad 3.3, by  checking up this  option,  user are allow
to edit the Z value in geometry of each vertex within the features, or collect the real time
observation height  via  GNSS.  To  edit  the  Z value,  you  will  find  it  easy  to  operate  by
using the Feature Properties function in Feature Properties Tool.

   

3. Then  add  the  field.  You  will  see  a  row of  tools .  Tapping  the  
button can add attribute field, and you will  enter “Add Field” dialog box.  Then please
input the information below:

Name: give a name for the field. 
Type:  specify  the  attribute  value  of  the  field  is  text  or  numeric.  The  numeric  values
include four types, Short, Long, Float, and Double.
Length Precision: if you select  Text  in the Type field,  Length will  be able to be set
up.  If you select  the  numeric  type  as  Short,  Long,  Float  or  Double  in  Type  field,  the
system will automatically give a default value in Length and Precision fields.  So the two
fields will be unable to be modified. 
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4. As you finished the information input,  tap OK  and  return  to  the  “New Layer”  dialog
box.  The  newly  created  field  will  be  added  to  the  list.  Please  follow  the  steps
described above to add more needed fields.

   

You can select a field and tap   to adjust the order. Also you can tap  or  to
delete the selected field or all fields. As the fields are successfully added, tap “OK.”
Then you can start to edit the layer, we will explain how to edit layer in Edit Features.
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NOTE:  You  need  to  create  one  field  at  least.  Field  names  are  not  allowed  to  be
repeated or the system will be unable to read data correctly.
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Photo Layer

Photo Layer

Photo layer is created by using GPS function and camera function of smart  device.  The
pictures with coordinate information can be connected to the point  features  of the layer
through SuperPad Hyperlink function.  Once users  tap  the  feature  of  photo  layer,  the
linked picture will reveal through hyperlink.

1. Tap the Map/Layer button on the main toolbar,  switch to Map/Layer toolbar,  and tap
the downward arrow of Open Map > New > Photo Layer. 
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2. “Photo Layer” dialog box shows up and tap  in Path to select the folder to save the
photo layer. In File Type select the format for the photo layer; three are three options,
*.geo,  *.shp and *.sph.  Please note that  *.sph is  a dynamic  photo  layer,  which  will
be described later. Then tap OK. 

   

3. Then  you  will  enter  “All  Photo(s)”  dialog  box.  Select  the  folder  which  saves  the
photos to add  and  check  the  photo(s)  that  you  want  to  add  to  photo  layer  in  File
Name. If you want to select all, check All Selections and tap OK. 
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4. Back to the map window, the photo layer is added to the map. 
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SPH Format
If you want  to save the picture layer in *.sph format,  firstly  please  select  the  folder  to
save the picture layer. The selected folder should contain the pictures  you want  to add
to the picture layer. 
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When the picture layer is  saved,  all  the pictures  with coordinates  in this  folder  will  be
automatically added to the layer.
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After that if the pictures in the folder are added or removed, the *.sph layer contents  will
change correspondingly.  For instance,  if the  picture  of  Taipei101  is  removed  from  the
folder,  when  you  open  the  *.sph  layer,  there  is  no  longer  Taipei101  feature  on  the
picture  layer.  In  other  words,  *.sph  dynamically  changes  the  layer  contents  if  the
pictures in the folder are added or removed.
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 How  to open the photos of photo layer?

How to open the photos of photo layer?

1. Tap the Explorer button on the main toolbar, switch to  Explorer toolbar, tap the
downward arrow of Identify > Hyperlink on the menu.
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2. As Hyperlink function is activated, tap on the map screen with stylus (or mouse),
the photograph linked to this feature will automatically show up on the window.

   

NOTE: the photo layers are created in point format. The point feature on the photo layer
is  the  coordinates  of  the  picture.  The  folder  used  to  save  the  pictures  taken  by
SuperPad can be set in System Settings, please refer to PDA Pictures.

The pictures used in photo layer should contain coordinate information,  and how is  the
coordinate information generated? First  of all,  you should make sure the  smart  device
you want  to use to take pictures  is  equipped with GPS function  and  ensure  the  GPS
settings correct. After that, go to the Camera tab of System Settings in SuperPad and
set  “Save X,  Y coordinate.” As to the Camera settings,  please refer to PDA Pictures.
When GPS position is  successfully  received,  tap the Camera  function.  The  PDA  will
enter the camera mode, and then you can start  to take pictures.  Follow these steps to
take pictures and the pictures will contain coordinates.

© 2015 Supergeo Technologies Inc. All Rights Reserved.
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 PDA Pictures

PDA Pictures

To take the PDA pictures for the creation of photo layers, you need to set up the
related settings before taking pictures. 

1. First, tap the System Settings button on the main toolbar, switch to System
Settings toolbar and tap System Settings.

 

   

2. “System Settings” dialog box shows up and tap the Camera tab, then select the
setting options.
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Default Picture  Folder:  set  up  the  path  for  the  folder  to  save  the  pictures.  In  other
words,  you save the pictures  in this  folder.  While you are  creating  a  photo  layer,  you
just open the same folder to obtain photo files instead of spending time on searching. 
Prefix:  set  up  the  prefix  of  the  pictures  file,  and  the  default  is  “photo.”  The  pictures
format  is  JPG (*.jpg),  which  will  be  automatically  added  to  file  as  the  extension.  For
example, the settings are set  to record data and time,  so the file name will  be “photo-
20090527110605.jpg.”
Quality: set  up picture quality.  There  are  four  options  including  Default,  Low,  Normal
and High.   
Date/Time in Filename: record the date and time in filename. If you check “Date/Time
in Filename”, the file name will be “photo-20090527110605.jpg.”
Save X, Y coordinate: if you want  to produce photo layers  with these photos,  please
do check “Save X, Y coordinate.”

NOTE: in terms of layer, in addition to the above described supported formats,  you can
also  use  SuperGIS  Data  Conversion  Tool  to  transfer  files  of  different  formats  to
SuperPad accepted files and used in SuperPad so that  the performance of display  and
manipulation can be enhanced. 
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Graphics Layer

Graphics Layer

Graphics layers are to annotate the general layer with text and feature symbols to
facilitate users to clearly understand the annotation information. For instance, if a
dangerous area in Layer A needs to be annotated, you can use Graphics Layer to
create a layer for displaying annotation on the map rather than set the attribute fields;
the format is *.spg. Please see the figure below that Dangerous Area rectangle is the
symbol feature of the Graphics Layer which clearly marks the location but will not
influence or damage the original contents of layer.
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On one Graphics layer, the various kinds of graphics  including text  point,  text  polyline,
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text polygon, text rectangle and text ellipse can be added at  a time,  and the style and
text  of  each  graphic  can  be  set  respectively.  As  to  the  way  to  edit  graphics  layer,
please refer to Edit.
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Open Map

Open Map

1. Tap the Map/Layer button on the main toolbar, switch to Map/Layer toolbar, tap  
Open Map.
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2. “Open Map” dialog box opens and please choose the map file desired to open. 
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Note that you might add any map you want to use.

© 2015 Supergeo Technologies Inc. All Rights Reserved.
Save Map/Save Map As

Save Map/Save Map As

Tap the “Map/Layer” button on the main toolbar, tap the “Open Map” downward arrow >
 "Save Map/Save Map As." 

The map will be stored in the original file or as a new map file in the format of *.spp.
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Import APM

Import APM

 
SuperPad supports to import ArcPad map files (*.apm). 

1. Tap the Map/Layer button on the main toolbar, switch to Map/Layer toolbar; tap the
downward arrow of Open Map > Import APM.
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2. Select a file to open in SuperPad.
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Map Properties

Map Properties

In Map Properties, you could set up the properties of the current map, including title,
comments and spatial reference as the information for other users to better know the
map. 

1. Tap the Map/Layer button on the main toolbar, switch to Map/Layer toolbar, and tap
the downward arrow of Open Map > Map Properties.
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2. “Map Properties” dialog box shows up, and you could edit the title and comments of
the map in the General tab. 
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In the Spatial Reference tab and you can set  the map's  coordinate system. The map's
coordinate  system  can  be  modified  by  tapping  the  earth  button   at  the  lower-left
corner. The “Coordinate System” dialog box shows up after the earth button is  tapped.
 Here you can set up the type of Datum or Projection.
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After selection, tap OK, it shows the selected coordinate title and details in the "Map
Properties" dialog box. Or you can tap  to remove the spatial reference.
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In Scale tab, you can assign the map scale. 
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In the Extent tab, if you select  Map Center,  please enter XY coordinate values and the
map will be panned to the extent in which the specified coordinates is the center.  If you
select  the  Map  Extent,  please  enter  the  boundary  values,  and  then  the  map  will  be
zoomed to the extent with the four specified coordinates as the boundaries.
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Please note that if you want to enter the coordinates in the format of Degree Minute
Second (DMS), please separate the values of degree, minute and second by space.
Please see the figure below, X means 120 degrees 39 minutes and 48.455 seconds.

   

© 2015 Supergeo Technologies Inc. All Rights Reserved.
Recent Layers

Recent Layers
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Tap the Map/Layer button  on  the  main  toolbar,  switch  to  Map/Layer  toolbar,  and  tap
downward  arrow of  Open  Map  >  Recent  Layers.  A  list  of  layers  that  are  recently
opened shows up.  As you tap one layer from the list,  it  will  be automatically  added to
the map.
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Recent Maps

Recent Maps

Tap the Map/Layer button on the main toolbar, switch to Map/Layer toolbar, and tap the
downward arrow of Open Map > Recent Maps. A list of maps that are opened recently
shows up;  please select  the  one  you  want  to  open.  Then  the  map  will  automatically
load in.
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Exit

Exit

Tap the Map/Layer button on the main toolbar, switch to Map/Layer toolbar, and tap the
downward arrow of Open Map > Exit  to close SuperPad. 
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If you have not saved the map file, a query box will show up and ask whether you want
to save the file.
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6.2 Add Layer

Add Layer

GIS map is  the display  of  overlaying  many  different  typed  layers,  consisting  of  many
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different  layers.  It  supports  two  types  of  layer:  Feature  Layer  and  Raster  Layer.
SuperPad 3.3 supports  GEO  layer,  which  is  the  Supergeo  self-developed  vector  data
format.  A  GEO  layer  has  two  files.  One  is  the  GEO  file  (*.geo),  used  to  record  the
spatial data containing feature information and spatial information;  the other is  DBF file
(*.dbf), used to record the attribute data,  in which every  record of attribute corresponds
to a property  of the feature in GEO file.  Vector  layer  includes  three  types  of  layer  as
point layer, line layer and polygon layer.

Besides feature layers, SuperPad supports  many different  imagery  files  in raster layer.
Overlaying feature layers and raster layers  enables  users  to compare data,  highlighting
the theme of files.  The supported raster files  include ECW(*.ecw),  MrSID(*.  Sid),  JPG
(*.jpg), GeoTIFF (*.tiff), JPEG 2000(*.jpeg) and SuperGIS Raster SGR (*.sgr) Supergeo
self-defined.  The  world  files  always  accompany  raster  layers  to  describe  the  datum
information for the image.  Moreover,  raster  layer  can  only  be  displayed  in  SuperPad,
but cannot be edited. 
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Add Layers

Add Layers

1. Tap the Map/Layer button on the main toolbar, switch to Map/Layer toolbar, tap Add
Layers.

   

2. “Add Layers” dialog box opens. Check the layers desired to add.  is point layer,
 is line layer,  is polygon layer and  is image layer.
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Note that you might add any layer(s) you want to use.

3. The selected layers are displayed on the map.
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Layer Files

Import/Export

Import/Export

SuperPad supports  SLR (*.slr) layer  file,  which  is  compatible  to  the  SuperGIS  series
products, so the layer files are able to be used in SuperGIS series products, too.

Tap the “Map/Layer” button,  switch to “Map/Layer” toolbar,  tap the  downward  arrow of
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Add Layers >  Layer File. Select  Import  or Export  to import  the specified SLR file  or
export the file in a new SLR file.

    

© 2015 Supergeo Technologies Inc. All Rights Reserved.

6.3 Save Screen

Save Screen

Save Screen function is a lot like desktop computer's Print Screen function. When
you need some screen image in manipulation, Save Screen function can be used.

1. Tap the Map/Layer button on the main toolbar, switch to Map/Layer toolbar; tap the 
Save Screen button on the toolbar.

   

2. The “Save File” dialog box appears, please enter the file name and choose the file
type(*.bmp, *.jpg, *.gif and *.png).
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3. Open the file.
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6.4 About SuperPad

About SuperPad

1. Tap the Map/Layer button on the main toolbar, switch to Map/Layer toolbar, tap 
About SuperPad and the dialog box that shows version and copyright of SuperPad
program shows up.
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2. Tap OK to close the dialog box.
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Quick Reference (for PC version)

Quick Reference (for PC version)

It provides a quick reference for the tools. 

Tap the Map/Layer button on the main toolbar, switch to Map/Layer toolbar, and tap
downward arrow of About SuperPad > Quick Reference. And the Quick Reference
shows up.
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User Guide (for PC version)

User Guide (for PC version)

The online user manual is provided. 

Tap the Map/Layer button on the main toolbar, switch to Map/Layer toolbar, tap
downward arrow of About SuperPad >  User Guide and the online manual displays.
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7 Layer Management
7.1 Layer Manager

Layer Manager 

Map is the result of overlapping different types of layers, including point layer, line layer,
polygon layer and image layer.  Each layer can be set  to display  in  different  ways,  for
example visibility,  edit  ability,  the overlapping order,  etc.  As to the detail  settings  of  a
single layer,  such as  symbol,  visible scale,  and  hyperlink  or  so,  are  set  up  in  Layer
Properties. 

Tap the Map/Layer button on the main toolbar,  and  tap  Layer  Manager  to  enter  the
“Layer  Manager”  dialog  box.  There  are  seven  options  at  the  top  of  the  dialog

.  Among  the  seven  options,  Layer  Properties  covers
much more contents and will be explained in another section independently.

     



Layer Management

110

Note that you might add any layer(s) you want to use.

© 2015 Supergeo Technologies Inc. All Rights Reserved.
Adding Layer(s)

Adding Layer(s) 

: If you still want to add layer(s), please tap this icon and choose layer(s) you want
to add from the directory. Back to the “Layer Manager” dialog box, you will find the
layer(s) you just added are added to the list now.
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Adjusting Layer Display Order

Adjusting Layer Display Order

:  Map  is  the  display  of  overlapping  many  different  types  of  layers.  However,
sometimes layers  might  mask the display  of other layer(s).  For example,  the  polygon
layer might mask the display  of point  layer.  GIS map is  the result  of overlapping many
layers.  Therefore,  if  the  bottom  layer  is  a  point  layer  or  a  line  layer  whose  features
possess smaller  area,  the  upper  polygon  layer,  whose  features  possess  larger  area,
might  cause the bottom layer partial invisible.  Thus,  the  point  and  line  layers  will  not
display clearly on the map. By viewing the icons on the left side of the layer name, you
can learn the layer type,  refers  to  point  layer,   refers  to  line  layer,   refers  to
polygon  layer,  and   refers  to  image  layer.  The  icons  offer  helpful  information  for
adjusting the overlapping order. We suggest you to adjust  the layer order right  after the
layers  are added.  If  you  want  to  add  image  layer,  we  suggest  you  to  place  it  in  the
bottom  place  to  avoid  its  large  image  covering  other  layer's  display.  Therefore  the
recommended  order  will  be  point  layer  >   line  layer  >   polygon  layer  >  
image layer from top to the bottom.
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As you are adjusting the layer order, you need to select a layer first. When the layer is
selected, tap  and the selected layer will be moved upward by one place; tap  and
the selected layer will be moved downward by one place.

After you have settled the order, tap OK and back to the map. You will find that the
order changes based on the settings.
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Deleting Layer(s)

Deleting Layer(s)

: Delete layer(s). Select the layer that you want to delete and tap . A query dialog
box shows up. If you are sure to delete the selected layer, tap Yes to delete; if you do
not want to remove the layer, tap No.
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Removing All Layers

Removing All Layers

: Remove all layers. If you want to delete all layers at a time, tap  directly without
selection, and a query dialog box appears. If you are sure to remove all layers, tap Yes
to remove all layers at a time; if you want to cancel, tap No.
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Group Layer

Group Layer
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: Users can select several layers and make them into Group Layers  by  using Group
Layer function,  so editing and managing map become more convenient.  If you need to
manage  layers  by  viewing  several  layers  as  one  layer,  you  can  set  these  layers  a
Group Layer.  For instance,  to one river layer and one irrigation channel layer,  you can
make them a Group Layer and name it “Hydrology data.” The display  of Group Layer is
just like the way ordinary  layer displays.  However besides the group layer name, all  of
the  contained  layers  are  listed  below the  Group  Layer.  To  each  layer  in  the  Group
Layer, the properties and visible scale can be set individually or you can directly  set  up
the  visible  scale  for  the  entire  Group  Layer.  As  to  the  display  order  of  the  layers  in
Group Layer,  it  can also  be  set  in  Group  Layer  Properties.  If  the  visible  scale  of  the
Group Layer conflicts  with that  of the layer  under  it,  the  system  will  apply  the  Group
Layer's setting as priority.

1. Click Group Layer  and a Group Layer is added to the map. Select the Group
Layer and click the Layer Properties  to enter the dialog box to set up the
properties.

   

2. In the properties dialog box, there are three tabs, Source, Display and Layers which
can be set.  In the Source tab, the name of the Group Layer can be set. And it
shows the path, feature amount, size and extent of the group layer..



Layer Management

116

   

3. In the Display tab, the visible scale and transparency can be set for the Group Layer.
The way to set up Display tab is just the same way as setting up the ordinary layer.
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4. In the Layers tab, you can add layers to Group Layer.
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5. In Layers  tab,  click  Layers to enter the “Layer Manager”  dialog box.  Click   to
add layer. Just like the way to manipulate the ordinary layers,  the order of the layers
in Group Layer can also be adjusted; the layer in group layer can be deleted as  well.
Click  to enter the “Layer Properties” dialog box and set  up the settings for each
layer.
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6. Or you can continue to add a new Group Layer under the Group Layer you already
built by tapping .
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Setting Visible

Setting Visible

You might  add many layers  at  a  time,  but  sometimes  you  might  want  to  hide  some
specific  layer(s).  For example,  a  Rest  Area  layer  is  not  necessary  to  display  on  the
map all the time, but you need to know the position occasionally. Or you might  need to
display  some  layer(s)  in  some  special  condition.  For  example  when  you  are  editing
layers  you can set  the image layer invisible to save  the  loading  time;  till  you  want  to
display the image layer then set it visible. In situations like this, you can set up whether
to allow layers visible or not.  
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In the “Layer Manager” dialog box you can see all  the layer names of the added layers
listed below. You will  see  under the layer name, which means this  layer is  visible
on the map; if you tap the icon, it becomes ,  which means this  layer is  invisible on
the map. If you want to set all layers visible, please check All  Visible  at  the top of the
layer list then all layers display on the map.

NOTE: Crossing out  layer's  visible icon does not  means that  the layer will  be removed
but means the layer will not be redrawn on the map.  Though the layer does not  display
on the map, you still can create new features and edit  attribute data to it.  However,  the
created features will be invisible on the map. Only in visible status,  the created features
of  the  invisible  layer  can  be  seen  on  the  map.  Another  situation  is  like  that  only  in
visible status can you use Select Feature  tool to query  and edit  the existing features
on the map.
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Setting Editable

Setting Editable

On the map you might  add many layers,  and you may add more than one layer of the
same type.  For example,  two line layers,  two point  layers  and two polygon layers  are
added to a map.  When you would like to edit  point  features  from layer which is  one of
the  point  layers,  the  system  cannot  recognize  which  point  layer  you  intend  to  edit.
Therefore, we need to specify that only one layer of a type of layers  is  editable.  In other
words, at most one point layer, one line layer and one polygon layer can be set editable
at  a time.  Then,  the  system  can  correctly  judge  the  editing  acts  are  made  to  which
layer. As a result, only one layer of one type is able to be set editable.  
  

At the bottom of the “Layer Manager” dialog box, a list shows all of the layers.  And you
can see  below the layer by default, which means the layer is  in-editable;  if you tap
the icon again,  it  becomes ,  which means editable.  You can determine whether  to
set  the layer editable or not  by  directly  tapping this  icon.  Moreover,  only  one  layer  of
one  type  (point  layer/line  layer/polygon  layer)  is  able  to  set  editable.  Thus,  if  you
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already set  point  layer A editable and you want  to set  point  layer B editable,  you  can
tap  of layer B to switch to .  Then,  you will  see layer A automatically  switch  to

. The final result is only layer B is editable.   

NOTE: Raster image layer can be displayed only but is unable to be edited. 
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Legend

Legend

In addition, there are three tabs at the bottom: Layer, Legend and Snapping. In Legend
tab, click  and you can expand all legends of the map. 
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Snapping

Snapping

Snapping, when users are creating or editing features, they can precisely  snap features
to another existing feature within the specified snapping tolerance.  For instance,  to two
neighboring farmlands,  which share the border,  you need to ensure they snap to each
other exactly. And Snapping is the tool that can help you easily achieve the goal.

   

In  Snapping  tab,  the  snapping  properties  and  snapping  tolerance  can  be  set.  The
snapping  tolerance  is  a  specific  distance  which  is  the  radius  the  mouse  cursor  or
stylus  moves.  If encountering the parts  of feature that  are set  to be snapped  to  within
the tolerance distance,  the system will  automatically  snap the mouse cursor or stylus
to the new position.
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In Snapping tab, you can enter the tolerance by  yourself,  the unit  is  pixel and you can
tap Pixel with stylus  to modify  the value.  The snapping properties  refer to the  parts  of
the  existing  feature  to  which  you  want  the  editing  features  to  snap.  The  snapping

properties include Vertex , Edge , Midpoint and Endpoint .

Vertex: snap to each vertex of each feature of the layer. 
Edge: snap to all edges of each feature of the layer. 
Midpoint: snap to the middle point of an edge between two vertices. 
Endpoint: snap to the start or end point of a polyline feature. 

To  Point  layer  user  can  only  set  whether  vertex  is  to  be  snapped  to;  composed  by
vertices,  polyline  can  be  set  whether  to  be  snapped  to  vertex,  edge,  midpoint  or
endpoint; as to polygons, you can set whether to snapped to vertex, edge or midpoint.

For instance, in order to snap vertex and edge of farmland A and B, the vertex and edge
need to be set  available to  snap  to.  As  a  result,  in  editing  farmland  B,  the  cursor  or
stylus will automatically snap to farmland A's  vertex  or edge when the cursor or stylus
moves in the tolerance. 
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In editing feature B,  move the vertex  to  approach  the  position  of  feature  A  where  you
want  to  snap  to.  As  the  distance  is  less  than  the  snapping  tolerance,  the  vertex
automatically  snaps to feature A at  the position where the square  indicates.  After  the
editing is finished, confirm and write in the editing. The snapped features present  as  the
figure at the upper-right; the two features  share some the border seamlessly.  Snapping
is finished.

Please refer to Move Vertex to learn the way to operate snapping.

© 2015 Supergeo Technologies Inc. All Rights Reserved.

7.2 Layer Properties

Layer Properties 

In Layer Properties you can set up the properties  of each single layer,  including layer
source,  fields,  symbol,  visible scale,  label,  hyperlink,  etc.  While  the  image  layer  has
three settings only  including Source,  Spatial  Reference  and  Display,  but  for  DXF  and
DGN files  Symbology is  additionally  able  to  be  set  particularly.  Now we  are  going  to
explain the settings respectively.  



SuperPad 3.3 Help

125

Please select a layer you want to review and tap  to open the Layer Manager of the
selected layer or double-click  the layer you want  to select  directly  to enter.  There  are
totally  seven  tabs  at  the  bottom  of  the  dialog  box:  Source,  Spatial  Reference,
Display,  Symbology,  Hyperlink,  Fields and Label.Tapping the leftward  or  rightward
arrow can move the tabs. 

© 2015 Supergeo Technologies Inc. All Rights Reserved.
Source

Source

Source tab displays the information of name, path, features, size, code page and
extent for your reference. Please note that data revealed in this tab is for your reference
only, which is unable to be modified.
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Spatial Reference

Spatial Reference

If the layer is defined with coordinate system, the Spatial Reference will show. However
if the layer is not defined with a coordinate system, you can tap  and set the spatial
reference.
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Display

Display

You  can  set  the  visible  scale  of  layer  in  Display  tab.  In  general,  “Show  layer  at  all
scales” will be suitable for most situations, but sometimes you might  need to show the
major  layers  only,  and  show the  minor  layers  at  some  specific  scale.  For  instance,
there are “National High  Way”  and  “County  Road”  layers  on  the  map.  “County  Road”
layer is  not  very  useful as  the map extent  covers  the  entire  nation,  and  the  map  with
“County  Road” layer will  make the screen more massive.  On the contrary,  users  need
to know the  distribution  of  “National  High  Way”  more;  as  a  result  the  “County  Road”
layer should be hidden.  While the map is  zoomed to county  and township extent,  the
county  road will  be needed to display,  providing  detail  information.  In  such  case,  you
can set up the visible scale to “Country Road” and display the layer as the map scale is
zoomed between the settings.

   

If you want  to set  “When  zoomed  between”  please  tick  the  option  first  and  input  the
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maximum and minimum scale.  Only  as  the map is  zoomed to the setting scales,  will
the layer display.

Transparency sets the transparency of the layer that  the smaller the value is,  the more
transparent the layer is.
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Symbology

Symbology

You can set the single symbol of the layer through this tab. As to symbol settings in
SLR or SGD project file, SuperPad also support to import and you can display or
modify the attributes.
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Point

Point

1. Select the symbol, click , and you will enter “Symbol” dialog. Select new symbol
from the list below and Current will show the selected one.



SuperPad 3.3 Help

129

       

 

2. Click Current and enter Point Symbol dialog, here you can set the style, size, angle,
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border, color and offset.

    

3. When you finish setting, click OK. Back to the map and you will see the symbol has
been modified.
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Polyline

Polyline

1. Select the symbol, click , and you will enter “Symbol” dialog. Select new symbol
from the list below and Current will show the selected one.
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2. Click Current and enter Line Symbol dialog, here you can set the style, size, angle,
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border, color and offset.

    

3. When you finish setting, click OK. Back to the map and you will see the symbol has
been modified. 
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Polygon

Polygon

1. Select the symbol, click , and you will enter “Symbol” dialog. Select new symbol
from the list below and Current will show the selected one.
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2. Click Current and enter Fill Symbol dialog, here you can set the style, color and
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outline.

    

3. When you finish setting, click OK. Back to the map and you will see the symbol has
been modified. 
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Hyperlink

Hyperlink

If you want to link features to exterior sources, such as  files  or websites,  please create
the file paths or website address in the attribute fields  as  you are creating a new layer.
Moreover, in the Hyperlink page of Layer Properties the setting of linking field should
be  specified.  After  all  settings  are  finished,  the  map  displays,  and  you  can  use
hyperlink function to directly tap features and open the file or link to the website. 

1. First of all, tap Layer Manager,  select  the layer that  you want  to set  hyperlink  and
tap Layer Properties . Tap Hyperlink tab.  Tap the drop-down arrow, the display
box  shows  up.  Then,  select  a  field  that  records  hyperlink  file  path  or  website
address.



Layer Management

138

   

2. Tap OK back to the “Layer Manager” dialog box. 
3. Tap OK to close the “Layer Manager” dialog box.  After the settings are finished,  you

can use the hyperlink  function while manipulating map.  As to how to  use  hyperlink
function, we will introduce in the Hyperlink. 

 
NOTE: if  you  want  to  link  to  some  specific  websites,  please  make  sure  the  Internet
service is  ready.  Sometimes you might  encounter some significant  situations in which
the link cannot work successfully. Then, please check the cases as below stated:
Lack of extension: If the hyperlink  is  to link  the exterior file,  please  do  remember  to
add the extension by the end of the file name.
Lack of suitable program: The linking file might  be unable to open if you do not  have
the suitable application to open or files in wrong file format.
Incorrect file path: The file might not open when the application cannot find out the file
you specify with a correct path. Please check whether the file path settings in attribute
data are correct.
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Fields

Fields

Fields  refer  to  the  attribute  fields.  The  Field  page  in  “Layer  Properties”  dialog  box
shows the type and length of all  the attribute fields.  To the left  field name you will  see
the label of  or .  represents  the text  type is  numeric,  represents  the type  is
string,  from which you can  recognize  the  type  of  field  text.  Users  are  able  to  add  or

delete fields to a layer as the target layer is not editable. Tap  to add new fields  and
set up the name, type, length and precision.
  

  

Tap  to delete the selected fields, please tap Yes.
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Label

Label

It refers to the text label. As annotators of features are displayed on the map, users can
recognize  the  information  easier  and  get  the  layer  information.  Label  is  to  mark  the
attribute values of a specified field on the map for users  to recognize.  So,  as  users  see
the features,  they can know the attribute values through the label,  or even find out  the
position of feature by the labeled attribute value.
 
For instance, let's take Taipei City districts for example. If you want  to mark  the district
names  on  each  district  for  users'  easier  understanding  of  the  district's  name  and
position,  the  label  function  can  be  used  to  achieve  the  goal.  So,  you  will  see  the
administrative districts with name shown on the map.

1. First of all, enter Layer Properties, tap the Label tab,entering the “Label” dialog box.
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2. In the next, check Show Label and set up the following items:
Type:  two  options,  Simple  and  Line.  What  should  be  noted  is  that  you  can  select
Simple for point,  line or polygon layer,  but  can only  select  Line for Line Layer.  Line  is
not available for point  or polygon layer.  Why does line layer have a particular line type
to choose? This is because in line layer the text  of label can be divided into along line
or  not,  repeated  text  or  not  and  the  problem  of  orientation  of  text  position,  which  is
more complex and needs to do special treatment.  If  you  select  Line  type  for  the  line
layer, the Placement item will  offer different  contents  from selecting Simple type.  Later
in the Placement  part  we will  respectively  explain the options provided for  selection  of
Simple and Line, and now we take Simple as the example.
Field: to specify the field to mark label. 
Style: tap Text  Symbol entering “Text  Symbol” dialog box.  Here you can set  up Font,
Color and whether to display Shadow and Halo effect.
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3. To set up font, please tap Font, and enter “Font Setting” dialog box.
4. Tap the drop-down arrow of Name, Size and Style to set  the name, size and style of

the font  by  each.  Style includes four styles  of regular,  bold,  italic  and bold  italic  for
your  options.  Besides,  you  can  choose  whether  to  use  Strikeout  and  Underline
effect. If the Strikeout effect is checked, the strikeout effect preview will display in the
square below.
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5. If  you  want  to  set  Shadow effect,  please  check  Shadow  item  and  set  up  Width,
Color, Distance and Position.

Width: width of the shadow.
Color: color of the shadow.
Distance: the distance from the shadow to text.
Position: the relative position of shadow to text.

      

6. If you want to set up Halo effect,  please check the Halo item and set  the Width and
Color.  What  is  halo  effect?  It  is  to  spread  out  a  color  zone  with  some  width  to
enhance the visual effect  from the edge of the text,  just  like circling the  text  with  a
color zone and extent slightly outwards, such as . The yellow zone is  the
halo  effect  display.  After  all  settings  are  finished,  please  tap  OK  and  back  to  the
Label page to preview the display  with the settings.  If  you  want  to  adjust,  tap  Text
Symbol again to modify.
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7. Placement: the label can be divided into two kinds, for line layers only and for layers
of all  types of layers.  Putting the line layer from the other groups is  because in line
layer the text can be placed along line or not, repeated text or not and the orientation
of  text  position  to  the  line,  which  is  more  complex  and  needs  to  do  special
treatment.  However,  the layers  of  the  other  types  need  to  consider  the  text  layout
only.  For example,  place the text  to the center,  right,  or  left  to  the  feature?  Or  the
system can set the various combinations.  For example,  if the setting orders  are set
as center priority and up the second, the system will place the labels to the center in
top priority.  If the center layout  will  be  deterred  by  something,  the  system  will  use
the second order setting.  In conclusion,  system will  follow the  placement  orders  to
place the text. Besides, line layer and layers  of other types both can set  the label's
maximum and minimum visible scale so that the layer will not be massive due to too
many  texts  on  the  map.  With  the  visible  scale  setting,  the  map  looks  more
comfortable, neatly and easy to read. No matter you choose Simple type for a point,
line or polygon layer,  when you  tap  Placement,  it  shows  the  identical  “Placement”
dialog box.  Please check the desired placements  first,  then  tap or   to  arrange
the order.
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For instance, the priority orders set Right, Center and Left, referring that  the text  will  be
placed according to the priority  of right,  center and left.  If  the  text  will  be  deterred  as
placement to the right,  system will  adjust  the placement  to the second order-center;  if
the placement  in center also gets  deterred,  it  will  be  placed  to  the  third-order-  to  the
left.

   

8. If you choose Line type,  as  tapping the Placement,  “Line Feature  Annotator”  dialog
box appears. There is one item to set:

Along: two options, By Word and By Character.  Along is  used to set  whether the text
is to display along the line feature or according to the text's original type.
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By word means each character of the text is along a line.

   

While By Character refers each character is along the line feature.
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9. Visible  Scale:  you  can  set  the  visible  scale  “as  layer's  visible  scale”  or  “when
zoomed between.” The use of label can give more information, enriching the map with
higher  value.  However,  under  some  situations  the  labels  might  interfere  the  map
reading.  For  instance,  when  you  are  viewing  the  global  rainfall  distribution,  it  is
unnecessary  to mark  Taiwan administrative district  names on  the  map,  which  is  of
little thematic map meaning and troubles readers instead.

   

10.The reference scale can display the label at a specific  scale ratio.  When the map is
zoomed in, the label will become larger accordingly; when the map is  zoomed out,  it

becomes smaller.  You can tap  to acquire the current  map scale and set  it  the
reference scale. If the reference scale is  not  defined,  the label will  be displayed at  a
fixed  scale,  which  means  the  label  displays  in  fixed  size  no  matter  the  map  is
zoomed in or out;  If reference scale is  defined,  when map is  zoomed  in  or  out,  the
label will also be zoomed in or out according to the reference scale.

About “when zoomed between”, if the minimum scale is set 1:7,000,000, and maximum
1:430,000.  After  settings  are  finished,  tap  OK  in  each  dialog  and  back  to  the  map
window. In figure below, you can see the scale at  the lower right  corner is  between the
set scales as 1:445,048. As a result, the labels are displayed.
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11.Allow  Duplicate: if you choose to allow duplicate,  please  check  it;  if  not,  please
uncheck it.  Sometimes too many labels  duplication makes the map layout  massive
and  uneasy  to  recognize.  See  the  figure  below,  so  one  label  appears  once  only,
allowing the layout looks more neat and comfortable.

   

12.Allow  Overlap:  if  you  choose  to  allow  overlap,  please  check  it;  if  not,  please
uncheck it.  The annotators  might  overlap  due  to  the  close  distance  to  each  other,
resulting in unidentified text  and massive  look;  in  such  situations,  we  suggest  you
uncheck Allow Overlap.

13.If you consider presenting label messages completely, you can set up Allow Overlap
function as  figure below. If the overlapping causes the unidentified text,  we  suggest
you to zoom in the map display. So, the label will  be clearer.  Or you can set  up the
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label's visible scale based on the most  comfortable visual effect,  which will  show the
labels  when map is  zoomed  between  the  maximum  and  minimum  values  you  set.
Therefore the map looks good and is able to offer sufficient information.
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Image Layer-Symbology

Image Layer-Symbology

Layer  properties  of  image  layer  include  Source,  Spatial  Reference  and  Display  tabs.
But to DXF file in CAD system, it has one more tab of Symbology to set.  Symbology is
to assign whether the layer is  visible and the display  color.  Except  0 layer is  the layer
reserved by  CAD system, the other layers  are  designed  or  created  by  users  on  their
own.  refers to visible layer;   refers  to invisible.  And the color of the layer symbol
can be changed by tapping the left color square to choose new color.
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8 Toolbar Overview and Browser
8.1 Three-Tier Toolbar

Three-Tier Toolbar

The three-tier toolbar is  newly  developed in SuperPad  3.3,  which  can  be  described  in
three tiers.
Main Toolbar: the top tier is  the largest  class,  including six  main classes:  map/layer
toolbar, browser toolbar, edit toolbar, GPS toolbar, system settings toolbar and Internet
Application toolbar. 
Corresponding  Toolbar:  in  the  second  row  toolbar  on  the  map,  the  toolbar  is
corresponding to each main toolbar button.  
Tool  Menu:  the  tool  menu  appears  on  the  third  row  when  users  tap  the  downward
arrow of the tool on the toolbar group on the second row.

    

NOTE:  Some  of  the  toolbar  buttons  only  have  one  single  tool  without  the  dropdown
arrow. This kind of tools does not have tool menu. 
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To  help  users  understand  the  functions  of  the  tools,  we  will  briefly  introduce  the
functions of all tools below. 

Map/Layer main toolbar 

Icon Name Description

Map/Layer main
toolbar Open, save, add map/layer and layer manager.

Explorer main toolbar Manipulate map, browse, zoom in/out, pan,
identify, bookmark manager and hyperlink.

Edit main toolbar Select a point/line/polygon feature, edit feature/
vertex and add new features.

GPS main toolbar Turn on/off GPS, record tracklog and GPS
navigation settings.

System Settings main
toolbar Set up the various system parameters.

Map/Layer toolbar 

Icon Name Description

Open Map Open a map file.

Add Layers Add one or more layers.

Layer Manager Manage the layers.

Save Screen Save the screen.

About SuperPad The version and copyright of SuperPad.

Open Map tool menu

Icon Name Description

New Create a new map, quick project, feature layer,
photo layer and graphics layer.

Open Map Open a map from files.
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Save Map Save the map.

Save As Save map as a new file.

Import APM Import ArcPad APM file.

Print Setup (PC
version)

Set print settings. 

Print (PC version) Print.

Map Properties The name, description and spatial reference of the
map.

Recent Layers The layers that recently opened.

Recent Maps The maps that recently opened.

Exit Close SuperPad.

Add Layer tool menu

Icon Name Description

Add Layers Add one or several layers.

Layer Files Import or export the layer files (*.slr).

About SuperPad tool menu

Icon Name Description

About SuperPad Show SuperPad program version and copyright.

User Guide (PC
version)

Online manual in PDF.

Quick Reference (PC
version)

Quick reference of GPS tables and all tools.

Explorer toolbar 

Icon Name Description

Zoom In Zoom in the map.
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Identify Query the attribute data.

Zoom to Full Extent Go back to the previous map extent

Go Back to Previous
Extent

Zoom to cover full extent.

Find Search features by filtering condition.

Refresh Redraw the map.

Zoom In tool menu

Icon Name Description

Zoom In Zoom in the area.

Zoom Out Zoom out the area.

Pan pan the area.

Slide Zoom Slide upward and downward by touching the map to
zoom out and zoom in map.

Rotate Map Adjust the map rotation angle.

Clear Rotation Clear the degree of the rotation.

Identify tool menu

Icon Name Description

Identify Tap map to query attributes.

Hyperlink Tap features to open the linked webs or exterior
files. 

Zoom to Full Extent tool menu

Icon Name Description

Zoom to Full Extent Zoom map to cover all layers. 

Zoom to Layer Zoom map to the range of selected layer.

Go to Bookmark Move map extent to bookmark extent.
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Go Back to Previous Extent tool menu

Icon Name Description

Go Back to Previous
Extent

Open the previous map screen.

Go to Next Extent Open the next map screen.

Find tool menu

Icon Name Description

Find Search features by filtering conditions.

Create Bookmark Create new bookmark.

Bookmark Manager To edit or delete bookmarks.

Edit toolbar

Icon Name Description

Select Feature Select a feature to edit. 

Vertex Edit Edit the feature's vertices.

Point Create a point feature.

Capture Point Using
GPS Add a point feature at GPS position.

Add GPS Vertex Add a new vertex using GPS.

Add GPS Vertices
Continuously Add vertices continuously using GPS.

Feature Properties Edit attribute data.

Text Point Add a text point.

Select Feature tool menu

Icon Name Description
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Select Feature Select a feature to edit.

Select at GPS
Position

Select a feature at GPS position.

Clear Edit Selection Clear the edit selection.

Zoom to Selected
Feature

Zoom the selected feature to the map center.

Move to Selected
Feature

Move the selected feature to the map center.

Repeated Attribute Repeat the attributes of the last created feature.

Vertex Edit tool menu

Icon Name Description

Vertex Edit Edit the feature's vertices.

Move Vertex Move the vertex.

Insert Vertex Insert a new vertex into the feature.

Segment Polyline Continue to digital new vertices behind the last
vertex.

Point (add point/line/polygon feature) tool menu

Icon Name Description

Point Create a point feature (for point layer).

Line Create a line, a line feature (for line layer).

Polyline Create a polyline, a polyline feature (for line layer).

Freehand Line Create a freehand line, a line feature (for line layer).

Polygon Create a polygon, a polygon feature (for polygon
layer).

Rectangle Draw a rectangle to create a polygon feature (for
polygon layer).
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Circle Draw a circle to create a polygon feature (for
polygon layer).

Ellipse Draw an ellipse to create a polygon feature (for
polygon layer).

Freehand Polygon Draw a freehand polygon to create a polygon
feature (for polygon layer).

Edit Attribute tool menu

Icon Name Description

Feature Properties Edit or modify attribute data.

Move Feature Move the feature.

Rotate Feature Rotate the feature.

Offset Feature Offset the feature.

Scale Feature Scale feature with the feature center as the
standard.

Resize Feature Resize the width or height of feature.

Delete Feature Delete the feature.

Edit Text Point tool menu

Icon Name Description

Text Point Add a text point for a graphics layer.

Text Polyline Add a text polyline for a graphics layer.

Text Polygon Add a text polygon for a graphics layer.

Text Rectangle Add a text rectangle for a graphics layer.

Text Ellipse Add a text ellipse for a graphics layer.

GPS toolbar 
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Icon Name Description

Turn On/Off GPS Turn on or off GPS function.

Tracklog Record Record GPS tracklog.

GPS Status Current GPS status. 

GPS Position
Information

GPS navigation information.

GPS Debug GPS signal record.

GPS Options GPS settings.

Pan To GPS Pan the map to GPS position.

GPS Navigation Mode Activate the GPS navigation mode and head to
waypoint.

System Settings toolbar 

Icon Name Description

System Settings Set up the system parameters.

Quick Explorer Whether to display the quick explorer or not.

Add Waypoint Add a waypoint.

Polyline Measure Measure distance, area and coordinates.

Camera Take pictures with PDA through SuperPad.

Run Script Write script directly or load and run script files.

Serial Port Input or output messages from GPS receiver.

Status Bar tool menu 

Icon Name Description

Quick Explorer Whether to display the quick explorer or not.

Status Bar Whether to show status bar or not.
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Panning Frame Whether to show panning frame or not.

Compass Whether to show compass or not.

Scale Bar Whether to show scale or not.

Map Grid Whether to show the map grid or not.

Add Waypoint tool menu

Icon Name Description

Add Waypoint Create a waypoint.

Add Waypoint at
GPS Position Add a waypoint at GPS position.

Waypoint Manager Manage waypoints.

Photo Navigation Use photos that equipped with coordinates to
navigate. 

Export Waypoints Export all waypoints.

Import Waypoints Import waypoint file.

Polyline Measurement tool menu

Icon Name Description

Polyline
Measurement

Draw a polyline to measure distance, area and X, Y
coordinates. 

Freehand
Measurement

Draw a freehand line to measure distance, area
and X, Y coordinates.

Rectangle
Measurement

Draw a rectangle to measure distance, area and X,
Y coordinates.

Radial Measurement Draw a circle to measure distance, area and X, Y
coordinates.

Feature Measurement Tap on features to get the measurement result.
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8.2 Zoom In Tool Menu
Zoom In

Zoom In

1. Tap the  Explorer button on the main toolbar,  switch to Explorer toolbar,  tap  Zoom
In. 

   

2. When the button displays selected status, the function is activated. Then, draw a
rectangle to zoom in with stylus (or mouse).
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3. The drawn rectangle is zoomed in.
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The way to zoom in map by drawing a rectangle gets  involved  with  the  map's  ratio  of
width to height. It  is  of very  little chance to have the drawn rectangle's  ratio of width to
height identical to that of map. Therefore, the system firstly takes the drawn rectangle's
width or height  as  a standard and adjusts  the other's  ratio  to  meet  the  map's  ratio  of
width to height. After the rectangle's ratio of width to height  is  adjusted identical to that
of the map, the system will start to zoom in the adjusted new rectangle.

Please see the figures below. The square of  thicker  border  is  the  rectangle  drawn  by
user with stylus  to zoom in while the square  of  thinner  border  is  the  adjusted  square
given by system (which is invisible on the map) that has ratio of width to height identical
to the map.  The figure in the left  side,  the system takes the width of square of thicker
border as the standard and automatically  adjusts  the height  of square of thinner border
to make the ratio of width to height identical to that of map. Then, the system will  zoom
in the square of thinner border in proportion.  As a result,  the square you want  to zoom
in will be zoomed in properly without ratio difference.
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The function can be used repeatedly.  If you want  to stop Zoom In function,  please tap
again Zoom In button. When the selected status disappears, the function stops.

NOTE: you tap a button to select a function. For example, if the Zoom In function is  in
selected  status  (which  refers  to  functioned  status),  the  function  is  activated  for  use.
After  you  zoom  in,  the  button  is  still  available.  Therefore,  as  you  tap  the  map  with
stylus again, you still can zoom in the map. If you want to stop the function,  please tap
again the function button. While the button recovers to non-selected status, the function
stops.  Therefore,  do  remember  to  tap  the  function  button  again  to  stop  the  function
when you have finished the function,  preventing the modified map  from  being  adjusted
again.
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Zoom Out

Zoom Out

1. Tap  the  Explorer  button  on  the  main  toolbar,  switch  to  Explorer  toolbar,  tap  the
dropdown arrow of Zoom In > Zoom Out. 

   

2. When the button displays the selected status, the function is activated. Then draw a
rectangle on the map where you want to zoom out with stylus.
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3. The drawn rectangle is zoomed out.
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The way to zoom out  map by drawing a rectangle gets  involved with the map's  ratio of
width to height. It  is  of very  little chance to have the drawn rectangle's  ratio of width to
height  identical to that  of map.  Therefore,  the system first  takes the drawn rectangle's
width or height  as  a standard and adjusts  the other's  ratio  to  meet  the  map's  ratio  of
width to height. After the rectangle's ratio of width to height  is  adjusted identical to that
of the map, the system will start to zoom out the adjusted new rectangle.

Please see the figures below. The square of  thicker  border  is  the  rectangle  drawn  by
user with stylus  to zoom out  while the square of thinner border is  the adjusted square
given by system (which is invisible on the map) that has ratio of width to height identical
to  the  map.  The  figure  in  the  left,  the  system  takes  the  height  of  square  of  thicker
border as  the standard and automatically  adjusts  the width of square of thinner border
to make the ratio of width to height identical to that of map. Then, the system will  zoom
in the square of thinner border in proportion.  As a result,  the square you want  to zoom
in will be zoomed in properly without ratio difference.
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The function can be used repeatedly. If you want to stop Zoom Out function, please tap
again Zoom Out button. When the selected status disappears, the function stops.

© 2015 Supergeo Technologies Inc. All Rights Reserved.
Pan

Pan

1. Tap  the  Explorer  button  on  the  main  toolbar,  switch  to  Explorer  toolbar,  tap  the
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dropdown arrow of Zoom In > Pan. Then tap the stylus on the map and drag map to
where you want. 
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Slide Zoom

Slide Zoom

With  touch  control  mode  feature  in  PDA,  this  function  particularly  designed  in
SuperPad enables  you  to  rapidly  slide  zoom  in  or  slide  zoom  out  the  map  by  finger
touching screen or stylus touching screen at any time while you are moving. 

1. Tap  the  Explorer  button  on  the  main  toolbar,  switch  to  Explorer  toolbar,  tap  the
dropdown arrow of Zoom In > Slide Zoom button on the tool menu.
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2. To touch at  the position where  you  want  to  zoom  with  your  finger  or  stylus,  a  red
crossed frame appears right at the touch point. Push your finger or stylus  upward on
the PDA, the map slides zoom out with the red crossed frame as the center.  As the
stylus or finger leaves the screen, the map begins to redraw.

      

3. To push your finger or stylus  downward on the PDA, the map slides zoom out  with
the red crossed frame as the center.  As the finger or stylus  leaves  the  screen,  the
map begins to redraw. To stop the function, please tap Slide Zoom button again.
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For PC version, please hold the mouse left button at the position that  you want  to slide
zoom  out,  a  red  crossed  frame  appears  at  the  mouse's  position.  Then  mouse  drag
upward  to  slide  zoom  out  the  map  with  red  crossed  frame  as  the  center.  As  you
release  mouse  the  map  will  be  redrawn.  Or  hold  the  mouse  left  button  and  drag
downward  to  slide  zoom  in  the  map.  After  the  mouse  is  released,  the  system  will
redraw the map.

NOTE: Slide  Zoom  function  can  be  used  with  Panning  Frame  function  together  to
perform zooming and panning together,  making the map browsing more effectively  and
rapidly.  After selecting  Slide  Zoom  function,  please  activate  Panning  Frame.  As  a
result, panning frame shows up on the map. Consequently  you can perform slide zoom
and panning frame functions together. 
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Rotate Map

Rotate Map

As you are doing field survey with PDA at hand, you might need to use SuperPad while
walking; however the PDA's map takes its top as the north, which might  be not  the real
north. Then, you need to rotate the PDA to target the PDA map's north at  the real north
to  ensure  you  are  heading  in  correct  direction.  Consequently,  the  PDA  manipulation
becomes very  inconvenient.  To solve this  problem and avoid rotating  PDA  to  target  at
the real direction,  Rotate  map function is  especially  designed to help users  to  adjust
the map angle with stylus to target at real direction; thus, you do not  need to rotate the
PDA with confusion but can accomplish your work more quickly.

1. Tap  the  Explorer  button  on  the  main  toolbar,  switch  to  Explorer  toolbar,  tap  the
dropdown arrow of Zoom In > Rotate Map.
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2. Tap on the map with stylus  and rotate,  the screen  will  show as  figures  below.  The
pink hollow arrow always points  the north of the map,  while the yellow arrow can be
dragged to rotate direction degree to the desired position.  The number in the middle
of the yellow arrow shows the rotation degrees. As the stylus  leaves the screen,  you
will  see the north of the map turns  to the direction where the yellow arrow just  has
pointed at.
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If the compass is set  to show on the map,  you will  find the compass also changes its
north to the direction of the yellow arrow. And to stop Rotate  Map function,  please tap
again the Rotate Map button.
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Clear Rotation

Clear Rotation

After the map is rotated, and you want to recover to the default map direction, taking
PDA top as the north, you can tap this function to immediately reset the map rotation
degree to zero without rotating to zero by hand.
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1. Tap the Explorer button on the main toolbar, switch to Explorer toolbar, tap the
dropdown arrow of Zoom In > Clear Rotation.

   

2. And you will see the rotation degree be reset to zero, back to taking PDA top as the
north; if the compass is set to display on the map, the compass direction will also
be adjusted back to taking top as north.

   



SuperPad 3.3 Help

175

© 2015 Supergeo Technologies Inc. All Rights Reserved.

8.3 Identify Tool Menu
Identify

Identify

Identify  function  allows  you  to  query  the  feature's  attributes.  On  the  map,  draw  a
rectangle  with  your  stylus,  and  the  features  covered  by  this  rectangle  (including
features of different layers) will be shown on the result dialog box.  In the dialog box you
can find the result  features  and expand the attribute  data.  Even  more,  you  can  follow
the highlight in yellow flash to search the correct position of the feature.

1. Tap the Explorer button on the main toolbar, switch to Explorer toolbar, tap Identify. 

   

2. When the button reveals functioned status, drag a rectangle with stylus or mouse on
the map where you want to query attributes.
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3. The dialog box appears  and all  the covered features  will  be listed by  layer.  The  top
level is the layer name, and through the icon to the left  of layer name you can learn
the layer type is  point,  line or polygon.   refers  that  the layer can be expanded to
display  all  features  it  covers;   means  the  layer  has  completely  expanded  all  its
features. 

   

Besides, there are seven buttons in a row on the right side of the dialog box. A feature
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should be selected first, and then the seven buttons can be functioned.

   

: The selected feature is highlighted. After a feature is selected, tap this button and
the corresponding feature will be highlighted. Then, you will learn the correct position of
the feature.

   

: Move to feature. After a feature is selected, tap this button and the feature will be
zoomed out to the map center and highlighted so that you can learn the feature's
position.
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: Pan to Center. Select a feature and tap this button; the selected feature will be
panned to the map center and highlighted, so you can know the position of feature.

   

: Add waypoint. After a feature is selected, tap this button and “Waypoint” dialog box
appears. This feature can be set as waypoint and the XY coordinate values will be input
automatically in the dialog box or you can input manually.
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: Measure tool. After a feature is selected, tap this  button and the “Measure Result”
dialog  box  appears.  The  measure  result  is  the  same  as  the  result  of  using  Feature
Measurement tool, the info includes:
Starting coordinate: the start point's coordinate values of the feature.
End coordinate: the end point's coordinate values of the feature.
Perimeter: the total distance from the start to end point.
Area: measures the polygon's area.
(point,  line  and  polygon  have  different  measure  results,  please  refer  to  Feature
Measurement.)
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: Feature Properties. Attributes tab shows the properties of the feature. 
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The hyperlink picture is presented in Picture tab if the feature has one, and the picture

can be rotated by tapping . You can specify the hyperlink field and click  to
change the picture.
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Geography tab displays the coordinates.
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: edit attribute. Select one feature and tap . The “Edit Attribute” dialog box shows
up. Select an attribute and tap  to edit the contents.
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NOTE: the pop-up dialog box  in  SuperPad  can  be  zoomed  in  or  out  by  dragging  the
lower right corner with stylus. It is movable by dragging the top of the dialog box,  which
can avoid the map being  covered.  Besides,  at  the  upper  right  corner,  tapping  the  
can  minimize  the  dialog  box,  tapping   can  close  the  dialog  box,  tapping   can
maximize the dialog to full  screen,  tapping  in the full  screen dialog  box  can  zoom
out the dialog box, and tapping  in the minimized dialog box can zoom in the dialog
box. If there is a Name field or other fields like Name, for instance “EnglishName” in the
attribute table, the system will use the value of the field to be the name of the feature.  If
there is  no Name field or so,  the system will  use  the  value  of  the  first  field  to  be  the
name of the feature.
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Hyperlink

Hyperlink
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Hyperlink function enables  users  to  link  to  the  exterior  resources  or  webs,  such  as
files or website so that  users  can attain the additional information immediately  without
the need of searching on their own.  Also since the linked exterior information is  for the
current  map  position,  users  can  have  much  stronger  locale  concept  and  obtain
information more rapidly.  Besides,  the  way  to  open  pictures  in  picture  layers  applies
hyperlink function as well.  

1. Tap  the  Explorer  button  on  the  main  toolbar,  switch  to  Explorer  toolbar,  tap  the
dropdown arrow of Identify > Hyperlink. 

   

    

2. Tap the feature with hyperlink on the map with stylus (or mouse) and the exterior file
or web opens on the screen directly.
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NOTE: if you want to activate hyperlink to connect the exterior resources,  such as  files
or  web,  you  should  create  the  file  path  or  web  address  in  the  attribute  fields  when
creating a new layer.  Consequently  go to Layer Manager>Layer Properties>Hyperlink
to assign the field to hyperlink so that the system can guide to the file or web. 
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8.4 Zoom to Full Extent Tool Menu
Zoom to Full Extent

Zoom to Full Extent

1. Tap the Explorer button on the main toolbar, switch to Explorer toolbar,  tap Zoom to
Full Extent.

   

2. And you will see the map is zoomed to the extent covering all features of all layers.
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Zoom to Layer

Zoom to Layer

1. Tap  the  Explorer  button  on  the  main  toolbar,  switch  to  Explorer  toolbar,  tap  the
dropdown arrow of Zoom To Layer >  Zoom to Layer,  and the list  of all  layers  will
show up on the right side, tap the layer that you want to go and you will see the map
is zoomed to cover all extent of the selected layer.
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NOTE: if you have zoomed to the selected layer but cannot see the layer, please check
if  the  layer  is  set  invisible  in  Layer  Manager.  All  layers  will  be  listed  on  Zoom  to
Layer list. Therefore, even if the layer is set invisible, it is still listed; however, since the
layer  is  set  invisible,  it  is  invisible  on  the  map.  In  such  case,  please  go  to  Layer
Manager and set  the layer visible then select  Zoom  To  Layer  and  you  will  see  the
layer.
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Go to Bookmark

Go to Bookmark

The function is able to be used when the bookmarks are built  up already.  If there is  no
bookmark at all, the function presents unusable status. 

1. Tap  the  Explorer  button  on  the  main  toolbar,  switch  to  Explorer  toolbar,  tap  the
dropdown arrow of  Zoom  to  Full  Extent  >   Go  To  Bookmark,  and  the  list  of  all
bookmarks will  be  expanded  to  the  right  side.  Directly  tap  the  bookmark  that  you
want to go with stylus (or mouse). And the map will  move to the recorded bookmark
boundaries.
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NOTE: Bookmarks will  not  be  saved  in  the  system  after  you  exit,  you  need  to  reset
bookmark for each time using SuperPad.
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8.5 Go Back to Previous Extent
Go Back to Previous Extent

Go Back to Previous Extent

1. Tap the Explorer button on the main toolbar, switch to Explorer toolbar, tap Go Back
To Previous Extent and the map will go back to previous extent
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Go to Next Extent

Go to Next Extent 

After Go Back To Previous Extent is applied and you want to go back to the original
extent, Go To Next Extent can be used. 

1. Tap the Explorer button on the main toolbar, switch to Explorer toolbar, tap the
dropdown arrow of Go Back To Previous Extent > Go To Next Extent and the
map will go to the next extent.

   

NOTE: Go Back to Previous Extent and Go to Next Extent,  in fact,  do not  undo or
redo layer contents but simply  alter the map display.  On the one side,  this  tool allows
users  to easily  browse the  map  that  you  have  viewed  without  the  need  of  repeatedly
zooming  or  panning.  On  the  other  side,  the  tool  is  for  viewing  only  not  for  file
modification.  If you have modified the  file  by  using  Edit  toolbar  and  want  to  undo  the
editing,  please  use  the  undo  function  provided  by  Smart  Editing  Bar  instead.
Moreover, the Smart Editing Bar is only able to use when the map is in editing mode. 
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8.6 Find Tool Menu
Find

Find 

1. Tap the Explorer button on the main toolbar, switch to Explorer toolbar, and tap Find
.

   

2. “Find” dialog box shows up. Choose the layer to query in Layer. For the layers  which
are set  invisible can still  be queried.  Next,  select  the field and value to find  in  Field
and Value using SQL syntax. If you check “Find only features in current view extent”,
it only finds features on the current map window. After that, tap OK.
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You can also find features by setting the GPS coordinates in Location tab. You can find
the features by assigning coordinate system and XY coordinates. 
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3. There are seven buttons in the row on the right side of the result dialog box. A feature
should be selected first, and then the seven buttons can function.
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: The selected feature is  highlighted.  After a feature is  selected,  tap this  button and
the  feature  will  be  highlighted  on  the  map.  Thus,  you  will  learn  the  position  of  the
feature.

   

:  Move to feature.  After a feature is  selected,  tap this  button and the feature will  be
zoomed out  to the map center and highlighted.  Therefore,  you  can  learn  the  feature's
position.
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:  Pan  to  Center.  Select  a  feature  and  tap  this  button;  the  selected  feature  will  be
panned to the map center and highlighted, so you can know the position of feature.

   

:   Add waypoint.  After a feature  is  selected,  tap  this  button  and  “Waypoint”  dialog
box appears. This feature can be set  as  a waypoint,  the X,  Y coordinate values will  be
input in the dialog box automatically or you can input manually.
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:Measure tool.  After a feature is  selected,  tap this  button and the “Measure Result”
dialog  box  appears.  The  measure  result  is  the  same  as  the  result  of  using  Feature
Measurement tool, the info includes:
Starting coordinate: the start point's coordinate values of the feature.
End coordinate: the end point's coordinate values of the feature.
Perimeter: the total distance from the start to end point.
Area: measures the polygon's area.
(point,  line  and  polygon  have  different  measure  results,  please  refer  to  Feature
Measurement.)
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: Feature Properties. Feature properties are shown and you can select to edit. 
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The hyperlink picture is presented in Picture tab if the feature has one, and the picture

can be rotated by tapping . You can specify the hyperlink field and click  to
change the picture.
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Geography tab displays the coordinates.
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:  Edit  attribute.  Select  one feature and tap .  The Edit  Attribute dialog box shows
up. Select an attribute and tap  to edit the contents.
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NOTE: Find and Identify tools allow you to query  the feature's  attribute data.  You can
choose one of the two methods according to the information you already knew and the
need since there is some discrepancy between the two tools.  If you learn precisely  the
attribute data but don't know where the feature's located, Find is  suggested to be used
to search through setting the filtering condition.  However,  if you only  know the feature's
position on the map, you can use Identify to view its attribute data by  directly  dragging
a rectangle.
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Create Bookmark

Create Bookmark

1. Tap  the  Explorer  button  on  the  main  toolbar,  switch  to  Explorer  toolbar,tap  the
dropdown arrow of Find > Create Bookmark.  
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2. “Add/Edit  Bookmark” dialog box shows up.Give a  name  for  the  bookmark  in  Name
field,  and  you  will  see  in  the  dialog  box  the  left  and  top  and  right  and  bottom
boundary  values of the  map  are  input  automatically  by  the  system.  If  you  want  to
reset the boundary, please directly change the values.After the settings are finished,
tap OK to close the dialog box. In “Bookmark Manager” dialog box this bookmark will
be listed.
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Bookmark Manager

Bookmark Manager

1. Tap  the  Explorer  button  on  the  main  toolbar,  switch  to  Explorer  toolbar,tap  the
dropdown arrow of Find > Bookmark Manager.

   

2. The “Bookmark  Manager” dialog box shows up.  All  the  bookmarks  will  be  listed  in
the dialog box, and you can delete or edit the bookmarks.
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3. Select the bookmark that you want to adjust by tapping, and tap the Edit button,  the
“Add/Edit  Bookmark”  dialog  box  shows  up.  You  can  modify  boundary  values  or
change the name of the bookmark.  After the settings are finished,  tap OK and back
to the “Bookmark Manager” dialog box.
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4. If  you  want  to  delete  bookmarks,  please  select  the  bookmark  first  and  tap  the
Delete  button,  and  query  message  shows  up.  If  you  are  sure  to  delete  the
bookmark, tap Yes; if not, tap No.

   

NOTE: The bookmark is to record the map extent  only.  Next  time you start  SuperPad,
you should create new bookmark.
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8.7 Refresh

Refresh

Refresh can redraw the map; any changes on map or resetting of layer properties  can
trigger the map to redraw. Whenever SuperPad is drawing a map, tapping on any part of
the screen with stylus  (or mouse) will  stop the drawing,  which allows  you  to  do  other
behaviors and saves the drawing time. To continue to redraw the map, just tap Refresh.

Tap the Explorer button on the main toolbar, switch to Explorer toolbar,tap Refresh.
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9 Editing Features
9.1 Editing Tools Overview

Editing Tools Overview

Before  editing  features,  the  layer  you  want  to  edit  should  be  set  editable,  and  the
various editing tools can be used. Editing features can be divided into two parts:  editing
existing features and creating features.

Editing  Existing  Features:  the  feature  that  you  want  to  edit  should  be  selected  by
Select Feature  function first.  After the feature is  selected,  choose  a  needed  function
from the various editing tools, such as moving, offsetting or deleting feature or vertex.  
Creating  Features:  creating  features  function  adds  new  features  of  point,  line  and
polygon on the map. Moreover, the attributes and geography can be edited as well.

The editing is functioned by using the various tools to work the corresponding functions.
For example,  when a feature is  to be edited,  Selec  Feature  tool  should  be  selected
and used to do the selection. Consequently, editing tools  should be selected and used
to edit the feature or vertex (line or polygon layer).  As a result,  before you start  to edit,
select a tool first. Following, we are giving you an overview on editing tools.    

Select Feature tool menu: through this tool menu, the feature you want  to edit  can be
selected or you can cancel the selection; to PDA equipped with GPS function,  features
at  the  GPS  position  can  be  selected  or  the  map  can  be  zoomed  to  the  selected
feature's extent for better viewing.

Icon Name Description

Select Feature Select a feature to edit.

Select at GPS
Position

Select a feature at GPS position.

Clear Edit Selection Clear the edit selection.

Zoom to Selected
Feature

Zoom the selected feature to the map center.

Move to Selected Move the selected feature to the map center.
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Feature

Repeated Attribute Repeat the attributes of the last created feature.

Vertex Edit tool menu: through these editing tools, moving, inserting and deleting
vertex can be done. Besides, continuing to sketch vertices of a line can be done with
the tool menu.

Icon Name Description

Vertex Edit Edit the feature's vertices.

Move Vertex Move the vertex.

Insert Vertex Insert a new vertex into the feature.

Segment Polyline Continue to digital new vertices behind the last
vertex.

Point  tool  menu:  you  can  create  different  types  of  features,  such  as  point,  line  and
polygon.
(1) Point: Create a point feature.
(2) Line: Create line features by line, polyline and freehand line functions.
(3) Polygon: Create polygon features by rectangle, polygon,  ellipse,  circle and freehand
polygon functions.

Icon Name Description

Point Create a point feature (for point layer).

Line Create a line, a line feature (for line layer).

Polyline Create a polyline, a polyline feature (for line layer).

Freehand Line Create a freehand line, a line feature (for line layer).

Polygon Create a polygon, a polygon feature (for polygon
layer).

Rectangle Draw a rectangle to create a polygon feature (for
polygon layer).

Circle Draw a circle to create a polygon feature (for
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polygon layer).

Ellipse Draw an ellipse to create a polygon feature (for
polygon layer).

Freehand Polygon Draw a freehand polygon to create a polygon
feature (for polygon layer).

Feature Properties tool menu: You can edit feature properties and move, rotate,
offset, scale, resize and delete the features.

Icon Name Description

Feature Properties Edit or modify attribute data.

Move Feature Move the feature.

Rotate Feature Rotate the feature.

Offset Feature Offset the feature.

Scale Feature Scale feature with the feature center as the
standard.

Resize Feature Resize the width or height of feature.

Delete Feature Delete the feature.

Text Point tool menu: it provides the tools to edit the features for the graphics layer.

Icon Name Description

Text Point Add a text point for a graphics layer.

Text Polyline Add a text polyline for a graphics layer.

Text Polygon Add a text polygon for a graphics layer.

Text Rectangle Add a text rectangle for a graphics layer.

Text Ellipse Add a text ellipse for a graphics layer.
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Capture Point Using GPS tool menu: when GPS is activated, features can be created
at the GPS position.

Capture Point Using
GPS Add a point feature at GPS position.

Add GPS Vertex Add a new vertex using GPS.

Add GPS Vertices
Continuously Add vertices continuously using GPS.

NOTE: some tools  are usable only  under some  specific  conditions.  For  example,  the
GPS related tools can be usable only if GPS is activated.  A usable tool presents  in full
colors; on the contrary, an unusable tool presents in gray color.
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9.2 Editing Existing Features

Editing Existing Features

First we will introduce how to edit the existing features  on the map.  The features  might
be generated long time ago or with some mistakes, so they need to be modified.

In editing,  first  you should ensure the layer  you  want  to  edit  is  set  editable  in  Layer
Manager.  This  is  because Select Feature,   and Feature  Properties tools  can  only
be usable when target layer is  in editable status.  Moreover,  only  one layer of a type is
able to be set  editable,  which means if you have three point  layers  to edit,  you should
edit one layer one time.  However,  you can edit  one point  layer,  one line layer and one
polygon layer together.
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Select Feature Tool Menu

Select Feature

Select Feature

1. Tap the Edit button on the main toolbar, switch to Edit toolbar; tap Select Feature. 

   

2. After the function is activated, directly tap the feature that you want to edit on the
map with stylus (or mouse). Then, the selected feature will be marked in frame.
Then, you can select editing tools to edit the features.
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Setting layer visibility  helps  selecting the editing feature.  If a layer is  set  invisible,  the
features of the layer are not  to be displayed on the map.  That  means the minor layers
can  be  hidden  temporarily  and  you  can  select  and  edit  the  features  among  fewer
options to obtain a better result. 

NOTE: how do I know if any feature is  selected? There are two ways to check.  Firstly,
a  selected  feature  will  be  marked  in  frame.  Second,  if  the  feature  is  located  within
invisible extent,  please check the Vertex  Edit  button  on  the  toolbar  to  see  if  it  is  in
usable status.  If yes,  it  means a feature is  selected;  for  point  layer  (it  has  no  vertex)
Move Feature, Delete Feature and Offset Feature on the Vertex Edit tool menu will
be in usable status.
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Select at GPS Position

Select at GPS Position
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1. First connect GPS with your mobile device or ensure mobile device's GPS settings.
2. Tap the GPS button on the main toolbar,  switch  to  GPS  toolbar  and  tap  Turn  On

GPS. 
3. When you begin to select features to edit using GPS, please switch to Edit toolbar,

tap the dropdown arrow of Select Feature > Select at GPS Position. 

   

4. While you are tapping Select at GPS Position button, the feature at the current
GPS position will be selected. After the feature is selected successfully, the
selected feature will be marked.
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NOTE: Select at GPS Position function selects features according to the current GPS
position. Please make sure there is an editable layer on the map. If there is no editable
feature at the current position, no feature will be selected.
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Clear Edit Selection

Clear Edit Selection

If  you  want  to  clear  selection,  tap  Edit  button  on  the  main  toolbar,  switch  to  Edit
toolbar;  tap  the  dropdown  arrow  of  Select  Feature  >  Clear  Edit  Selection.  As  a
result, the selected mark disappears.
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© 2015 Supergeo Technologies Inc. All Rights Reserved.
Zoom to Selected Feature

Zoom to Selected Feature

1.  Tap Edit button on the main toolbar, switch to Edit toolbar; tap the dropdown arrow
of Select Feature > Zoom To Selected Feature. 
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2. The selected feature is zoomed to the map center.
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Move to Selected Feature

Move to Selected Feature

1.  Tap Edit button on the main toolbar, switch to Edit toolbar; tap the dropdown arrow
of Select Feature > Move To Selected Feature. 
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2. The selected feature is moved to the map center.
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Repeated Attribute

Repeated Attribute

As  one  feature  is  newly  created,  this  function  can  be  used  to  create  another  new
feature with the same attributes, sparing the attribute editing time. 

1. As a new feature is created and its  attribute is  also built  up,  tap OK and go back to
the map. Then tap the Repeated Attribute function.

   

2. After  that,  tap  the  position  where  you  want  to  add  a  new  feature,  and  a  confirm
message shows up. Tap Yes.

   

3. The edit  attribute dialog of the feature will  not  show up,  but  the  new feature  will  be
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directly added on the map with the same attributes as the previous created feature.

   

NOTE:  Repeated  Attribute  is  only  for  “repeat  the  attribute  of  previously  added  new
feature to the next  new feature  “;  that  is  to  say,  the  previous  feature  and  the  current
editing  feature  should  be  new features  on  the  map.  If  either  of  them  is  the  existing
feature on the map, you will find the function does not work.
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Feature Properties Tool Menu

Feature Properties

Feature Properties

1. Select the feature that you want to edit with the selection method mentioned above. 
2. Tap Edit tool on the main toolbar and switch to the Edit toolbar, tap Feature

Properties.
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3. “Feature Properties” dialog box shows up. There are three tabs: Attributes, Picture
and Geography. Select an attribute and edit it.

   

4. “Field Value” dialog box shows up and change the value.
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5. In the Picture tab,  if the feature has hyperlink  picture,  you can assign the hyperlink

field and tap  to specify the picture path. Tapping  can rotate the picture.

    

6. In Geography tab, select a vertex and you can edit the geography.
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© 2015 Supergeo Technologies Inc. All Rights Reserved.
Move Feature

Move Feature

1. Select the feature that you want to edit. 
2. Tap the dropdown arrow of Feature PropertiesFeature Properties > Move
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Feature. 

   

3. Then drag the selected feature to the desired new position with stylus, and you will
find that the feature is moved to new position.
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Rotate Feature

Rotate Feature

1. Select the feature that you want to edit. 
2. Tap the dropdown arrow of Feature Properties > Rotate Feature.

   

3. The selected feature comes in editing mode, then you can rotate the feature to the
desired position with stylus (or mouse) then release. The rotated feature will be
marked in black frame.
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4. Tap Write In  of the Smart Editing Bar to save the edit.
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Offset Feature

Offset Feature

1. Select the feature that you want to edit. 
2. Tap the dropdown arrow of Feature Properties > Offset Feature.
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3. An “Offset Feature” dialog box shows up, input the desired X and Y offset unit and
tap OK back to the map. The feature will be offset to the new position.

    

NOTE: “Units” refers to the same unit in Extent tab of Map Properties.
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Scale Feature

Scale Feature

The  function  can  scale  the  editing  feature  proportionally  with  feature  center  as  the
standard by dragging stylus or mouse. 

1. Select the feature you want to edit. 
2. Tap the dropdown arrow of the Feature Properties > Scale Feature.

   

3. Drag the rectangle that  surrounds the selected feature by  stylus  or mouse to zoom
in or zoom out  the  feature  with  the  original  feature's  center  as  the  standard.  If  the
rectangle is  dragged  closer  to  the  feature's  center,  the  feature  will  be  zoomed  out
more;  if the  rectangle  is  dragged  farther  to  the  feature's  center,  the  feature  will  be
zoomed in more. As the stylus or mouse is released, a new feature is  obtained.  See
the  figure  below,  the  original  feature  is  displayed  as  a  feature,  while  the  scaled
feature is displayed with the vertices.
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4. After the feature is scaled, tap Write In  of the Smart Editing
Bar to save the edit.

5. After the data is saved, the feature on the map is zoomed out proportionally.
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Resize Feature

Resize Feature

Resize Feature and Scale Feature are both to adjust the size of editing feature, while
the difference is that Resize Feature is to resize the width or height of feature as
user's need, which is more flexible than proportionally scaling of Scale Feature
function. 

1. Select the feature you want to edit.
2. Tap the dropdown arrow of Feature Properties > Resize Feature. 

   

3.  The selected feature will be displayed with eight small black squares and you can
drag any of the eight black squares to resize the feature.
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4. After the feature is resized, tap Write In  of the Smart Editing
Bar to save the edit. 

5. After the editing is saved, the feature is zoomed out on the map.
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Delete Feature

Delete Feature 

1. Select the feature that you want to edit. 
2. Tap the dropdown arrow of Feature Properties > Delete Feature. 
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3. Message box shows up. If you are sure to delete, tap Yes; if not, tap No. If you tap
Yes, the feature will be deleted.
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Vertex Edit Tool Menu

Vertex Edit

Vertex Edit

1. Select the feature that you want to edit. 
2. Tap Zoom To Selected Feature and the feature is zoomed to the map center. Tap
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Vertex Edit.
   

    

3. All vertices of the feature are presented in frames. When you tap any vertex, it will be
marked in red frame and a pop-up menu shows up for you to select Offset…, Move
to, Move To GPS or Delete.

   

4. Tap Offset and Offset Vertex dialog box shows up. Input the X and Y offset unit,
tap OK back to the map. The vertex is moved to new position.

       

5. If you tap Move to…, “Move Vertex” dialog box shows up, input the new position to
move.
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6. If you want to delete a vertex, tap Delete and the vertex will be deleted immediately.
7. Tap Write In  of the Smart Editing Bar to save the edit.
8. If you want to move the vertex to GPS, activate GPS, tap Move to GPS. 
9. Then the vertex will move to the current GPS position.
10.To confirm the edit, please tap  and the vertex moves to the GPS location.
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Move Vertex

Move Vertex

              
1. Select the feature that you want to edit. 
2. Tap the dropdown arrow of Vertex Edit > Move Vertex. 
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3. The selected feature comes in vertex editing status. Drag the vertex  that  you want  to
move to the new position with stylus  (or mouse).  When the stylus  leaves screen (or
release mouse), the vertex is moved to the new position and the shape of the feature
is changed as well.

   

4. Tap Write In  of the Smart Editing Bar to save the edit.
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Insert Vertex

Insert Vertex             

1. Select the feature that you want to edit. 
2. Tap the dropdown arrow of Vertex Edit > Insert Vertex.
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3. Tap at the position where you want to insert a vertex with stylus (or mouse), and a
vertex is inserted right at the position.

   

4. Tap Write In  of the Smart Editing Bar to save the edit.
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Segment Polyline (for line layer only)

Segment Polyline (for line layer only)

1. Select the feature that you want to edit. 
2. Tap the dropdown arrow of Vertex Edit > Segment Polyline.



Editing Features

238

   

3. The selected feature comes in editing mode. Tap at the position where you want to
add a vertex and a vertex will be sketched to link to the last vertex of the feature.
More vertices can be sketched continuously.
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4. Tap Write In  of the Smart Editing Bar to save the edit.

NOTE: you can implement several edits using Undo , Redo , Continuously Undo
 or Continuously Redo  on Smart Editing Bar to help you edits. At last, when

you are sure to write in the edits, tap  to redraw; if not, tap  to cancel.
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9.3 Creating Features on Layer
Point

Point

           
To create a point feature, you should ensure a point layer is editable. 
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1. Tap the Edit  button on the main toolbar,  switch to Edit  toolbar;  tap Point.  After the
Point button displays enabled, you can tap the position on the map where you want
to create a new feature.

    

2. Then message box shows up, if you are sure to add this feature,  tap Yes to create a
new feature; if not tap No.

   

   

3. “Edit Attribute” dialog box shows up. You can input the attribute data. Select the field
to edit and tap  to enter the “Field Value” and edit.
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4. After the  attribute  is  accomplished,  tap  OK.  And  the  newly  added  point  feature  is
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displayed on the  map.  After  the  point  feature  is  created,  you  can  continue  to  add
more point features. If you want to stop the function, tap again the Point button. 
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Line

Line

To create a line feature, you should ensure a line layer is editable. 

1. Tap  the  Edit  button  on  the  main  toolbar,  switch  to  Edit  toolbar;  tap  the  dropdown
arrow of Point > Line. 
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2. After the Line  button displays  selected status,  tap  the  start  and  end  points  of  the
line you want to create on the map. The first point  you tap on the screen is  the start
point,  and  the  second  point  is  the  end  point  of  the  line.  Later,  the  system  will
automatically link the two points to become one line.
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3. Message box shows up. If you are sure to add the feature, tap Yes; if not, tap No.

   

4. “Edit Attribute” dialog box shows up, in which you can create the attribute data.  Then
tap OK.
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5. Later, you will find the line is added to the map.
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6. You can continue to  create  more  lines;  if  you  want  to  stop  the  function,  tap  Line
button again and the function stops.
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Polyline

Polyline

    
To create a polyline feature, you should ensure a line layer is editable.

1. Tap  the  Edit  button  on  the  main  toolbar,  switch  to  Edit  toolbar;  tap  the  dropdown
arrow of Point > Polyline. 



SuperPad 3.3 Help

247

   

2. After  the  Polyline  button  displays  selected  status,  continuously  tap  on  the  map
where you want to place turn points  for the new polyline.  After the second turn point
is placed, a line appears to connect between the first and second point. After the last
point is done, tap Polyline button again to accomplish the creation of feature.
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3. Message box shows up. If you are sure to add this feature, tap Yes; if not, tap No.

   

4. “Edit Attribute” dialog box shows up, in which you can create the attribute data of the
features. Then tap OK.
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5. You will find the polyline is added to the map.
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6. After that,  you can continue to add more  polyline  features.  If  you  want  to  stop  the
function, tap again the Polyline button.
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Freehand Line

Freehand Line

         
1. Tap  the  Edit  button  on  the  main  toolbar,  switch  to  Edit  toolbar;  tap  the  dropdown

arrow of Point > Freehand Line.
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2. As Freehand Line  button displays  selected status,  directly  drag and draw the line
with  stylus  (or  mouse)  as  you  want.  As  the  stylus  leaves  screen  (or  mouse
releases), the drawing is finished.
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3. Message box shows up. If you are sure to add the feature, tap Yes; if not, tap No. 

       

4. “Edit  Attribute” dialog box shows up,  in which  the  attribute  data  of  the  new feature
can be edited. Then tap OK.

    

5. You will find the freehand line is already added to the map.
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6. Then you can continuously add more freehand lines. If you want  to stop the function,
tap the Freehand Line button and the function stops.

© 2015 Supergeo Technologies Inc. All Rights Reserved.
Polygon

Polygon 

        
To create a polygon feature, you should ensure a polygon layer is editable.

1. Tap  the  Edit  button  on  the  main  toolbar,  switch  to  Edit  toolbar;  tap  the  dropdown
arrow of Point  > Polygon. 
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2. After the Polygon button displays selected status, tap where you want  to place turn
points for the new polygon feature on the map with stylus,  which are the vertices  of
the polygon. It is unnecessary to link  the start  and end points  on your own because
SuperPad will automatically link the start and end points  to accomplish the polygon.
After the vertices  are  well  placed,  tap  Polygon  button  again  to  finish  the  drawing.
Then, SuperPad automatically  links  the start  and end points  to become a complete
polygon.
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3. Message box shows up. If you are sure to add the feature, tap Yes ;if not, tap No.

    

4. “Edit Attribute” dialog box shows up, in which you can create the attribute data.  After
the data is set up, tap OK.
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5. Back to the map, you will find the polygon is added to the map.
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6. The Polygon function also stops.  So,  if you want  to create more  polygon  features,
please tap Polygon button again.
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Rectangle

Rectangle

         
To create a rectangle feature, you should ensure a polygon layer is editable.

1. Tap  the  Edit  button  on  the  main  toolbar,  switch  to  Edit  toolbar;  tap  the  dropdown
arrow of Point > Rectangle. 
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2. After the Rectangle button displays selected status, drag a needed rectangle on the
map with stylus  (or mouse holds  left  button).  The start  point  is  the  point  where  the
stylus  touches the screen,  while the end point  is  the point  where  the  stylus  leaves
(or  mouse  releases).  After  the  stylus  leaves  the  screen  (or  mouse  releases  left
button), the drawing is finished.
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3. Message box shows up. If you are sure to add the feature, tap Yes; if not, tap No.

   

4. “Edit  Attribute” dialog box shows up,  in which,  you can create the attribute data  for
the new feature. After attribute data is accomplished, tap OK.
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5. You will  find the rectangle is  added to the map.  And you can continue to add more
rectangle features.
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Circle

Circle         

To create a circle on the map,  you should ensure a polygon layer is  editable,  and the
Circle  button presents  usable status  in full  colors.  With  Circle  tool,  you  can  draw a
circle feature as needed. 

1. Tap  the  Edit  button  on  the  main  toolbar,  switch  to  Edit  toolbar;  tap  the  dropdown
arrow of Point > Circle.
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2. After the Circle button displays selected status, drag a needed circle with stylus  (or
hold  mouse  left  button).  The  start  point  is  the  point  where  the  stylus  touches  the
screen and the end point is the point stylus leaves screen. The center of the circle is
right the start point.



SuperPad 3.3 Help

263

   

3. Message box shows up. If you are sure to add the feature, tap Yes; if not, tap No.

   

4. “Edit  Attribute” dialog box shows up,  in which you can  create  the  attribute  data  for
the new feature. After attribute data is accomplished, tap OK.
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5. You will find the circle is added to the map.
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6. Then you can continue to add more circle features.  If you want  to stop the function,
tap Circle button again and the function stops.
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Ellipse

Ellipse

        
To create an ellipse, you should ensure a polygon layer is editable.

1. Tap  the  Edit  button  on  the  main  toolbar,  switch  to  Edit  toolbar;  tap  the  dropdown
arrow of Point > Ellipse.
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2. After the Ellipse  button displays  selected status,  drag a needed ellipse with  stylus
(or hold mouse left button). The start  point  is  the point  where the stylus  touches the
screen and the  end  point  is  the  point  where  stylus  leaves  the  screen.  When  your
stylus  leaves (or mouse releases left  button),  the drawing is  finished.  The  center  of
the ellipse is right the start point.
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3. Message box shows up. If you are sure to add the feature, tap Yes; if not, tap No.

   

4. “Edit  Attribute” dialog box shows up,  in which you can  create  the  attribute  data  for
the new feature. After attribute data is accomplished, tap OK.
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5. You will find the ellipse is added to the map.
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6. After  that,  you  can  continue  to  add  more  ellipse  features.  If  you  want  to  stop  the
function, tap Ellipse button again and the function stops.
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Freehand Polygon

Freehand Polygon         

To create a freehand polygon, you should ensure a polygon layer is editable. 

1. Tap the Edit  button  on  the  main  toolbar,  switch  to  Edit  toolbar;  tap  the  downward
arrow of Point > Freehand Polygon. 
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2. After  the  Freehand  Polygon  button  displays  selected  status,  you  can  draw  a
needed  polygon  on  the  map  with  stylus  (or  mouse  left  button).  When  the  stylus
leaves the screen (or mouse releases),  the drawing is  finished.  It  is  unnecessary  to
link  the  start  and  end  points  on  your  own.  SuperPad  automatically  links  them
together to accomplish the drawing.
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3. Message box shows up. If you are sure to add the feature, tap Yes; if not, tap No.

   

4. “Edit  Attribute” dialog box shows up,  in which you can  create  the  attribute  data  for
the new feature. After attribute data is accomplished, tap OK.
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5. You will find the freehand polygon is added to the map.
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6. After that,  you can continue to add more freehand  polygon  features.  If  you  want  to
stop the function, tap the Freehand Polygon button again and the function stops.
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Graphics Layer

Graphics Layer

1. First,  create  a  new graphics  layer.  Tap  Map/Layer  toolbar,  tap  dropdown  arrow  of
Open Map > New > Graphics Layer.
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2. “Graphics  Layer”  dialog  box  opens.  Set  up  the  filename  and  path.  The  file  type  is
SPG. Then start to edit Graphics Layer.
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Text Point

Text Point

1. To add text point, firstly switch to the Edit toolbar and select Text Point.

   

2. Tap the location on the  map  where  you  want  to  add  the  text  point,  and  the  query
dialog box opens and tap Yes to add the text point.

   

3. As the “Feature Properties” dialog box  opens,  enter  the  text  to  show in  Text  field.
Check Text  Symbol and Feature Symbol to set  up the font  of text  and  the  style  of
the symbol. When the settings are finished, click OK.
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4. Go back to the map,  the text  point  is  added to the map.  You can add multiple text
points and set the points with different styles.
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Text Polyline

Text Polyline

1. To add text polyline, firstly switch to the Edit toolbar, tap the dropdown arrow of Text
Point > Text Polyline.
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2. Create the polyline by tapping with stylus (or mouse) on the map with several turning
points  which will  be the  vertices  of  the  polyline.  When  the  stylus  taps  the  second
turning point,  a segment  appears  to connect  the  first  point  and  the  second  turning
point,  and so forth.  At  last  when the end point  of the polyline is  tapped,  click  Text
Polyline again to finish the edit.

   

3. As the query dialog box appears, please click Yes to add the text polyline.
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4. As the “Feature Properties” dialog box  opens,  enter  the  text  to  show in  Text  field.
Check Text  Symbol and Feature Symbol to set  up the font  of text  and  the  style  of
the symbol. When the settings are finished, click OK.

   

5. Go back to the map, and the text polyline is added to the map.
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Text Polygon

Text Polygon

1. To add text polygon, firstly switch to the Edit toolbar, tap the dropdown arrow of Text
Point >  Text Polygon.
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2. On the map, tap the turning points  which will  be the vertices  of the polygon with the
stylus  (or  mouse  click).  You  do  not  have  to  precisely  connect  the  start  and  end
points manually but SuperPad will automatically connect them. After the vertices  are
selected,  click  Text  Polygon  again  to  finish  the  drawing  and  SuperPad  will
automatically connect the start and end points.

   

3. As the query dialog box shows up, please click Yes to add the text polygon.
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4. When the “Feature Properties” dialog box opens, enter the text  to show in Text  field.
Check Text  Symbol and Feature Symbol to set  up the font  of text  and  the  style  of
the symbol. When the settings are finished, click OK.

   

5. Go back to the map, the text polygon is added to the map.
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Text Rectangle

Text Rectangle

1. To add text  rectangle,  firstly  switch  to  the  Edit  toolbar,  tap  the  dropdown  arrow of
Text Point >  Text Rectangle.
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2. Drag and draw a rectangle on the map with stylus (or mouse click). The start  point  is
the point the stylus taps the screen (or where you first  click  and hold the mouse left
key) and the end point is the point where the stylus  leaves the screen (or where you
release mouse left  key).  The drawing is  finished when the stylus  leaves  the  screen
(or mouse left key is released).

   

3. As the query dialog box shows up and tap Yes to add the text rectangle.
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4. The  “Feature  Properties”  dialog  box  opens,  enter  the  text  to  show  in  Text  field.
Check Text  Symbol and Feature Symbol to set  up the font  of text  and  the  style  of
the symbol. When the settings are finished, click OK.

   

5. Go back to the map, the text rectangle is added to the map.
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Text Ellipse

Text Ellipse

1. To add the text  ellipse,  firstly  switch to the Edit  toolbar,  tap  the  dropdown  arrow of
Text Point >  Text Ellipse.
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2. Drag and draw an ellipse with stylus (or click and hold the mouse left  key).  The start
point  is  the point  where  the  stylus  taps  the  screen  and  the  end  point  is  the  point
where the stylus  leaves the screen.  When the stylus  leaves  the  screen  (or  release
mouse left key), the drawing is finished. The start point is the center of the circle.

   

3. As the query dialog box shows up, please click Yes to add the text ellipse.
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4. Enter the “Feature Properties” dialog box and enter the text  to show in Text.  Check
the Text  Symbol and Feature Symbol to set  up the font  of text  and the style of the
symbol. After the settings are finished, click OK.

   

5. Go back to the map, the text ellipse is added to the map.
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© 2015 Supergeo Technologies Inc. All Rights Reserved.

9.4 Editing with GPS Tools

Editing with GPS Tools

Editing  with  GPS  is  quite  similar  to  editing  with  stylus  or  mouse.  Firstly,  the  target
layer should be editable;  in the  next,  select  the  tool  buttons  designed  particularly  for
GPS. The greatest  difference between the two lies  that  SuperPad uses  GPS  received
position to replace the position you used to input  by  stylus  or  mouse.  Through  GPS,
point, line or polygon features can be created; or vertices can be inserted to the current
feature with the GPS current position.  

Capture Point Using GPS can be used under situations meeting the two conditions
below:

A point layer is set editable on the map.
GPS is activated.
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Add GPS Vertex and Add GPS Vertices Continuously can be used under situations
meeting the three conditions below:

A line or polygon layer is set editable on the map.
GPS is activated.
Segment Polyline button is in selected status.
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Capture Point Using GPS

Capture Point Using GPS

To capture point using GPS, you should ensure a point layer is editable, and the Point
button presents usable status in full colors. Capture Point Using GPS is to add a
point feature at the current GPS position. 

1. First  connect  GPS  with  your  mobile  device  or  ensure  the  GPS  settings  of  your
mobile device. 

2. After the positioning successes,  tap the GPS button on the main toolbar,  switch to
GPS toolbar; tap Turn On GPS  on the toolbar and you will  see the GPS cursor as

 shows, which represents the GPS position.  On toolbar,  Capture  Point Using
GPS displays usable status  now, tap the Capture  Point Using GPS  button on the
tool menu. 
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3. Message box shows up. If you are sure to add the feature, tap Yes; if not, tap No.

   

4. “Edit Attribute” dialog box shows up, in which you can create the attribute data for
the new feature. After attribute data is accomplished, tap OK. 
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5. And you will see the created point feature on the map.
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NOTE: when you want to run the GPS related functions, please turn on GPS first and
ensure positioning works well. Thus, the related functions can work.
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Add GPS Vertex

Add GPS Vertex 

                
Connect  GPS  with  your  mobile  device  or  ensure  the  GPS  settings  of  your  mobile
device.  After  the  positioning  successes,  tap  the  GPS  button  on  the  main  toolbar,
switch  to  GPS  toolbar;  tap  Turn  On  GPS.  Add  GPS  Vertex  function  should  work
together  with  creating  new  features.  That  is  to  say,  Polyline  or  Polygon  function
should be activated prior to activating Add GPS Vertex  function.  After the vertices  are
well placed, finally a new feature is generated.

1. After GPS is activated, tap the dropdown arrow of Point > Polyline. 
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2. Now Add GPS Vertex function is in usable status, when GPS moves to the position
you want to add a vertex, tap the Add GPS Vertex button.

        

3. A vertex is added by tapping the button one time. After all vertices are well placed,
you can tap again the Polyline button to finish the drawing.

4. Message box shows up. If you are sure to add the feature, tap Yes; if not, tap No.
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5. “Edit Attribute” dialog box shows up, in which you can create the attribute data for
the new feature. After the data is accomplished, tap OK.

   

6. You will find the polyline is added on the map.
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7. Polygons can be created in the same way, too. You need to tap the button again if
you would like to implement the function again.
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Add GPS Vertices Continuously

Add GPS Vertices Continuously

Firstly,  connect  GPS  with  your  mobile  device  or  ensure  the  GPS  settings  of  your
mobile  device.  After  the  positioning  successes,  tap  the  GPS  button  on  the  main
toolbar,  switch to GPS”toolbar;  tap Turn On GPS.  Same  as  Add  GPS  Vertex,  Add
GPS Vertices Continuously function should work  together with Polyline  or Polygon,
so  Polyline  or  Polygon  function  should  be  activated  prior  to  activating  Add  GPS
Vertices Continuously to start to edit.

1. After GPS is activated, tap the Edit button on the main toolbar, switch to Edit
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toolbar; tap the dropdown arrow of Point > Polyline.

   

2. When GPS moves to the position where you want to add vertices, tap the Add GPS
Vertices Continuously on the tool menu. SuperPad will add vertices continuously
according to the GPS positions.
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3. Tap Add GPS Vertices Continuously button again to finish adding vertices then tap
again the Polyline button to finish the editing. Message box shows up. If you are
sure to add the feature, tap Yes; if not, tap No.

   

4. “Edit Attribute” dialog box shows up, in which you can create attribute data. After the
data is accomplished, tap OK.
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5. You will find the polyline is added to the map. Polygon can be created in the same
way as well.
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NOTE: if the layer on which you are to create features  is  being  graded  (which  means
the  symbol  type  is  Graduated  Symbol  or  Unique  Symbol  in  layer  properties),
sometimes you might  find that  the created features  do not  appear on the map.  In  this
case, please go check the attribute data of the created features.  If the attribute values
are outside the grades,  the features  will  not  appear  on  the  map  but  are  added  to  the
layer indeed.  Please reconfirm whether the attribute values are set  correct  or  re-grade
the layer.  The created feature's  attribute value will  be  also  re-graded  and  displayed  in
the corresponding symbol.

© 2015 Supergeo Technologies Inc. All Rights Reserved.

9.5 Smart Editing Bar

Smart Editing Bar

Smart  Editing Bar is  located at  the  lower  left  corner  of  the  map,  and  it  appears  only
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when the layer is editable and usable in editing mode.  The functions it  provides include
undo,  redo,  write in,  clear editing  behaviors  or  screen  lock.  In  the  process  of  editing,
each editing behavior is  marked in black  frame, while the original feature is  marked  in
thinner dashed frame. So, you can know the difference between the two features.

   

Undo/Redo 
If you follow the steps to  start  to  edit  a  feature,  you  will  see  that  the  original  feature
remains at the position marked in thinner dashed frame. However,  the edited behaviors
will be marked in black frame. If you want to undo the edit, tap , the system will undo
to previous action.  If you want  to redo the edit,  tap  to reverse the  previous  undone
action.
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Continuously Undo/Redo         
In editing mode, if you want to undo several actions, tap . A list of actions shows up;
“Initial” is  the earliest  editing action and others  will  be  listed  by  order.  In  the  list,  you
can select the action you want to undo directly,  and the system will  undo the selected
action.
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If you want to redo editing actions continuously,  tap the  button and a list  of actions
shows up.  The item nearest  to the button is  the last  editing  action  and  others  will  be
listed by order. In the list,  you can directly  choose the action to redo,  and the system
will reverse the selected action.
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Write In         
In editing mode, tap  and the editing actions will be written in file and be displayed on
the map.

Clear Editing Behaviors        
In editing mode, tap  and all editing actions will be canceled, returning to before
editing status.

Screen Lock       
To prevent the map from being modified carelessly, Screen Lock function can be used
to lock  the map.  Tap ,  and the icon will  become locked status  .  Then,  all  of  the
tools on the map are unusable, and neither is the map.  Therefore,  the map is  unable to
be amended at all. To cancel Screen Lock, tap , and the icon will  become unlocked
status . The map is able to be manipulated.
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10
C h a p t e r
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10 GPS
10.1 Turn On/Off GPS

Turn On/Off GPS 

          
1. Tap the GPS button on the main toolbar,  switch to GPS toolbar,  tap Turn On GPS

 to connect  SuperPad and GPS receiver.  After  GPS  is  activated,  the  icon  turns

green .

   

2. After GPS positions successfully,  a GPS status  bar  appears  on  the  bottom  of  the
map, indicating the information of longitude,  latitude,  date,  time,  speed per hour and
altitude.  If  the  coordinate  information  is  displayed  in  degree  format,  it  can  be
switched  to  numeric  format  as  tapped  with  stylus  or  mouse  on  coordinate
information,  and if it  is  displayed in numeric  format,  you can tap it  to  switch  to  the
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degree format. If the unit of speed per hour is kilometer, it can be switched to mile as
tapped with stylus or mouse on speed information.

         

A yellow cursor inside a red hallow circle  represents  the GPS position.  And the

yellow cursor  is  pointing  the  heading  direction,  while  the  yellow trail  by  the
end of the yellow cursor is  GPS trail.  The lighter the trail  color is,  the more distant  the
current GPS position is. 

3. If you want  to turn off GPS, tap Turn Off GPS  and message box shows  up.  If  you
are sure to turn off, tap Yes; if not, tap No.
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10.2 Tracklog Record

Tracklog Record

GPS tracklog records your trail. When GPS is activated, turn on tracklog and
SuperPad will start recording GPS tracklog till you stop it.  

1. Tap the GPS button on the main toolbar and tap Tracklog Record  on the
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toolbar.

   

2. “GPS Tracklog” dialog box appears.  Tap  and  select  the  storage  path  in  Folder.
Date and time are automatically  input  in  File  Name  (0713-1458  means  July  13th  -
Fourteen fifty eight) or you can input  on your own.  Tap OK and SuperPad begins  to
record tracklog.
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3. When you want to stop recording tracklog, please tap Stop Record button on the
toolbar and message box shows up.

   

4. If you are sure to stop, tap Yes; if not, tap No. The tracklog file will be stored in the
assigned folder in KML (*.kml) file by default.

The format of tracklog can be set to save in KML (*.kml), SHP (*.shp) or GEO (*.geo) in
the  Tracklog  tab  of  GPS  Options;  even  you  can  assign  to  record  in  point,  line  or
polygon format.  As to tracklog settings,  please refer to Tracklog tab of GPS Options
in this  chapter.  If the  tracklog  is  recorded  as  a  layer,  it  can  be  added  and  viewed  in
SuperPad. See the figure below, it is a tracklog geo file in point  format  being displayed
in SuperPad.
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NOTE: the tracklog can be  stored  in  KML  format,  Keyhole  Markup  Language.  It  is  a
language  adopting  XML  syntax  and  format,  used  to  describe  and  store  geographic
messages  (such  as  point.  line,  polygon  and  model),  and  can  be  identified  and
displayed by various GIS software, like Google Earth. 
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10.3 GPS Status

GPS Status

Connect SuperPad and GPS according to the method mentioned above. Tap the GPS
button on main toolbar, switch to GPS toolbar and tap the GPS Status. Then the
satellite information will be displayed on GPS Status window.
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In the part of GPS status, the number of effective received satellites and the signal
intensity can be viewed. Now we are to explain each tab respectively: 

Standard

Name Description

Sky Illustration
The  little  green  circle  represents  the  satellite  has
sufficient signal for GPS to receive,  and the number
inside means the satellite's  No.  that  GPS  will  take
to calculate current  coordinates.  The little red circle
represents  the  satellite  has  insufficient  signal  for
GPS to receive. GPS will not take it.

Signal Chart The  blue  bar  represents  the  satellite  has  sufficient
signal  and  GPS  will  calculate  current  coordinates
with  it.  The  red  bar  represents  the  satellite  has
insufficient  signal  and  GPS  will  not  take  it  to
calculate.
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GPS Information

Here are the current GPS information:
1. Longitude: the longitude of your current position.
2. Latitude: the latitude of your current position.
3.  Altitude:  the  height  of  your  current  position,
calculated from the sea level.
4. Speed: your current heading speed per hour.

Detail

   

Name Description

Date Date and time.

UTC Coordinated Universal Time.
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Longitud
e

The longitude of your current position.

Latitude The latitude of your current position.

Altitude The height of your current position, calculated from the sea level.

Speed Your current heading speed per hour.

Track The azimuth of heading direction.

Mode Display mode.

PDOP The position dilution of precision.

HDOP The horizontal dilution of precision.

VDOP The vertical dilution of precision.

Satellites
Display the information of each satellite. The satellites of insufficient intensity are
highlighted in pink color.
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Name Description

ID Number of satellite

Elevation Elevation.

Azimuth Azimuth.

SNR Signal to noise ratio
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10.4 GPS Position Information

GPS Position Information

Tap the GPS button on the main toolbar, switch to GPS toolbar and tap the GPS
Position Information button. The GPS Navigation window shows up. 
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Name Description

Total
time

The total time since orientation starts till now.

Target The place where user wants to go.

Distance The straight line distance from current position to target.

Trip The heading distance.

Speed The speed rate of user to the waypoint.

  

The little triangle outside the circle means the waypoint, the destination. The indicator
points at the GPS heading direction; the visible N refers to the north.

On GPS Navigation window, the messages about waypoint can be viewed, also the
settings can be changed by tapping the icons on the top of the window. The following
are the descriptions for these icons:
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Name Description

North Lock 

Locked ,  north is  locked at  the upward  side  of  the  compass;
unlocked , the heading aspect  is  always at  the upward side of
the compass. As you tap the North Lock, the locked icon turns to
be unlocked icon,  and the north aspect  will  no longer be fixed at
the upward side of the compass, but the heading aspect will. That
is  to say,  the heading aspect  will  be fixed to the  upward  side  of
the compass.

Waypoint
manager 

Tap  Waypoint  and  a  pop-up  menu  shows  up.  You  could  select
the waypoint  from  the  menu  by  checking  it.  Or  you  could  click
More  to  reveal  “Waypoint  Manager”  dialog  box.  Here  you  could
edit or delete waypoint or set up your target. 

Time  Reset total time.

Trip distance  Reset total trip distance.

Close Close navigation window.

Waypoint Manager          
All waypoints are listed here;  select one to set as current destination to go. 

   

Tap “More…” and “Waypoint Manager” dialog box shows up. Select a waypoint and
choose the function in the right side to manage the waypoint. The red waypoint is the
current target to go.�
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Tap “Edit” and Waypoint dialog box shows up. You can edit the name XYZ of the
selected waypoint.
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Tap the “Delete” button, and message box shows up. Tap “Yes.”

    

Press  “Delete  All”  button  shows  the  message  box.  If  you  are  sure  to  delete  all
waypoints, tap “Yes.”
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Tap the “Goto” button and the map  will  zoom  to  the  specified  waypoint.  Tap  the  “Set
Target”  button  and  the  selected  waypoint  will  set  as  the  destination  and  it  will  be
marked in red.
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If you check “Visible”, the waypoint icon will be displayed on the map. If not, it will be
invisible.
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10.5 GPS Debug

GPS Debug

          
Tap the GPS button on the main toolbar, switch to GPS toolbar and tap the GPS
Debug button. The GPS signals are shown on the window.
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10.6 GPS Options

GPS Options…    

               
Before GPS is activated, please set up the GPS settings to successfully connect GPS
and SuperPad. 

Tap the GPS button on the main toolbar, switch to GPS toolbar > GPS Options. “GPS
Options” dialog box shows up. It contains ten tabs: GPS, Tracklog, GPS Display,
GPS Height, Spatial Reference, Location, Log, Misc, Altert and Editing.
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GPS

GPS

Follow the GPS settings to adjust the items. 
Protocol: select the suitable protocol and the default is NMEA0183. 
Port: select the correct port and the default is COM8. 
Baud: select a suitable item, the default is 4800. 
Data Bits: the default is 8.
Parity: the default is None.
Stop Bits: the default is One.
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If you are not sure the correct port, make sure GPS connection and power are ready.
Then, tap  next to Port, so the system will automatically detect the usable port.
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After the data is finished, tap OK.

If you do not understand the contents of GPS items, please see the description below:

Name Description

Protocol Select the GPS protocol. 

Port Select the port to connect GPS with mobile device. 

Baud
Select the Baud rate of GPS receiver, nine options available
including 1200, 2400, 4800, 9600, 19200, 28800, 38400,
57600,115200.

Data Bit The Bit count that GPS can deliver. 

Parity The parity count that GPS delivered, including four options of None,
Even, Odd and Mark Space.

Stop Bit The last bit value that GPS delivers.

NOTE:  NMEA0183  is  the  specification  defined  by  National  Marine  Electronics
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Association  (NMEA).  When  the  positioning  information  such  as  longitude,  latitude,
successfully  positioning  code,  adopted  satellite  count,  signal  intensity,  satellite
azimuth, elevation, date, UTC time, DOP and so on from satellite are received by  GPS
receiver, they will be transferred to GPS position of latitude and longitude in NMEA0183
format and displayed on the window.
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Tracklog

Tracklog

In this tab the tracklog contents can be set up according to your request. 

   

The contents include:
File Type: the tracklog can be saved in KML, SHP or GEO file. To KML, it can be read
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and displayed by various GIS software. Or to SHP and GEO layer,  they can be used in
Supergeo series products. 
Format: Tracklog can be recorded in point,  line or polygon.  The  point  format  tracklog
displays in point. The line format  tracklog displays  in line.  The polygon format  tracklog
displays in polygon. In other words, if the tracklog is saved to layer (*.geo or *.shp),  the
layer type will be identical to the recording format. As a result,  point  format  transfers  to
point  layer,  line format  transfers  to line layer,  and polygon format  transfers  to  polygon
layer.

See the figure below. It is the tracklog saved in GEO layers in point format then being
added to SuperPad.

   

Min Distance between Points: set the distance between the previous and next points
when sampling. Unit is degree.
Sampling Rate: the sampling rate, the unit is second. It indicates how many seconds
a sample will be taken. 
Play Interval: set the unit is second. That is how many seconds a tracklog will be
played.
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GPS Display

GPS Display

After GPS is activated, GPS cursor and the trail will show up on the map. In this tab,
you can set whether to show GPS cursor, trail and GPS status bar. 

   

GPS cursor: you can set whether to show GPS cursor and its  size.  The cursor will  be

a  yellow cursor  surrounded  by  a  red  hallow  circle  .  Check  this  item  and  GPS
cursor shows; if not, it disappears. 

GPS trail: you can set  the color,  length and width of trail  .  The color  can  be
selected by tapping the color block in basic or advanced tab. The default  is  yellow.  And
the lighter the trail's  color is,  the  farther  the  distance  to  GPS  position  is.  Check  this
item and GPS trail shows; if not, it disappears.
GPS status bar: GPS status  bar shows on the bottom of the map.  The  status  bar  is
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translucent  yellow,  and  text  is  red  .  To
change the font  and color of the text,  please tap  Text  Symbol  to  change.  Check  this
item and the GPS status bar will show on the bottom; if not, it disappears.

© 2015 Supergeo Technologies Inc. All Rights Reserved.
GPS Height

GPS Height

Set  up  the  GPS  antenna  height  and  geoid  separation.  If  the  GPS  receiver  is  placed
several meters above the ground, you can enter the antenna height. Then, when GPS is
calculating  position,  the  distance  will  be  deducted  and  more  precise  position
information could be obtained. For the same reason, you can enter the geoid separation
to deduct the discrepancy. Please enter according to your preciseness request,  or you
can maintain the default. The default is 0 meter.

   



GPS

330

© 2015 Supergeo Technologies Inc. All Rights Reserved.
Spatial Reference

Spatial Reference

Tap the earth icon  at the bottom right corner and set the spatial reference. As to the
details of setting the spatial reference, please refer to Map Properties.
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Location

Location

When the coordinates of current position are not  obtained by  GPS yet,  the system will
automatically read the longitude, latitude and altitude of the last known GPS position till
the current position is obtained.

If “Restore Location” is  selected,  the position that  is  located  in  the  longitude,  latitude
and  altitude  fields  will  be  used  to  be  the  initial  GPS  position  to  search  the  current
position.  This  position offers  GPS receiver with an initial position  to  track  the  satellite
and obtain current position more quickly.
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Log

Log

If Logged File is checked, the data that GPS receiver outputs will be logged in .TXT file.
Tap  to select the storage path.  To activate log,  the Logged File should be checked
before GPS is activated so that it could start recording. GPS log could be used to solve
GPS problems,  since all  the information that  SuperPad receives from GPS  receiver  is
well recorded in it.

   

Enter  message  in  GPS  Initialization  String,  and  the  message  will  be  sent  to  GPS
receiver when GPS is  activated.  The function of GPS Initialization String  is  commonly
used  to  send  command  to  GPS  receiver  and  specify  the  output  options  of  GPS
receiver.  For  instance,  you  can  use  GPS  Initialization  String  to  specify  the  GPS
receiver to output data as Pedestrian mode or Vehicle mode.
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Misc

Misc

Automatically  Activate:  when  a  SuperPad  map  file  defined  with  coordinates  is
opened, GPS will be activated automatically.  
Automatically Pan View:  SuperPad  will  automatically  pan  map  and  keep  the  GPS
position center of the map. 
Automatically Rotate Map: map is rotated according to the GPS heading direction.    

You can activate the three options mentioned above by checking the items.
  
DST Distance: when the  distance  from  GPS  position  to  the  destination  is  less  than
distance you set in this  box and also in Alert  tab,  Approaching destination is  checked
for alert, the alert will be activated by the system.
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Alert

Alert

You can decide whether to show alert message by checking when GPS data are under
the situations as below:

   

1. No GPS data being received:  when GPS is  activated but  no message is  received
from GPS receiver in SuperPad, the system will send alert automatically.

2. No current position fix:  when GPS receiver  can  not  position,  and  no  coordinates
can be received from GPS receiver in SuperPad, the system will send alert. It usually
occurs when less than three effective satellites are received by  GPS receiver so that
GPS can not position successfully.  
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3. Not a 3D fix: if the received GPS coordinates include X, Y coordinates  only  but  no Z
coordinate, the system will send alert as this option is checked.

4. Maximum PDOP exceeded: tap the  and enter the “Gps Quality” dialog box to
set  up the option PDOP/HDOP/VDOP…  .  As  the  received  value  exceeds,  the
system will send the alert.

5. Approaching Destination: if the distance of current GPS position to the destination
is  less  than  the  set  distance  in  DST  Distance  in  Misc  tab,  the  system  will
automatically send the alert.

The advanced settings,  you can decide whether to use the items below by  tapping  or
clicking the icon:
A.  Text alert.
B.  Voice alert.
C.  Tap  to play the voice effect.

If  the  tapped  icon  appears  with  “x”,  it  means  this  function  stops.  Besides,  you  can
change the voice file by tapping .
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Editing

Editing

Number of positions to averages: when editing using GPS, the system will  use the
average of GPS positions to be the position.  In this  way,  the system can acquire more
precise  result  than  capture  of  one  single  GPS  position,  and  the  inaccuracy  can  be
reduced as well. Number of positions to averages means to get an average value from a
specific quantity  of GPS positions.  It  is  suitable for “Capture  Point Using GPS”  and
“Add GPS Vertex”. For instance,  set  10,  it  means that  to get  the average value from
10 GPS positions. At last, a vertex at the position of the average value is  added.  “Add
GPS Vertices Continuously”  sampling  rate,  the  unit  is  second,  it  means  a  sample
will be get in the second you set, and a vertex will be added.
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10.7 Pan to GPS

Pan to GPS

The function can pan the map to the current GPS position once. If GPS position is not
within the map window, tap the Pan to GPS button and the map will be immediately
panned to the current GPS position.
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10.8 GPS Navigation Mode

GPS Navigation Mode

Before  using  GPS  Navigation  Mode,  waypoint  should  be  set  up  first  so  that  the
function can be activated by specifying waypoint. As to the settings of waypoint,  please
refer to Add Waypoint. As the waypoint is set up, switch to GPS toolbar and tap GPS
Navigation Mode. GPS will guide you to the waypoint.
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GPS Navigation Mode and Automatically Rotate Map functions are both relevant  to
GPS;  however,  the  ways  to  move  are  different.  GPS  Navigation  Mode  will  pan  the
map along GPS position. The map will be panned only when the GPS position is  nearly
out of the map window, so GPS position can be kept within the map window. Since the
map orientation is always fixed, the GPS heading direction on PDA might head upward,
downward,  leftward,  rightward or any  direction  according  to  GPS.  On  the  other  hand,
the Automatically Rotate  Map  in  Misc  tab  of  GPS  Options works  in  another  way.
The map orientation always changes according to the GPS heading direction,  which is
always fixed at  the top of the screen.  Therefore,  if GPS heads  to  the  east,  SuperPad
will  rotate the map and display  the east  at  the top of screen.  For the reason,  you  will
find the map window rotates  according to the GPS direction continuously,  and  that  is
why  it  is  named  Automatically  Rotate  Map.  About  the  settings  and  description  of
Automatically Rotate Map please refer to the Misc tab of GPS Options.
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11 System Settings and Others
11.1 System Settings

System Settings

Many parameters need to be set in System Settings in SuperPad. Please set up
based on your requirements. Or use SuperPad by default first. Later, when you need to
adjust, please go to System Settings to change 

1. Tap the System Settings button on the main toolbar, switch to System Settings
toolbar and tap the System Settings button. 

   

2. In the dialog box, there are thirteen tabs, and you can switch the tabs by tapping the
leftward of rightward arrow on the right side.
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Display

Display

Set up the display related settings, including Background, Selection and Coordinate
Format.
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Background
The map's background color. Tap the color block to select the background color, and
the default is white. Tap the color block on the right side entering “Color Picker” dialog
box and select a color from basic or advanced color.
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Selection
Tap the color block  of Color to decide the  selection  color;  the  default  color  is  yellow.
Tap the block on the right side,  entering “Color Picker” dialog box and you can choose
to  select  a  basic  color  or  advanced  color.  For  instance,  in  querying  feature,  the
selected feature will be highlighted in yellow flash.
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Width is to set up the width of color. The wider the color you set, the more exaggerated
the selected feature can be displayed.

Status Bar Coordinate Format 
How the coordinate format shown on the status bar when stylus (or mouse) is being
moved on the map can be changed. Three options are available and the default is
Degree.

Degree: 

Degree Minute:

Degree Minute Second: 

After the settings are finished, tap OK.
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Camera

Camera

In field survey,  the surveyors  usually  take pictures  of the real scenery  with camera  for
recording  and  observation.  SuperPad  also  supports  to  take  pictures  using  PDA
equipped  with  camera  function.  The  picture  format  is  JPG  (*.jpg).  Moreover,  PDA
equipped with GPS function can record the coordinates of the place where you take the
picture in SuperPad.  Therefore,  the picture can record image,  coordinates  and time for
easier arrangement and even can be used to produce photo layers.



SuperPad 3.3 Help

345

              

Camera Tab
Default Picture Folder: when the picture is taken, it is stored in this  folder.  Tap  to
select the storage folder.
Prefix: every file you save will be given a name according to this prefix.
Quality: the quality of picture, four options including default, low, normal and high.
Date  and Time  in Filename: if the item is  checked,  when pictures  are  stored,  date
and  time  will  be  appended  to  prefix  directly.  Please  see  the  part  of  file  name  of  the
figure on the upper right side.
Save X, Y Coordinate: if you take pictures with PDA equipped with GPS function,  the
coordinates of the place you take pictures will be saved. So, in the future, when you are
arranging these pictures,  they can be positioned directly  on the map according  to  the
coordinate values (the coordinate values are saved in EXIF Marker of JPG file).

NOTE: if PDA does not  equip with camera function,  the camera  function  in  SuperPad
can not be used.  And it  is  only  usable in smart  device equipped with camera function,
not  for the  PC.  The  obtained  coordinate  values  will  be  stored  in  EXIF  (Exchangeable
Image File Format) of JPG file.  EXIF refers  to exchangeable image file format,  which is
used  to  set  up  the  digital  picture's  information.  It  is  a  standard  format  to  record  the
properties  messages  and  data  of  the  digital  pictures.  And  the  coordinate  values  are
recorded in it.
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Path

Path

Default Maps and Data  Path: Set  up the path to access map or data file.  Moreover,
as SuperPad starts, the map files listed in the “Open Map” dialog box are exactly  what
are stored in this path.
Extensions Path: Set  up  the  path  for  SuperPad  to  read  the  custom  extensions.  As
long as the custom extension files are placed to this path, SuperPad will read it.
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Locale

Locale

The system provides Fourteen kinds of user interfaces in Traditional Chinese, Simplified
Chinese, English, Japanese, Spanish, German, French, Arabic, Turkish, Russian,
Italian, Korean, Polish and Portuguese. After the language is selected, tap OK and the
user interface is changed to the selected language.
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Map Grid
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Map Grid

In the map grid tab, you can decide the Line and Text. Map grid will show the longitude
and latitude lines on the map and indicate the value on the map.

   

Tap Line to enter “Line Symbol” dialog, please set up for each item, including Style,
Width and Color.
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After the settings are done, continue to set up the text. Please set up according to your
preference.
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If you choose to show the map grid on the map, the map grid will be displayed on the
map based on the settings.
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If the Spatial reference of the map is Geographic Coordinate System, and the map grid
label will be presented in latitude and longitude format.
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ToolBar

ToolBar

ToolBar tab allows you to choose the color of toolbar.
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Function Key

Function Key

This function is for PDA only. In general, PDA device has up,  down,  right,  and left  keys
below the screen, and this function is to set up the express functions for the four keys.
Tap the dropdown arrow of each item, a function menu for selection shows up and you
can choose the function to give the key. After the settings are finished, once any one of
the keys is pressed, the given function will perform.
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Editing

Editing

In Editing tab users  can set  up  whether  to  particularly  mark  the  snapping  position  in
specified color when snapping features. For example, if we set up to mark  the snapping
position in red, see the figure below.

   

When snapping features, the snapping position will be displayed as the color defined.
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To check “show measurements after adding new features” will display the Feature
Measurement dialog box right after a feature is added up. The measurement result is
exactly the same as what is obtained by using Feature Measurement tool. Please refer
to Feature Measurement for measurement result details.
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Customize

Customize     

In general manipulating SuperPad is  easy  and  flexible.  Moreover,  the  plug-in  add-ons
can be added to the program to improve the working efficiency.  SuperPad plug-in add-
ons  are  able  to  be  generated  by  SuperGIS  Mobile  Engine  in  *.dll  file.  SuperPad  will
need to be restarted to activate the extension's  functions after the extension items are
ticked to make the functions take effect.
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Please check the add-on you want  to use and tap OK and a message box shows up.
Please close and restart SuperPad to activate the selected add-on's  functions.  In other
words, as SuperPad restarts, the selected extension or project  file will  be added to the
toolbar.
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AccuracyDisplayPanel
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AccuracyDisplayPanel 

This add-on takes to work together with GPS, which presents the accuracy of GPS
display. As GPS turns on in SuperPad, the GPS accuracy info will present at the upper
right corner on screen. Take the figure below as an example, 4.6 means the accuracy,
the less value has the higher accuracy; 4 means the number of satellites that
SuperPad collects. The green signal means 3D orientation, which has better precision;
the red signal means 2D orientation or below or insufficient info, which is less precise. 
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AdvancedEditAttribute

AdvancedAttributeEditing
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This add-on allows users to create custom forms to enter attribute values and to modify
attribute values.  A custom form used to enter attribute values is  a quick  menu  that  is
particularly  designed  according  to  the  features  of  the  attribute  to  enable  users  to
quickly enter attribute values. For instance, there is  a layer whose contents  of attribute
table should be input  in date format,  in that  case the field format  can be set  as  yyyy/
MM/dd with custom form. While users  are editing the field,  they can select  a  date  by
clicking instead of typing each word. Another example, users should enter file path in a
File field, if it has no custom form, users will  have to enter the complete file path ex:/
sdcard/SuperPad/Photo/butterfly1.jpg/  on their own. But with the custom form, users
can set the custom form in File Name type and system will enable users to browse and
select the file path to directly input the field when editing,  which saves lots  of time.  The
custom form offers  a quick  menu to enter the attribute values so that  users  can  enter
the data in a simplest and quickest way when doing the field survey.

    

© 2015 Supergeo Technologies Inc. All Rights Reserved.
 Creating a custom form
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Creating a custom form

1. Attribute Setting function enables users to create the custom forms which are used
to enter  attribute  values.  Firstly,  tap  Attribute  Setting  and  select  the  layer  which
you want to create the custom form for.

    

2. The “Attribute Setting” dialog box shows up, and all the attributes are listed in it.  You
may tap  to expand the format of the attribute or tap  to hide.  After an attribute is
selected,  you can change the type of the attribute by  tapping .  You can  set  the
contents of attributes by tapping . 
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3. Tap  and  “Select  Attribute  Type”  dialog  box  shows  up.  This  extension  provides
nine types of attribute and each type has different  format.  Now we will  describe  the
function and settings of each type.
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 Menu 
Function
When  editing  attribute  using  Advanced  Edit  Attribute  tool,  users  can  select  the
suitable item to be attribute value from the drop-down menu directly.
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Settings
In the “Menu Attribute” dialog box, users can add Values (items of the drop-down menu)

by  tapping  .  The  “Menu  Attribute  Item”  dialog  box  shows  up,  please  enter  the
content of the item and if you want to set as the default settings, check “Default.” When
the setting is  finished,  please  tap  OK.  Follow the  method  and  create  all  Values.  If  a

Value is selected, users can adjust the order by tapping ,  delete one single Value

by tapping  or remove all  Values by  tapping .  And the contents  of Value can be
modified by tapping .
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 Numeric  
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Function
When editing  attribute  using  Advanced  Edit  Attribute  tool,  users  can  directly  enter
the value. 

    

Settings
Users  can  set  the  attribute  name,  comment,  decimal  place,  default  value,  maximum
value and minimum value on the “Numeric Attribute” dialog box.
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 Text
Function
When editing  attribute  using  Advanced  Edit  Attribute  tool,  users  can  directly  enter
the text.
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Settings
Users can set  the attribute name, comment,  the length of the text,  default  text  on the
“Text Attribute” dialog box.
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 Date
Function
When editing attribute using Advanced Edit Attribute  tool,  users  can directly  tap the
date form to get the date or directly enter manually.
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Settings
Users  can  set  the  attribute  name,  comment  and  date  format  on  the  “Date  Attribute”
dialog box. If Auto Generate On Creation or Auto Generate On Update is  checked,  the
Date will be generated automatically while the feature is being added or updated.
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 Time
Function
When editing attribute using Advanced Edit Attribute tool, users can enter time.
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Settings
User can set  the attribute name, comment and define 24 hours  or 12 hours  format  on
the  “Time  Attribute”  dialog  box.  If  Auto  Generate  On  Creation  or  Auto  Generate  On
Update is checked, the Time will  be generated automatically  while the feature is  being
added or updated.
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 File Name
Function
When editing attribute using Advanced Edit Attribute  tool,  users  can browse the  file
path by tapping  and system will automatically enter the file path. Besides users can
preview the file by tapping .
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Settings
Users can set the attribute name, comment, file type on the “File Attribute” dialog box.
The extension of file should be clearly specified in file type. 
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 GPS
Function
When  editing  attribute  using  Advanced  Edit  Attribute  tool,  users  can  make  the
current  coordinates  be  entered  to  the  field  automatically  by  tapping   or  they  may
enter manually. Please be noted that the GPS of SuperPad should be turned on before
the activation of making coordinates be entered by system.
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Settings
Users  can set  the  attribute  name,  comment  and  GPS  format  on  the  ”GPS  Attribute”
dialog box.  Users  can define GPS format  in  X or Y or X and  Y.  If  Auto  Generate  On
Creation  or  Auto  Generate  On  Update  is  checked,  the  GPS  will  be  generated
automatically while the feature is being added or updated.
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 Camera 
Function
When editing attribute using Advanced Edit Attribute  tool,  users  can directly  take  a
picture by tapping the camera icon and the file path of the picture will  be entered to the
field automatically.  Please note that  the mobile device must  be equipped with  camera
function so this  function can be  performed.  The  picture  files  are  saved  in  the  camera
path that the System Settings defines.
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Settings
You can set the name of attribute, comment and picture quality  in the Attribute Setting
dialog box. Picture quality has four options Default, Low, Normal and High.
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 Area 
Function
When editing attribute with Advanced Edit Attribute,  you can tap the  Area  icon  and
record the area of the feature.
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Settings
In Area Attribute you can set the attribute name and comment.
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4. After the settings are finished,  please tap OK.  You can tell  the type of the attribute
field according to the icon on the “Attribute Setting” dialog box.
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5. The custom form to enter attributes is created.
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 Advanced Edit Attribute

Advanced Edit Attribute

After the custom form is created, you can edit the attributes with Advanced Edit
Attribute function in a quicker way.

1. Firstly, set the layer whose attributes you want to modify editable, and then select a
feature.
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2. Tap the AdvancedAttributeEditing tool and tap Advanced Edit Attribute on the
drop-down menu.
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3. The “Edit Attribute” dialog box shows up, please modify the attribute values
according to your need. After the modification is finished, please tap OK. Please see
the two figures below and you can easily understand how convenient the custom
form could be: when you are using the Advanced Edit Attribute function, you have
to enter all the data on your own if no custom form is available; if you have the
custom form, you can quickly enter the data with the specially designed forms.
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        Attribute table without custom form                 Attribute table with custom form

4. When the editing is finished, tap OK. The advanced attribute editing is
accomplished.
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BirdView

BirdView

2.5D bird view function makes the map be displayed with 3D effect and look more like
the reality. Tap the BirdView button on the main toolbar and switch to BirdView
toolbar.



System Settings and Others

386

   

Repeatedly tap the  button and the angle of depression will decrease. Repeatedly
tap the  button and the angle of depression will increase.
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DataServicesToolbar

 Add WMS Server

Add WMS Server

When PDA connects  to  Internet  service,  the  layers  published  on  the  Internet  can  be
added to SuperPad through this  add-on.  The  layers  published  on  the  Internet  usually
are of high practical utility  and through  SuperPad  users  can  swiftly  connect  to  server
and reach the layers for advanced browsing, analysis and editing.
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1. First of all, connect PDA to the Internet,  tap DataServicesToolbar button to switch
to  DataServicesToolbar  toolbar.  Tap  WMS  dropdown  arrow  and  tap  Add  WMS
Server.

   

2. Type the server address in URL and tap Get Layer.
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3. All of the layers distributed by the server are listed in the below part; please select
the layers to display by checking.
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4. Tap the Other tab and the related information about the layers will be presented in
the below part. Tap OK and go back to the map window.
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5. The map window displays the layers.
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 Adding WFS Server

Add WFS Server

1. First of all, connect PDA to the Internet, tap DataServicesToolbar button to switch to
DataServicesToolbar toolbar. Tap WMS dropdown arrow and tap Add WFS Server.
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2. Type the server address in URL and tap Get Layer.
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3. All of the layers distributed by the server are listed in the below part; please select
the layers to display by checking.
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4. Tap the “Others” tab and the related information about the layers will be presented in
the below part. Tap OK and go back to the map window.
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5. The map window displays the layers.
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 SuperGIS Server

SuperGIS Server

1. Tap SGS button and select Add Data from SuperGIS Server….  

    

2. SuperGIS Server window shows up. It provides three ways to connect to SuperGIS
Server: 
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Connection already exists    
During the period of time from SuperPad is activated until it is closed, once you have
connected to SuperGIS Server, you can tap the dropdown arrow to show the connection
IP list and directly choose one to connect. If you have not connected to any one yet, it
will be blank. 

    

SuperGIS Server Configuration File                           
All connection records generated by activating DataServiceTool will be saved as sgs
files (*.sgs) in the specified folder, and you can select a file to connect by tapping .
One file records one connection, and the filename consists of the date and time of
connection. For example, 20110928-1048.sgs refers to the connection at ten forty-eight
on September 28th in 2011. 
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Input                           
If it is the first time you connect to SuperGIS Server, you will need to input the server
IP, user name and password to connect. 

    

3. Connect SuperGIS Server window by clicking OK.
4. “Published Folders” window shows up. Please select a service to connect and click 

OK.
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5. The maps provided by the service will be shown on the window. If the map is
editable, it will be marked “Editable.” Select one map and click OK.
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6. The selected map displays on the window, and you can start to navigate.

    

7. If you select an editable map, you can set the map service editable in Layer
Manager, and then all the layers contained in the map service will be added to
SuperPad and be downloaded to the specified folder automatically. It might take a
few seconds, please be patient. After all layers show up, you can edit the layers in
the same way you edit the general GIS layers.
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8. After editing, if you want to update data with SuperGIS Server, please tap 
Synchronize Data with SuperGIS Server.

    

9. When the data is updated successfully, a message as below will show up.
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FixedZoom

FixedZoom

Provides the functions of fixed zoom in and fixed zoom out. The function keys are
located at the bottom left and bottom right corners of the map. Tapping  can perform
fixed zoom in. Tapping  can perform fixed zoom out.

   

© 2015 Supergeo Technologies Inc. All Rights Reserved.

GNSS

GNSS
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The add-on uses pesudorange observations measured by GPS reference stations to
correct the sharing error of receiver's pesudorange observations by Pesudorange
Correction(PSC). Then the corrected pesudorange observations are used to position
with improved accuracy[1]. Extended Kalman Filter(EKF) is used as the solution
technology to calculate the positioning, the states in solution are position, speed and
time in 3-dimensional[2]. Be well noted, the GPS accuracy can be influenced by
environments such as in basements, on overpasses or near-by tall buildings; the
positioning accuracy could drop due to the satellite signals being shielded. To enhance
product performance, used in open space or non-shield space is recommended. 

1. Parkinson BW and Spilker J J Jr. (1996) Global Positioning System: Theory and
Applications, Volume 2, John Wiley & Sons, Inc.

2. Gelb A (1974) Applied Optimal Estimation, Cambridge, MA: MIT Press. ISBN:
0262570483
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Mobile Device Settings

Before going outside to do the survey, please make sure you have done some changes
on the settings to your mobile device:

1. Navigate Settings > System. 
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2. Tap Power, in Power page uncheck both of the boxes "Turn off device if not used for"
in "On battery power" and in "On external Power."
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3. Navigate Settings > System > Backlight, please uncheck the box “Turn off the
backlight when the device is not in use for.”

       
    

© 2015 Supergeo Technologies Inc. All Rights Reserved.
 Starting to Use on Window s Mobile

Starting to Use on Windows Mobile

1. Launch SuperPad in Windows Mobile.

2. Enter System Settings, find “Customize” tab and check the box “GNSS.dll.”
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3. Exit SuperPad, and restart it.
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4. Setup for the Spatial Reference of map: GCS_WGS_1984.
           
    

5. Switch to GPS toolbar and turn on GPS (icon will become green).
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6. Check the GPS status to make sure GPS is positioned:
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If the GPS is positioned, you will see a green check sign.
 

    

Tap “Detail”, the GPS position mode must be in 2D or 3D.
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If the GPS signal is positioned and fixed, the GPS position will be shown on the map.
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7. Switch to GNSS toolbar, and tap the wrench icon to set up for:
(a. the waiting time before starting to record GNSS data (it counts the seconds upon
the round icon mentioned in step 8 is tapped. Take the figure below as an example, 30
seconds  waiting time means it starts recording in the 31 seconds as the round button
is tapped)�
(b. the folder to save the RINEX and GNSS file
         
    

8. Tap the round icon in GNSS toolbar to enable the function. System will start
recording as the icon is tapped after the waiting time set in step 7. (red: stop
recording/ green: start recording).
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9. Add a new feature layer (point, line, or polygon in either .geo or .shp format).
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10.Switch to Edit toolbar, you may start to record the features by GPS.

    

11.Finish editing features, you may turn off GNSS to stop recording, and turn off GPS. 
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12.Finish! Bring your data/mobile device back to office. 

© 2015 Supergeo Technologies Inc. All Rights Reserved.
NTRIP

NTRIP
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 Mobile Device Settings
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Mobile Device Settings

Please make sure your mobile device had been link to the Internet (via cellular network
or WiFi) before applying NTRIP services. Also, please make sure you have done some
changes on the settings to your mobile device before starting up your field survey:

1. Navigate Settings > System. 
      

    

2. Tap Power, in Power page uncheck both of the boxes "Turn off device if not used for"
in "On battery power" and in "On external Power."
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3. Navigate Settings > System > Backlight, please uncheck the box ??Turn off the
backlight when the device is not in use for.??/text>
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Applying NTRIP Service on Windows Mobile Platform

1. Open up SuperPad on your Windows Mobile device.

2. Enter the Customize Tab within System Settings, and check up Ntrip.dll.
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3. After check up the option, please restart SuperPad to apply the settings.
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4.  Now you will find the NTRIP tool had been activated.For first time using, please
entering the setting page.
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5. Entering the setting page, your can select the Chip setting within the drop down list
as your mobile device's GNSS module specification. There are still some more
options to fill up with, including the COM Port for sending RTCM, Baud Rate, your
NTRIP Caster IP address/Port and your ID/Password. Meanwhile, user can simply
press the button beside MountPoint to get the service list. Select the service you
need and press OK. Please beware of the RTCM format has to be match with the
GNSS module of your mobile device.
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6. Finish the setting by pressing OK button and back to the main map frame. Now you
can hit the NTRIP service button to active the connection. Message will be shown for
indicate the connection status, and the handshake data will also been display on the
HUD.



System Settings and Others

422

    

7. Now you can swap to the GPS Tool and activate the positioning function. Your
current location will be shown on the main map screen, and you can also check out the
HUD display on the upper left part of the screen for data transmission status and fixing
quality. For more detailed information, you can entering the GPS Status tool and find
out more about accuracy and deviation. You can start the data collection and data
measurement when the positioning accuracy match up with your survey demands.
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7. You can easily build up various of dataset and collect data in higher accuracy via
NTRIP service.

8. For stopping the NTRIP service, simply just click on the NTRIP service button again.
System will show up a success message after terminate the connection.
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9. Now you can bring the data and mobile devices back to your office.

© 2015 Supergeo Technologies Inc. All Rights Reserved.
Laser

 Settings

Settings
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1. Before  starting  measurement  with  Laser  add-on,  please  complete  the  settings  to
connect mobile device and laser rangefinder. Firstly, tap the Select  Fields  drop-down
menu and tap Options.  The “Options” dialog box shows  up,  tap  the  Protocol  drop-
down menu and select the laser rangefinder to connect. Tap OK.

         

 
2. Set  the  connection  settings.  Please  tap  “Serial  Port  Options”,  the  “Serial  Port

Options” dialog box shows up and set the items.
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The serial port options  are explained in the table below: 

Name Content

Port Define  the  serial  port  of  the  mobile  device  to  connect  to  laser
rangefinder.

Baud Define the transmission rate of laser rangefinder.

Data Bits The count of bit which laser rangefinder transmits data.

Parity The count of parity which laser rangefinder transmits data.

Stop Bits The last bit transmitted by laser rangefinder.

3. Add the base map to SuperPad and set  the spatial reference of each layer.  Specify
the map spatial reference WGS 84.



SuperPad 3.3 Help

427

    

4. Create a new layer to store all the position data by tapping New Layer. Because the
laser  rangefinder  measures  the  position  by  shooting  one  spot,  the  obtained
measurement  result  belongs to one spot  as  well.  So please create  a  layer  of  point
type.  Eleven  attribute  fields  are  built  in  the  layer  by  the  system  to  save  the
measurement  results.  Or you can adjust  the fields  according  to  your  needs.  Users

can add a new field by tapping . If one field is selected,  users  can adjust  the order

by tapping ,  delete field by  tapping  or remove all  fields  by  tapping .  After
all the fields are created, tap OK.
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5. When a point  layer  is  created,  please  tap  Select  Fields to  set  the  measurement
information to be saved in which field. 

    

6. The “Field” dialog box shows up, there are two tabs, Standard and Advanced.
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Users  can decide the information  in  Standard  tab  to  be  saved  in  which  attribute  field
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through  the  drop-down  menu.  For  instance,  tap  the  drop-down  menu  of  Z,  you  can
select the field Z from the field list to record the altitude information.

Info Name Info Contents Field

X Longitude X

Y Latitude Y

Z Altitude Z

Date Date Date

Time Time Time

Identically, the Advanced tab include the information:

Info Name Info Contents Field

Horizontal
Distance

The horizontal distance from the measurement
spot to the target. HD

Vertical Distance The  vertical distance from the measurement spot
to the target. VD

Slope Distance The  slope distance from the measurement spot
to the target. SD

Inclination The inclination from the measurement spot to the
target. INC

Azimuth The azimuth from the measurement spot to the
target. AZ

Message The original message of the laser rangefinder. Message

Please refer to the figure below for the meanings of information in the Advanced tab.  As
to  how the  laser  rangefinder  calculates  and  measures  distance,  please  find  in  your
laser rangefinder manual.
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© 2015 Supergeo Technologies Inc. All Rights Reserved.
 Using Laser Rangefinder

Using Laser Rangefinder

In this add-on, there are two ways to measure with laser rangefinder: using GPS
position as datum and setting reference point as datum. With GPS position as
datum, firstly GPS must be turned on to get the current GPS position, and then start to
measure with laser rangefinder. The centroid information get is right the information of
the spot where the laser rangefinder shoots. The other way is to take a reference point
as datum, which is used when you are unable to reach the target. Through specifying a
reference point and relative position, the information of the real target can be found
through calculation.

© 2015 Supergeo Technologies Inc. All Rights Reserved.

 Using GPS Position as Datum

Using GPS Position as Datum
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1. Turn on GPS. When you start Laser extension and the GPS is off, a message as the
figure below will show up to remind you to turn on GPS.

    

2. Tap Get Target Position. When the button turns green, you can start to measure
with laser rangefinder.

         

3. Aim at the target with laser rangefinder and press the Fire button. When the
measurement information is obtained successfully, “Edit Attribute” dialog box shows
up and the information will be filled in the attribute table automatically. Tap OK.
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4. Go back to the map, a point feature is added to the map where you shot the spot. 
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5. If you have not created a point layer before starting measurement, after you shoot a
spot, a message as figure below will show up to remind you to create a point layer. 

     

6. After you shot a spot with laser rangefinder, you may tap Debug and check the
original signal of laser rangefinder. Through  it you will know whether the mobile
device connects to laser rangefinder successfully.
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 Setting Reference Point as Datum

Setting Reference Point as Datum

Please refer to the figure below, if a target centroid B is located where unable to
measure, and the relative position between centroid C and centroid B is known identical
to that between centroid D and centroid A; in that case, to get the relative position
between centroid D and centroid A via laser range finder is to get that between centroid
C and centroid B. After that, the position of target centroid B can be obtained by
calculating with the known position data of centroid C on laser range finder. Centroid C
is the reference point. Since the result is calculated by the relative position, the
difference of relative position might cause that of the result.
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1. Tap Get Target Position By Reference Point to set reference point. Tap “Get
Target Position” drop-down menu again, when Get Target Position By Reference
Point shows framed by a red square, please tap Select Reference Point and
directly tap where you want to set as reference point on the map.
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2. shows up where you tap on the map, it represents the reference point. Then, aim
at the relative position with laser rangefinder and press the Fire button. System will
calculate and shoot a spot from datum  towards the identical relative position. 

    
 

3. When the measurement result is obtained successfully by mobile device, “Edit
Attribute” dialog box shows up and the attribute table will automatically be filled with
results. 
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4. Tap OK to go back to the map, and the new feature will be added to the map.
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5. After tapping Get Target Position By Reference Point, if you then start to
measure without setting a reference point, a message as figure below will show up to
remind you to proceed by selecting the reference point after you shoot a spot. 

    

6. You can also enter the coordinates of the reference point manually. Firstly, tap Set
Reference Point and the “Reference Point” dialog box shows up. 
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7. Enter the X,Y,Z value of the reference point. After that, tap OK and go back to the
map and continuously proceed step 2. 

    

© 2015 Supergeo Technologies Inc. All Rights Reserved.
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NetworkTool

NetworkTool

It provides route planning function; through the settings of flags and barriers, the system
will work out the superior route planning. 

Firstly  add a road layer  to  SuperPad.  Then  tap  the  NetworkTool  button  in  the  main
toolbar  to  switch  to  NetworkTool  toolbar.  The  system  will  auto-detect  whether  a
corresponding .nrt  file of the same filename exists  in the folder when the road layer  is
added; if yes, the system will automatically add the .nrt file to SuperPad.  But  if the .nrt

file is saved in another folder, please tap  and add the .nrt file by yourself.

Select Set Location and tap the location on the map where you want to mark a label,

and the  shows up right at the position. Location is a simple label which facilitates
users to find out some specific position. Only one Location exists on a map; if
necessary, user can convert Location to Stop or Barrier, which will be described in the
following section.
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To set a Location at  the current  GPS position,  please activate GPS first  and switch to
the Network Tool toolbar. Tap the Set Location dropdown arrow and select  the Select
Location By GPS, a Location label shows up at the current GPS position.
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If you want to set up the Location with longitude and latitude, please select Set
Location By Long/Lat.

   

The “Set Location by Longitude” dialog box shows up; in Longitude Latitude the values
of the current GPS position are displayed. You can enter the values by yourself. After
the values are entered, please tap OK.
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Go back to the map, a Location will be added to the position where you just set up.
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If you want to clear Location, please tap Clear Location.

   

If you want to convert the Location to Stop, please tap Convert To Stop. The Location
turns to Stop.
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If you want to convert Location to Barrier, please tap Convert To Barrier. And Location
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turns to Barrier.

   

Tap the Add Stop dropdown arrow and a tool menu shows up. To add stop, please tap
Add Stop.
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In the next, tap the position where you want to add a stop, and then a stop will be
added to the map. Repeat the way to add stops till all the stops are added.
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To clear all stops, please tap Clear All Stop on the tool menu, and then all the stops
on the map will be cleared up.

To manage the stops, please tap the Manage Stops on the tool menu. After entering
Flags Manager dialog box, you can adjust the stop order or remove it. 
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First of all, select the stop you want to adjust, and you will find the tools on the upper
left part become enabled.

: the stop order is moved up by one place.
: the stop order is moved down by one place.
: remove the selected stop.
: remove all stops.

The unchecked locations are not viewed as stops, so the system will not plan to pass
the locations.

To add stops at GPS position, please activate GPS first. Then tap Add Stop By GPS 
on the tool menu.
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A flag named GPS will be added at the GPS position on the map.

   

To add barriers, tap the Add Barrier dropdown arrow. When tool menu shows up, tap
Add Barrier.

   

In the next, tap the location on the map where you want to add a barrier, and the barrier
will be added to the map. Repeat the way to add barriers till all barriers are added to the
map.
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To clear all barriers, please tap Clear All Barriers.

To manage barriers, please tap Manage Barriers. Select a barrier you want to remove,
and  click   to  remove  it.  Or  you  can  click   to  remove  all  the  barriers.  In  route
planning  the  unchecked  barriers  are  not  viewed  as  barriers  to  the  system,  so  the
system might plan to pass the barrier's position.
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To add barrier at the GPS position, activate GPS first and tap the Add Barrier By GPS
, and a barrier will be added to the map at current GPS position.
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When stops and barriers are set up, tap Create Route from Stops, and the result will
be displayed on the map.
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If you  want  to  plan  the  shortest  route,  please  select  Create  Optimized  Route  .  To
create the Optimized  Route,  the  system  will  plan  the  route  according  to  the  nearest
stop  instead  of  the  stop  order;  this  method  is  suitable  for  the  travel  route  planning.
Please  see  the  Create  Route  from  Stops  result  in  the  previous  part.  The  route  is
planned  according  to  the  specified  stop  order,  while  the  figure  on  the  right  side,  the
Create Optimized Route result, is planned according to the nearest  stop instead of the
order. Therefore, it will go to the nearest  stop first.  Please see the figures below to tell
the difference between Create Route from Stops and Create Optimized Route.
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To clear the route planning, please tap Clear Route.
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Tap Driving Direction and “Road List” dialog box shows up.  The dropdown list  in  the
upper  part  allows  users  to  select  the  road  section,  and  the  detailed  instructions  of
direction and distance are listed in the lower part.  When you select  a section,  tap 
and tap OK.

   

The map will pan to the extent of the selected road section. Please see the third figure
below.
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When you are approaching the destination, a message like the figure below will pop up.
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OnlineMapTool

OnlineMapTool

A variety of online maps are available to be used as the base maps with
OnlineMapTool. With the add-on users are able to choose the needed online map style
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to be the SuperPad basemap for further editing, query or measurement.
 
1. Tap Map Layer  to add the default Online Map Layer to the map. 
  

     

2. Map Style and Zoom Level buttons now become enable, tap the Map Style
downwards arrow to display the drop-down menu and tap to switch to required map
style. 
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3. Tap Zoom Level to adjust the Online Map Layer level.
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Please Note: To add Google Map to SuperPad, you need to add manually and before
use it please make sure you are well understanding the conditions and treaty  and have
authorized from Google Map. Next, open OnlineMapToolSetting.txt which is empty from
the SuperPad setup directory and write in the map styles wanted to this text file, one
item in a row, such as Google Roadmap, Google Satellite, Google Terrain, Google
Hybrid.

© 2015 Supergeo Technologies Inc. All Rights Reserved.
SketchLabeling

SketchLabeling 

The sketch add-on can draw freehand line with stylus on the screen map as highlight or
shorthand. 

Tap the Sketch button on the main toolbar and switch to Sketch toolbar. 
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Tap  Add  Sketch   button  and  when  Add  Sketch  gets  activated,  directly  draw the
freehand  line  with  stylus  on  the  map  and  the  freehand  line  will  be  highlighted  in  red
color.  If  you  want  to  delete  freehand  line,  please  tap  Delete  Sketch   to  clear  all
freehand lines,  so all  freehand lines will  be deleted.  If you want  to go back to previous
freehand  line  sketch,  please  tap  Previous Sketch  .  If  you  want  to  save  the  file,
please tap Save   and it will  be saved in KML file.  If you want  to open a file,  please
tap Open  to open a file.

© 2015 Supergeo Technologies Inc. All Rights Reserved.
SBAS

SBAS

This add-on will remind you with a plane icon shown on the map screen when a satellite
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flies over the current GPS position.
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SGSOnlineEditToolbar

SGSOnlineEditToolbar

Users are able to online edit the editable Services published by SuperGIS Server and
synchronize data with SuperGIS Server with this add-on. 

1. Start SuperPad, switch to SGSOnlineEditToolbar, and tap Open From SuperGIS
Server.
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2. Input conneciton info in Input. You can select an already-existing connection in
Connection already exists or choose a connection Configuration file in SuperGIS
Server Configuration File.
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3. Tap Service_ROOT to show the Published Resoureces. Choose one editable service
and tap OK. 
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4. Return to map, the service displays on the map and now tap  to do editable layer
setting.
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5. You can set one point layer, one polyline layer and one polygon layer editable, and
the selected layers will be allowed to add new features. Meanwhile Layer For Delete
specifies one layer to enable users to delete features on it. 
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6. For instance, to add a polyline feature, you need to tap Polyline button and draw a
polyline feature on map. Tap the Polyline button again as the feature is finished.
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7. Tap Yes.
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8. Enter the attribute data.
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9. Return to map, the polyline feature is added up and synchronized with SuperGIS
Server.
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10.To delete features, the target layer must be selected in Layer For Delete on Editable
Layer Settng page. Then tap Select Features to Delete button and frame the features
to delete.
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11.Check the features to delete and tap Yes.
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12.The selected features to delete have been removed and synchronized with SuperGIS
Server.
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SGTLayer

SGTLayer

The SGT map tile generated by Map Tile Tool now is able to be added to SuperPad
through SGTLayer add-on. Once the add-on is activated, you can read and display SGT
layer by adding SGT layer to SuperPad.
  
About the way to generate SGT map tile please refer to Map Tile Tool user guide.
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STCLayer

STCLayer

The STC map tile generated by SuperGIS Server now is able to be added to SuperPad
through STCLayer add-on. 

Once the add-on is activated, you can read and display STC layer by adding STC layer
(both *.xml and *.stp format index file are supported) to SuperPad.

    



SuperPad 3.3 Help

477

About the way to generate STC map tile please refer to SuperGIS Server user guide.
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Display Quality

Display Quality

Set up whether to use “Polyline Greeking” and “Polygon Greeking.” Greeking function
can simplify the rendering, improving the rendering efficiency.
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Polyline layer without greeking effect.

   

Polyline layer with greeking effect.
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Misc

Misc

In this tab, you can set whether to “Show startup dialog” after SuperPad is activated by
checking this option. If you want to use relative path for the layers, please check “Use
relative path for layers.”



System Settings and Others

480

   

If you check “Automatic SIP Panel”, when you are tapping the field, SIP panel will show
up automatically. For example, when you tap Name combo box, the SIP panel will
appear automatically.
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“Pen Tolerance” is the tolerance of stylus, the unit is pixel. “Default Dialog Font” can
set up the font for all SuperPad dialog boxes.
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11.2 Other Tools
Quick Explorer Tool Menu

Quick Explorer

Quick Explorer

1. Tap System Settings > Quick Explorer.
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2. Quick Explorer shows up. This is a set of quick tools in the left side of the window;
you can directly tap the function to pan, zoom in, zoom out or zoom to full extent for
one time. As an function is selected, the icon turns red, which means the function is
activated. As the function is accomplished, the icon returns to blue. 

    

© 2015 Supergeo Technologies Inc. All Rights Reserved.



SuperPad 3.3 Help

483

Status Bar

Status Bar

1. Tap “System Settings” on the main toolbar and tap Quick Explorer > Status Bar.

   

2. Please see the figure below. The map shows the status bar with coordinates at the
bottom of the screen.
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Panning Frame

Panning Frame

If you check this item, Panning Frame will show up on the map. And you will  find it  is
framed with many arrows around the map. As long as  you tap the arrow with stylus  (or
mouse)  where  you  want  to  move,  the  viewshed  will  pan  to  the  direction  that  arrow
indicates.  If you simply  tap the arrow once,  the map will  pan 1/3 of the  screen  range.
See the figure below; if you keep pressing the arrow,  the  map  will  be  panned  slightly
continuously.
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Slide Zoom can also be applied together with it, so you can zoom and pan together on
the map without switching toolbars to select tools and run the behaviors respectively.
Thus, the browsing can work more rapidly.
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Compass

Compass

If you check Compass, the compass will show up on the map. If not, it will be hidden.
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Scale Bar

Scale Bar

If you tap Scale Bar, the scale bar will show on the map. If not, it will be hidden.
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Map Grid

Map Grid

If you tap Map Grid, map grid shows on the map. If not, it will be hidden.
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The label format  of map grid will  be changed according to  the  spatial  reference  of  the
map. If the spatial reference is set in Projected Coordinate System, the map grid will  be
labeled  in  numeric,  whose  unit  is  meter,  like  figure  above.  If  the  map  is  set  in
Geographic Coordinate System, the map grid will be labeled with latitude and longitude,
see the figure below.
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Add Waypoint Tool Menu

Add Waypoint

Add Waypoint          

1. Tap  the  System  Settings  button  on  the  main  toolbar,  switch  to  System  Settings
toolbar,  tap  Add  Waypoint.  Then  tap  at  the  position  where  you  want  to  add
waypoint with stylus (or mouse). “Add Waypoint” dialog box shows up.
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2. Input the Name of waypoint and its X, Y and Z values will be automatically shown or
you can change the values. Then tap OK.
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Add Waypoint at GPS Position

Add Waypoint at GPS Position         

The function will add a waypoint  at  GPS position.  Please make sure the GPS function
is activated in SuperPad. 

1. When GPS reaches the position you want to set  waypoint,  tap the System Settings
button on the main toolbar, switch to System Settings toolbar and tap the dropdown
arrow of Add Waypoint > Add Waypoint at GPS Position.

   

2. “Add Waypoint” dialog box shows up. Input the Name for the waypoint and X, Y and
Z values will be input automatically according to the GPS position or you can change
on your own. Then tap OK.
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3. Back to the map, the waypoint is added to the map.
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Waypoint Manager

Waypoint Manager

1. Tap the dropdown arrow of Add Waypoint > Waypoint Manager.
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2. All waypoints will be listed here. You can select the one you want  to edit.  When the
waypoint is in selected status, tap a function button on the right side to use.

   

Name Description
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Edit “Add Waypoint” dialog box shows up and you can begin to edit.

Go to Move the selected waypoint to the map center.

Set Target The selected waypoint marked with check indicates that this is the
target GPS is going to.

Delete Delete the selected waypoint.

Delete All Delete all waypoints.

Visible Check it and waypoint mark  shows up on the map; if not, it
disappears.
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Photo Navigation

Photo Navigation

1. Tap the dropdown arrow of the Add Waypoint > Photo Navigation.

   

2. The “Open File” dialog box appears, please specify a photo with coordinates for
navigation.
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3. Go back to the map, and the system automatically sets the photo's position as
waypoint on the map. If GPS is activated, it will navigate to the position of the photo's
position.
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Import/Export Waypoints

Import/Export Waypoints

1. Tap the dropdown arrow of Add Waypoint and tap Import Waypoints or Export
Waypoints to import or export waypoints. To export waypoints, the waypoints will be
saved in *.geo file. To import waypoints, you will need to open the file.
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NOTE: “Waypoint Manager“ dialog box can be opened through the way mentioned
above or you can open it through GPS toolbar > GPS Position Information > Waypoint.
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Polyline Measurement Tool Menu

Polyline Measurement

Polyline Measurement

1. Tap  the  System  Settings  button  on  the  main  toolbar,  switch  to  System  Settings
toolbar, tap  Polyline Measurement.

   

2. Then draw a polyline that you want to measure on the map with stylus  by  tapping on
the position where you want  to add a turn point  and repeat.  A red point  appears  on
the first  tap then a blue line appears  to connect  the first  and second point  after  the
second tap; after the third tap, a blue line shows up to connect  the second and third
point and so on. After you tap the last  point,  tap Polyline  Measure  button again to
finish sketching polyline.
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3. “Measure Result” dialog box shows up, it offers information including:
Starting Coordinate: the first sketching point.
End Coordinate: the last sketching point.
Total Distance: total distance from the start coordinate to end the coordinate.
Straight Distance: the straight distance from start to end point.
Area: the area of the closed area that is made by connecting polyline's start and end
points. 
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4. Tap OK to close this dialog box.
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Freehand Measurement

Freehand Measurement             

1. Tap  the  System  Settings  button  on  the  main  toolbar,  switch  to  System  Settings
toolbar,  tap  the  dropdown  arrow  of  Polyline  Measurement  >  Freehand
Measurement.
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2. Drag the trail that you want to measure with the stylus (or mouse) on the map. When
the stylus (or mouse) leaves the map, the line sketching is stopped.

   

3. “Measure Result” dialog box shows up, and the results are listed here. Tap OK to
close the dialog.
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Rectangle Measurement

Rectangle Measurement             

Rectangle Measurement allows you to measure by sketching a rectangle on the
map.

1. Tap  the  System  Settings  button  on  the  main  toolbar,  switch  to  System  Settings
toolbar,  tap  the  dropdown  arrow  of  Polyline  Measurement  >  Rectangle
Measurement.
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2. Drag a rectangle on the map. When the stylus (or mouse) leaves the map, the
rectangle sketching is stopped.

   

3. “Measure Result” dialog box appears and the results are listed here. Tap OK to close
the dialog box.
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Radial Measurement

Radial Measurement           
 

1. Tap  the  System  Settings  button  on  the  main  toolbar,  switch  to  System  Settings
toolbar, tap the dropdown arrow of Polyline Measurement > Radial  Measurement
.
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2. Drag a circle with stylus,  the center of the circle is  the start  point.  When the stylus
leaves the map, the circle sketching is  stopped.  “Measure Result” dialog box shows
up, various measure results are listed. Tap OK to close the dialog box.

   

3. “Measure Result” dialog box shows up, various measure results are listed. Tap OK to
close the dialog box.
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Feature Measurement

Feature Measurement   

Feature Measurement allows users to get measurement result by tapping straightly on
features on the map.

1. Tap System Settings and switch to System Settings toolbar. Tap the downwards
arrow of Polyline Measurement and select Feature Measurement on the menu.
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2. Tap straightly on the feature you want to measure and the result shows up. Different
results show up, which depends on the feature type in point or line or polygon.
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Camera

Camera

You can only  use this  function  if  the  smart  device  is  equipped  with  camera  function.
Activating this function can directly activate the camera function in smart device through
SuperPad.  With  GPS  positioning  function,  the  coordinates  of  the  place  you  take
pictures can be saved to the picture file or can be used to generate photo layers.  In the
next, we are to take PDA as an example to explain the use.
 
Tap  the  System  Settings  button  on  the  main  toolbar,  switch  to  System  Settings
toolbar, tap Camera and PDA will enter the camera mode.
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After the picture is  taken,  “Input  Coordinate” dialog box shows up.  If GPS is  activated,
the system will input the coordinate values automatically or you can tap  to input  the
current GPS position. Besides, in Angle, you can input  the angle between you and the
target, taking the north of the target as 0 degree to gain the angle; in Distance input  the
distance  between  you  and  the  target.  After  that,  you  can  use  the  four  values  of
coordinate  values,  angle  and  distance  between  you  and  the  target  to  estimate  the
coordinates of the target.

   

After the data is  input,  tap OK.  The picture  file  will  be  stored  in  the  folder  you  set  in
System Settings > Camera tab > Default Picture Folder.
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Run Script

Run Script    

Run  Script  can  customize  SuperPad  function,  which  enables  users  to  directly  write
code; moreover, once the codes are run, the function can be executed.
                    
However  what  is  the  difference  between  Run  Script  and  the  projects  or  extensions
generated by SuperGIS Mobile Engine? SuperGIS Mobile Engine is a tool to generate a
set  of  complete  project  or  extension,  which  includes  the  custom  interface  design,
encoding and map control.  As  the project  or  extension  is  loaded  to  SuperPad,  users
must restart  SuperPad to take the function into effect.  But  as  to Run Script,  you can
directly write codes on SuperPad, and the function of script  can be executed when the
script  runs.  Compared to the completeness of extension created  by  SuperGIS  Mobile
Engine,  Run Script is  the tool acting  as  a  good  assistant  to  write  codes  for  smaller
function  in  customizing  light,  flexible  and  simple  custom  functions.  For  example,  as
you are  manipulating  SuperPad  and  you  do  not  need  Editing  function  for  the  current
project, you can write a script  of hiding Edit  toolbar,  save this  script  and activate it  as
needed.  Besides,  you  can  also  use  Run  Script  to  write  the  same  function  as  what
SuperGIS  Mobile  Engine  could  do,  but  the  aim  of  Run  Script  is  to  write  the  small
function  excluded  in  SuperPad  for  immediate  use.  The  convenience  and  promptness
are the key features of Run Script. 

Directly click Run Script of the System Settings toolbar.

   

After entering the dialog box as the figure below, you can start to write script.
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After the script is done, click Run . If the script  runs successfully,  the function can
be activated immediately. You can also save the script  as  a new file,  so next  time you
can  open  it  and  run  the  script.  The  executed  script  will  be  closed  as  you  exit
SuperPad.  So,  next  time  you  start  SuperPad,  you  need  to  run  the  script  again  to
activate it.
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Serial Port

Serial Port

Serial  Port  can  be  used  to  input  or  output  messages  of  GPS  receiver,  and  the
message will be displayed at the bottom.
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Firstly  set  up the various  parameters  of  GPS  receiver,  tap   and  enter  “Serial  Port
Options” dialog box.  In “Serial Port  Options” dialog box,  set  up the various parameters
according to your need.
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After the settings are finished,  go back to “Serial Port” dialog box,  tap  to input  the
messages from GPS receiver, and they will be displayed on the bottom square.  Or you

can tap  to  output  the  messages  that  you  type  on  the  bottom  of  square  to  GPS
receiver.
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Lock

Lock

Remember the Lock function of the Smart Editing Bar? As the  function  is  selected,
the map window will  be locked and will  not  be able to be modified.  This  function  is  to
avoid incorrect editing caused by carelessly  touching other function keys in the editing
process. However, it can work only together with Smart Editing Bar when the layer is
in editable status. Now, an independent  Lock function is  designed on the map window
for users to use any time.

Tap the unlocked icon  at  the upper right  corner of the map window; as  it  becomes
locked ,  the entire map window becomes locked.  To  cancel  the  locked  status  and
back to general manipulation,  please tap the locked icon .  As it  becomes unlocked
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, the map window is back to enabled status.
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Options

Options

This menu is located on the right side of the second tier toolbar. Tap the dropdown
arrow and the menu shows up. Many express toolbar associated options are listed on
it, and now we are to introduce them one by one.
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Minimize

Minimize

The toolbar can be minimized to make the map window neater.
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To show the toolbar, please tap the minimized toolbar area and the Maximize item
shows up. Tap Maximize and the toolbar will show.
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ToolBar Selector

ToolBar Selector

If this item is not checked, the first tier toolbar group will be hidden.
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To show the first tier toolbar, please check it. The default is checked.
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ToolBar Alignment

ToolBar Alignment

Toolbar is able to be aligned top, bottom, right, or left. The figure below is the example
that aligns right.
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ToolBar

ToolBar

If you have hidden ToolBar Selector, you can switch to the needed toolbar group
through ToolBar list.
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Favorites

Favorites…

Tap Favorites and enter “Favorites” dialog box. Check the items you want to add to
Favorites then tap OK.
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Go back to the map window, tap Favorites in the form of star icon and the checked
items will be added to the corresponding second tier toolbar.
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If you want to cancel Favorites, go to “Favorites” dialog box and uncheck all the items.
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Quick Menu

Quick Menu

Check Quick Menu and Quick Menu will be added to the left side of toolbar. Tap the
icon of Quick Menu and the menu shows up.
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Quick Menu Manager

Quick Menu Manager

Quick  Menu  Manager  can  set  up  the  functions  given  to  Quick  Menu.  Tap  Quick
Menu Manager and enter “Quick Menu” dialog box. The left  column shows all  function
items which are able to be added to Quick Menu;  the  right  column  shows  the  items
which are added in Quick Menu. And the up and down arrows located in the middle are
used to adjust the order of the items in the right  column, while the right  and left  arrows
are used to move the selected item to the left or right column.
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To hide the Quick Menu, just uncheck it on the Options.
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Button Level

Button Level

The button level can be set, the default is 16x16. 
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The figure below is level 24x24.

    

© 2015 Supergeo Technologies Inc. All Rights Reserved.



12
C h a p t e r



SuperPad 3.3 Help

529

12 System Requirements

System Requirements

Operating System for Desktop Computer 
- Windows 7 (32 bit)
- Windows 2000 Service Pack 4 
- Windows Vista
- Windows XP

Operating System for Smart Device
- Windows Mobile Software for Pocket PC 2003 
- Windows Mobile 5.0 for Pocket PC and Smartphone
- Windows Mobile 2003 SE software for Pocket PC 
- Windows Mobile 5.x/6.x
- Windows CE .NET 5.0 or higher

Synchronization Environment
- Microsoft ActiveSync 4.2 or higher 
- Windows Mobile Device Center 6.1 or higher (for Microsoft Vista or higher)
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13 Supported Format

Supported Format

Map File
filename.SPP (*.spp): Map file for SuperPad 3.3.
filename.SWG (*.swg): Map file for SuperWebGIS.
filename.SPM (*.spm): SuperPad 3.3 can only read map file of SuperPad 2, but cannot
save in this format. 

Layer File 
filename.SLR (*.slr): Layer file for SuperPad and SuperGIS.

Layer Format
The supported format in SuperPad includes:

Feature Layer
filename.GEO (*.geo)
filename.SHP (*.shp, ESRI Shapefiles)
filename.DXF (*.dxf, AutoCAD Drawing Exchange Format)

Projection File
filename.PRJ (*.prj): Sometimes it is accompanied with GEO or Shapefile

Raster File
The supported image layer file:
filename.SID (*.sid, MrSID image file)
filename.JPG (*.jpg, JPEG format, a raster file format of JPEG Committee)
filename.ECW (*.ecw, ER Mapper Compressed Wavelet imagery format)
filename.SGR (*.sgr, SuperGIS Raster format)
filename.GeoTiff (*.tiff)
filename.JPEG 2000 (*.jpeg)
filename.BMP (*.bmp )
filename.GIF (*.gif )
filename.PNG (*.png)
filename.LAN (*.lan )

Dynamic Photo Layer Format
filename.sph (*.sph)
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Graphics Layer Format 
filename.spg (*.spg, SuperPad Graphics Layer file)

Symbol Format
Supported Picture Symbol file:
filename.GIF (*.gif, Compuserves' Graphics Interchange Format)
filename.PNG (*.png, Portable Network Graphics)
filename.BMP (*.bmp, OS/2 or Win graphics format, BitMap Picture)
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14 Toolbars

Toolbars

SuperPad 3.3 has developed Three-tier toolbar, which allows users to switch to different
toolbars according to different properties, such as map/layer, explorer, edit, and GPS
and Internet service. Toolbar displayed in this way is much clearer and makes the
screen have more space to display the map. The manipulation efficiency can be
improved significantly.

Three-tier Toolbar
The toolbars developed in SuperPad can be explained in three-tier style.

   

Main toolbar: the largest class and the top tier, it has six buttons including map/layer
button,explorer button, edit button, GPS button and system settings button. The  five
buttons are located in the first row of the tools.
Toolbar: the toolbar is corresponding to the selected button on the main tool. It is
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located in the second row of the tools.
Tool menu: when the downward arrow of the toolbar is tapped, the tool menu shows
up.

Map/Layer Toolbar
Open Map Tool Menu

   

New 
Create a new map file, quick project, feature layer, photo layer and graphics layer.
Open Map 
Open the map file, the format is SPP (*.spp).
Save Map 
Save the current map file, the format is SPP (*.spp).
Save Map as 
Save the current map as a new file, the format is SPP (*.spp).
Import APM 
Import ArcPad map file, the format is APM (*.apm).
Map Properties  
Edit map title, command and spatial reference. 
Recent Layers 
Open the layers you recently opened .
Recent Maps 
Open the maps you recently opened.
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Exit 
Exit SuperPad.

New Layer Tool Menu

   

Add Layers 
Add one or more layers to the map.
Layer Files 
Tap the rightward arrow and the list shows up; you can select to import or export layer
files. 
Import Layer Files
Import *.slr layer file to the map.
Export Layer Files
Export layer's information to *.slr layer file.

Layer Manager 
Layer Manager shows up and you can change the related properties and contents of
layer.

Save Screen 
Save the current map in image file in *.bmp,*.jpg, *.gif or*.png.

About SuperPad Tool Menu

    

About SuperPad 
Show SuperPad program version and copyright.
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Quick Reference (for PC version) 
A quick reference for all tools.  
User Guide (for PC version) 
Online SuperPad user guide.

Explorer Toolbar
Zoom In Tool Menu

   

Zoon In 
Zoom in the selected area.
Zoom Out 
Zoom out the selected area.
Pan 
Pan the map.
Slide Zoom 
Slide upward or downward with finger or stylus to zoom in or zoom out the map. 
Rotate Map 
Rotate the map, adjusting PDA upward direction as the heading direction.
Clear Rotation 
Clear rotating map, recover to taking PDA upward direction as the north.

Identify Tool Menu
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Identify  
Query attribute of the feature by selecting with stylus.
Hyperlink 
Display website or file set as the hyperlink.

Zoom to Full Extent Tool Menu

   

Zoom to Full Extent 
Zoom to cover all layers.
Zoom to Layer 
Zoom to cover the entire range of selected layer.
Go to Bookmark 
Move map to the selected bookmark.

Go Back to Previous Extent Tool Menu
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Go Back to Previous Extent 
View the previous map extent.
Go to Next Extent 
View the next map extent.

Find Tool Menu

   

Find  
Input the filtering conditions to search features.
Create Bookmark 
Create a bookmark of the current map extent.
Bookmark Manager 
Edit or delete the bookmarks.

Refresh 
Redraw the map.

Edit Toolbar
Select Feature Tool Menu
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Select Feature 
Select a feature to edit.
Select at GPS Position 
Select a feature to edit at GPS position.
Clear Edit Selection 
Clear the edit selection status. 
Zoom to Selected Feature 
Zoom the map to the extent of selected feature that you want to edit.
Move to Selected Feature 
Move the map to the extent of selected feature that you want to edit.
Repeated Attribute  
Copy the attributes of the previous created feature to the new feature. 

Vertex Edit Tool Menu

   

Vertex Edit 
Switch to the vertex edit mode.
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Move Vertex 
Move one vertex.
Insert Vertex 
Insert a vertex between two vertices.
Segment Polyline 
Digitize vertex continuously after the last vertex of a polyline.

Add Feature Tool Menu

   

Point 
Add a point feature.
Line 
Add a line feature.
Polyline 
Add a polyline feature.
Freehand Line 
Add a freehand line feature.
Polygon 
Add a polygon feature.
Rectangle 
Add a rectangle feature.
Circle 
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Add a circle feature.
Ellipse 
Add an ellipse feature.
Freehand Polygon 
Add a freehand polygon feature.

Capture Point Using GPS Tool  

   

Capture Point Using GPS 
Capture GPS position as a point and make it a point feature.
Add GPS Vertex 
Capture GPS position as a point and make it a vertex.
Add GPS Vertices Continuously  
Continuously capture GPS position as points and make them vertices.

Feature Properties Tool Menu

   

Feature Properties 
Edit the properties of feature of graphics layer.
Move Feature 
Drag feature to the desired position.
Rotate Feature 
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Rotate the entire feature.
Offset Feature 
Offset the selected feature.
Scale Feature 
Scale feature with the feature¡¦s center as standard.
Resize Feature 
Resize the width or height of feature.
Delete Feature 
Delete the selected feature.

Feature Properties Tool Menu

Text Point 
Create text point.
Text Polyline 
Create text polyline.
Text Polygon 
Create text polygon.
Text Rectangle 
Create text rectangle.
Text Ellipse 
Create text ellipse.

GPS Toolbar

   

Turn On/Off GPS   
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Turn on/off GPS. 
Tracklog Record 
When GPS is activated, record the tracklog.
GPS Status 
Show GPS Status.
GPS Position Information 
Show GPS Navigation information.
GPS Debug 
Show GPS signal information.
GPS Options 
The related GPS settings.
Pan to GPS 
Pan map to GPS position.
GPS Navigation Mode 
Switch to GPS navigation mode and head to waypoint.

System Settings Toolbar

   

System Settings 
Set the system parameters with eight tabs.

Quick Explorer Tool Menu   
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Quick Explorer 
Whether to show quick explorer.
Status Bar 
Whether to show status bar.
Panning Frame 
Whether to show the panning frame.
Compass 
Whether to show the compass.
Scale Bar  
Whether to show the scale bar.
Map Grid  
Whether to show the map grid.

Add Waypoint Tool Menu

   

Add Waypoint 
Add waypoint, edit the name and coordinates.
Add Waypoint at GPS position 
Capture the GPS position and make it a waypoint.
Waypoint Manager 
Edit or delete waypoint; set the waypoint as destination; or position the waypoint at the
map center.
Photo Navigation 
Open the photo that equipped with coordinates and system will take the coordinates as
the waypoint to start navigation.
Export Waypoints
Export waypoint file as *.geo file.
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Import Waypoints
Import waypoint file.

Polyline Measure Tool Menu

   

Polyline Measurement 
Measure by drawing a polyline and the results will show up.
Freehand Measurement 
Measure by drawing a freehand line and the results will show up.
Rectangle Measurement 
Measure by drawing a rectangle and the results will show up.
Radial Measurement 
Measure by drawing a circle and the results will show up.

Feature Measurement 
Tap straightly on features to measure them.

Camera 
Turn on the camera function of PDA.

Run Script 
Write Script or load and run script file.

Serial Port 
To input message to GPS receiver or output messages from GPS receiver.
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15 How to develop SuperPad?

How to develop SuperPad?

In SuperPad, most functions are the toolbar buttons that SuperGIS Mobile Engine
provides. Besides, users can customize the needed toolbar buttons as required on their
own. Before designing the custom toolbar buttons, we need to understand the major
classes first, so we suggest you learn the basic concept of programming language. 

© 2015 Supergeo Technologies Inc. All Rights Reserved.

15.1 Class

Class

SGToolBar
In SGToolBar class, you can add several toolbar buttons or toolbar button groups
(SGToolBarButtonGroup) and set the image of the toolbar you would like to display in
the main toolbar of the SuperPad through the Image property. 
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The SGToolBar is an abstract class of which most of the methods and properties have
been implemented. If you would like to utilize the SGToolBar class to design a toolbar
and add it to SuperPad, you have to add a new class which inherits the SGToolBar and
implement the Initialize method. Thus, you can add the new toolbar to the
SGToolBarGroup. Take the following codes for example. (You can also create the code
through the Visual Studio template wizard,we will introduce the steps in next section.)

    

In implementing the Initialize method, you have to add two parameters, Application and
Mode. The Application includes basic objects which a GIS application needs, such as
map controls, GPS connection objects, waypoint set, and status bar, etc. These
objects facilitate you to initialize the SGToolBar designed by yourself and to gain the
needed objects at the same time. The Mode is applied to set the pattern of toolbars;
you can judge in initializing to make the toolbars you design provide different functions



How to develop SuperPad?

550

according to the needs.  

    

SGToolBarButtonGroup
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In a toolbar, we not only can add general toolbar buttons but also make the toolbar
button display like a menu; the toolbar buttons can be integrated to a toolbar buttons
group. SuperGIS Mobile Engine contains more than 100 built-in toolbar buttons for
developers to use.

Take SuperPad 3.3 for example. The menu in the figure below includes four tools, Zoom
In, Zoom Out, Slide Zoom, and Rotate Map. Developers do not have to implement the
functions by themselves but directly use the objects, ZoomInButton, ZoonOutButton,
SlideZoomButton, RotateButton, etc. Through the SGToolBarButtonGroup provided by
SuperGIS Mobile Engine, developers can integrate toolbar buttons and even set
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whether to switch the buttons in the toolbar while tapping tool menu.

    

The following sample code introduces how to produce a SGToolBarButtonGroup class,
containing four toolbar buttons and how to add them it to the SGToolBar.
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15.2 Sample

Sample

Next we are going to introduce some major extension project samples. After SuperPad
is completely installed, it contains 3 projects as below. In the following section, we will
describe the steps to develop the three projects.
1. SuperGIS.Engine.Mobile.ToolBar.Sketchlabeling : The plug-in extension for

SuperPad. You can add a toolbar to the toolbar groups. Sketch function is available,
and you can sketch any graph on the map.

2. SuperGIS.Engine.Mobile.Module.FixedZoom : The plug-in extension for
SuperPad. You can add the Fixed Zoom button on the map.

3. SuperGIS.Engine.Mobile.ToolBar.BirdView : The plug-in extension for SuperPad.
You can add a toolbar to the toolbar groups. BirdView function is available and can
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simulate 2.5D effect with which users can change the angle of depression. 

    

© 2015 Supergeo Technologies Inc. All Rights Reserved.
SketchLabeling

SketchLabeling

SuperGIS.Engine.Mobile.ToolBar.SketchL is the plug-in extension for SuperPad. You
can add a toolbar to the toolbar groups. Sketch function is available, and you can
sketch any graph on the map.
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Firstly, increase a class which inherits SGToolBar. In general, we increase such class
in two cases, one is to create this class together when a Mobile project is created; the
other is to create this class for an existing project. Here below are the descriptions for
them. 

Add a project and add a class
Firstly, start Visual Studio, create a new project and select the project type “SuperGeo”
in “SmartDevice.” Select “Mobile Class Library(Toolbar)” in the Templates, and click
OK. 
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Add a class for an existing project
1. Firstly, add new item in Visual Studio project. Right-click Solution Explorer and

click “Add”>“New Item” on the menu. See the figure below.
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2. Next, in the Add New Item window, select “SuperGeo” in Visual C# in the left side
window, select “Toolbar” in the templates in the right side and change the name to
“SketchToolbar.” Click “Add.”

3. A class which inherits SGToolBar class is automatically created by Visual Studio.
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After that, we have to implement Initialize method. Firstly, select the image you would
like to display in main toolbar. Specify the image of the toolbar to display by
implementing IImageProvider which gives corresponging images based on the size of
the toolbar buttons. This is because smart devices have different resolutions, and the
image on the toolbar needs to be adjusted followingly. By this way, in high resolution
smart devices, the images will not be too small or too vague. We need to implement as
code below. 
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As the toolbar class is created, we need to create “Toolbar Button.” Toolbar Button is
similar to the built-in toolbar buttons in SuperGIS Mobile Engine. In this case, the
difference is we need to create the toolbar button class on our own. The toolbar buttons
created in this section can be divided into two kinds:  

One is “ToolButton” which interacts closely with the map control. For instance, when
users click “Add Sketch”, they can draw on the map with mouse freely with the point
where mouse clicks as the base until mouse is released.  

    

The other is “Command Button” which triggers function directly as it is clicked. For
instance, as users click “Clear Sketch”, the graph users drawed will be cleared. Or as
users click Previous Sketch, the screen returns to the previous graph.

    

In SuperGIS.Engine.Mobile.ToolBar.SketchLabeling project, the first toolbar button
belongs to Tool Button, and the others all belongs to Command Button. To create
toolbar buttons which have the same function as mentioned, we need to create a class
which inherits SGToolbarButton for each toolbar button to show them on the toolbar of
application. Then, we need to implement ITool for “Add Sketch” which draws on the
map control to implment the function. Please follow the steps below:

1. Identically, add New Item in Visual Studio, select “Toolbar Tool Button”, name it
“AddSketchButton” and click “Add.” See the figure below.
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2. After you click Add, the class will be generated and the code as below will be added
automatically.

After the steps are accomplished in Visual Studio, expand region “ITool members”, you
can see the members including: Caption, Image properties and OnContextMenu¸
OnKeyDown, OnKeyUp, OnMouseDown, OnMouseMove and OnMouseUp methods.
The description of the functions is stated below:
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Property:
1. Caption: Specify the display name of the button in application.
2. Image: Specify the display image of the button in application.

Method:
1. OnContextMenu: As users right-click mouse on the map (long-press in PDA), it

will be called.
2. OnKeyDown: As users press some specific key with mouse button, it will be

called.
3. OnKeyUp: As the specific key is released by mouse button, it will be called.
4. OnMouseDown: As mouse clicks on the control, it will be called.
5. OnMouseMove: As mouse moves on the map, it will be called.
6. OnMouseUp: As mouse is released on the map, it will be called.

After understanding each property and functions of methods, now we can start coding
for the function of the toolbar button. For the detailed coding method, please refer to
SuperGIS.Engine.Mobile.ToolBar.SketchLabeling project.

Now AddSketchButton class is created. As to the rest four toolbar buttons which
belong to Command Button, we are going to illustrate with “ClearSketch” button. Please
follow the steps below: 

1. Add New Item in Visual Studio, select “Toolbar Command Button”, name it
“ClearSketchButton” and click “Add.” See the figure below.
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2. As you click “Add”, the class will be created and the code below will be
automatically generated:

    

Expand region “IComand members”, and you can see the members including: Caption,
Image, Tooltip properties and OnCommand method as well and OnClick event. The
functions are stated as below:

Property:
1. Caption: Specify the display name of the button in application.
2. Image: Specify the display image of the button in application.
3. Tooltip: Set the related information to be displayed for the toolbar button in

application.

Method:
1. OnComand: As users click the button, it will be called. You can define the function

of the button here.

Event:
1. OnClick: As users click the button, it will be called. If users want to extent function

for this button, simply add code directly to OnClick event.

After understanding each property and functions of methods, now we can start coding
for the function of the toolbar button. For the detailed coding method, please refer to
SuperGIS.Engine.Mobile.ToolBar.SketchLabeling project.

Add the plug-in extension to SuperPad application
If you want to add SketchLabeling plug-in extension to SuperPad application, please
place the DLL(SketchLabeling.dll) compiled by Visual Studio to “Customize” folder of
SuperPad installation category. After that, start SuperPad and this plug-in extension
shows in the “Customize” tab of “System Settings” button. Check “SketchLabeling.dll”
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and exit SuperPad. The plug-in extension is added to the SuperPad application toolbar
groups when you start SuperPad next time.
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FixedZoom

FixedZoom

We illustrate how to implement a plug-in extension with toolbar above; however, we
might not want to present all plug-in extensions in the form of toolbar. Take SuperGIS.
Engine.Mobile.Module.FixedZoom project for illustration, this project adds two buttons
on the map control, providing fixed zoom in and fixed zoom out function. Besides,
SuperGIS Mobile Engine particularly design an abstract class, ApplicationModule, for
extensions which do not present as toolbars. Like SGToolBar, the developers need to
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implement Initialize method and code in this method for nitializing the extension. 

To implement the abstract class ApplicationModule, we need to create a class named
FixedZoom which inherits the abstract class SuperGIS.Engine.Mobile.
ApplicationModule in Visual Studio by adding new item. In general, we add this kind of
class in two cases, one is to create this class when adding a Mobile project, the other
is to create this class for an existing project. See below the detailed statement.

Add project and add a class
Firstly, start Visual Studio, create a new project and select the project type “SuperGeo”
in “SmartDevice.” Select “Mobile Class Library(Toolbar)” in the Templates in the right
side. Click OK.
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Add a class for an existing project
1. Firstly, add new item in Visual Studio project. Right-click Solution Explorer and

click “Add”>“New Item” on the menu. See the figure below.

    

1. In the Add New Item window, select “SuperGeo” in Visual C# in the left side of the
window. Select “Application Module” in the templates in the right side and change
the name to “FixedZoom”, and click “Add.”
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2. A class which inherits ApplicationModule is automatically created by Visual
Studio. See the figure below.

    

Here below is the complete sample of FixedZoom class. Identically, we need to code in
Initialize method to initialize the plug-in extension.
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This extension adds two image icons to be the buttons which can fixed zoom in and
fixed zoom out map. The developers do not need to implement fixed zoom in and fixed
zoom out, they can directly use the toolbar buttons provided by SuperGIS Mobile
Engine. It works like using the built-in toolbar buttons, but the difference is we do not
present the functions as toolbar buttons but in another way that developers define on
their own to achieve the same goal.   

QuickExplorer and QuickExplorerButton are the classes that SuperGIS Mobile Engine
provides for adding the custom buttons in the map control and specifying the position of
each button. If you only need to do some simple work like Panning or Zooming, it is not
necessary to use toolbar but you can simply add QuickExplorerButton in the map
control to make it. In this sample, we are to add two QuickExplorerButtons and assign
the tools as FixedZoomInButton and FixedZoomButton.
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If you want to quickly create QuickExplorerButton, you can also add new item in Visual
Studio, as you select new item, choose “Quick Explorer Button” and click “Add.”
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A class which inherits QuickExplorerButton will be generated. The way to use this
class is the same as to use QuickExplorerButton, please refer to the sample code of
FixedZoom class in this project.

© 2015 Supergeo Technologies Inc. All Rights Reserved.
BirdView

BirdView

SuperGIS.Engine.Mobile.ToolBar.BirdView project is a plug-in extension of SuperGIS
Mobile Engine. It adds a toolbar in the toolbar group and provides BirdView function
which simulates 2.5 D effect and users can change the angle of depression.

SuperGIS.Engine.Mobile.ToolBar.BirdView project includes BirdView class as the
toolbar as well as two toolbar button classes, BirdViewUpButton and
BirdViewDownButton. BirdView.cs has the code. The way to create this project is
similar to SuperGIS.Engine.Mobile.ToolBar.SketchLabeling project. Firstly, create a
BirdView class which inherits SGToolBar (please refer to the way to add new item in
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the previous section) and create two toolbar buttons which respectively inherits
SGToolbarButton and ICommand, and implement the method.

In this sample, we implement the 2.5D effect by modifying the ZValue of
DisplayTransformation class. The sample code for BirdViewUpButton class is as below:

    

The BirdViewDownButton class adjusts the 2.5D effect to 2D effect, and the samle
code is as below: 

    

At last, please refer to the previous seciton for the way to load BirdView extension. You
can load the extension by reading plug-in extension though the Customize folder in
SuperPad.
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